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Введение 
Предисловие 

Еще один SPICE? 

Моделирование аналоговой схемы было неотделимо от аналоговой 
разработки микросхем (IC). Симуляторы SPICE - единственный способ 
тестировать схему до интеграции на чип. Далее, моделирование SPICE 
позволяет измерение токов и напряжений, которое невозможно любым 
другим способом. Успех симуляторов аналоговой схемы позволил 
распространить моделирование на разработку схем уровня платы. Схему 
более просто во многих случаях имитировать, чем макетировать, и 
возможность в моделировании проанализировать схему для 
производительности и задач ускоряет разработку убедительных, 
устойчивых схем. 

Учитывая количество коммерчески доступных симуляторов SPICE, 
почему нужно создавать новый симулятор? Потому, что уверенные 
аналоговые функции чрезвычайно трудно имитировать с коммерчески 
доступными симуляторами SPICE. Импульсные источники питания имеют 
быстрые высокочастотно-переключающиеся прямоугольные сигналы, что 
замедляет полный результат анализа. Это означает, что моделирование 
должно работать для тысяч и сотен тысяч циклов, чтобы иметь полный 
анализ импульсного регулятора. Коммерчески доступный SPICE просто 
делает это слишком долго, чтобы быть полезным методом 
моделирования. Время моделирования импульсного источника питания 
должно быть в минутах, а не часах, чтобы симулятор был полезным. 

Были методы моделирования аналоговой схемы, которые показали 
некоторый успех в ускорении моделирования импульсного источника 
питания, но за счет изготовления упрощающего предположения, которое 
не позволяют произвольную управляющую логику и полную имитацию 
комплексных форм сигнала переключения. Новый SPICE с встроенными 
примитивами логики, которые моделируют импульсный элемент 
управления, дает лучший ответ. Он может дать быстрое моделирование, 
детализированный объем формы сигнала, и все еще предоставляет 
гибкость для произвольных модификаций схемы. 

SwitcherCAD III является новым SPICE, который разработан для 
моделирования импульсной системы регулятора на уровне общей схемы. 
В новый SPICE встроены схемные элементы для моделирования 
практических компонентов уровня платы. Конденсаторы и катушки 
индуктивности могут быть оформлены с последовательным 
сопротивлением и другими паразитными аспектами их режима, не 
используя подсхемы или внутренние узлы. Кроме того, схемный элемент 
моделирования был разработан для энергетического MOSFET, который 
точно показывает его обычный режим заряда затвора, не используя 
подсхемы или внутренние узлы. Уменьшение количества узлов, которое 
симулятор производит, значительно уменьшает объем вычисления, 
необходимого для данного моделирования, не ставя под угрозу 
точность или детали форм импульсного сигнала. Другое преимущество 
этих новых моделей - то, что задачи сходимости проще решить, так 
как у них, как у компонентов уровня модели платы, есть конечное 
полное сопротивление на всех частотах. 

Современные импульсные источники питания включают логическую 
схему контроллера с множественными режимами работы. Например, режим 
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работы устройства может меняться от импульсного до пакетного или 
циклического пропуска, в зависимости от организации схемы. 
Оригинальный новый компилятор смешанного режима и симулятор были 
написаны в SwitcherCAD III, который позволяет этим продуктам 
реалистично моделировать быстродействующим вычислительным способом.  

Есть в настоящий момент приблизительно семьсот продуктов Linear 
Technology, оформленных в SwitcherCAD III. Программа свободно 
загружаема с вебсайта Linear Technology и является 
высокоэффективным универсальным симулятором SPICE. Включены 
демонстрационные файлы, которые позволяют Вам наблюдать загрузку, 
старт и нестационарный процесс цикл за циклом. В SPICE включена 
полнофункциональная программа редактора схем. для того, чтобы 
вводить новые схемы.  

SwitcherCAD III разрабатывается, чтобы использоваться тремя 
различными типами разработчиков: (1)те, кто знает то, что они 
делают,(2) те, кто думает, что они знают, (3)и те, кто уверен, что 
они абсолютно ничего не знают о разработке импульсного регулятора. 
Опытный дизайнер нуждается в ответах программы "что, если", которые 
позволят ему быстро изменять аспекты схемы, чтобы найти оптимальную 
разработку. Новичок нуждается в подходе поваренной книги, который 
приведет к надежной разработке, основанной на самых простых 
рецептах. "Неточное орудие" дизайнер нуждается в программе, которая 
позволит ему осуществлять свою добрую волю, но будет достаточно 
интеллектуальна, чтобы оградить его от фатальных дефектов 
разработки. 

К завершению мы сделали SwitcherCAD III чрезвычайно гибким, "что, 
если" инструментом электронной разработки, у которого есть метки 
предупреждения, когда вещи получаются из рук вон. Мы конструировали 
программу, чтобы иметь законченный начальный цикл разработки, 
основанный только на существенных вводах напряжения и потребностей 
в электроэнергии. Это позволяет испуганному дизайнеру начинать с 
рабочей схемы, позволяет опытному дизайнеру иметь неограниченную 
забаву, изменяющую вещи, и, мы надеемся, предоставляет достаточные 
меры безопасности, чтобы предотвратить плохие разработки. 

Пожалуйста знайте, однако, что SwitcherCAD III не предназначается 
как абсолютное решение. Это - только инструмент, чтобы упростить 
процедуру разработки, которая должна также включить макетирование и 
тестирование. Используйте здравый смысл с результатами, полученными 
при моделировании. 

. 

Краткий обзор SwitcherCAD III 
SwitcherCAD III является третьим поколением switching regulator 

design program Linear Technology. Программа состоит из 
высокоэффективного симулятора SPICE, расширенного со смешанной 
возможностью моделирования режима, которая включает новые 
встроенные приборы SPICE для макромоделирования: Импульсный 
Источник Питания (SMPS) контроллеры и регуляторы. Программа 
включает интегрированную иерархическую программу редактора схем., 
которая позволяет пользователям редактировать пример схемы SMPS или 
конструировать новые схемы. Интегрированное средство просмотра 
формы сигнала отображает моделируемые формы сигнала и позволяет 
дальнейшее исследование данных моделирования. Есть встроенная база 
данных для большей части Linear Technology power ICs (микросхем 
электропитания) и многих пассивных элементов. База данных прибора, 
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редактор схем, элемент управления моделирования и гармонический 
анализ интегрируются в одну программу. 

 
Благодаря смешанной возможности моделирования режима и многим 

другим расширениям по сравнению с предыдущими программами SPICE, 
значительно улучшается быстродействие моделирования, в то время как 
точность моделирования сохраняется. Пошаговый цикл моделирования 
SMPS может быть выполнен и проанализирован в минутах. Пользователь 
может получить детальное исследование энергосистемы несколькими 
щелчками мыши, не зная ничего об устройстве SPICE и программы 
редактора схем. Предварительно созданные демонстрационные схемы 
могут использоваться как точка старта, чтобы выстроить 
пользовательское описание схемы, чтобы подогнать источник питания к 
необходимым требованиям. После того, как создано новое описание 
схемы, оно может быть смоделировано, и сгенерирован отчет. 

Программное интегрированное иерархическое описание схемы и 
симулятор SPICE полностью доступны для общего использования. 
Улучшенные характеристики механизма моделирования SPICE - 
преимущество для имитации общих аналоговых схем и должны 
представлять интерес для всех электронных инженеров. Из более чем 
500 000 пользователей копий, распространенных пока, многие 
сообщили, что LTspice/SwitcherCAD III является их основным 
инструментом моделирования/редактирования схем. Мы надеемся, что Вы 
наслаждаетесь программой и находите ее полезной. 

 

Требования к системе 
LTspice/SwitcherCAD III может работать на любом PC с операционной 

системой Microsoft® Windows 98, 2000, NT4.0, Me, или XP. Так как 
моделирование может генерировать большой объем данных через 
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несколько минут, свободное пространство жесткого диска (> 200 МБ) и 
большое количество оперативной памяти (> 128 МБ) строго 
рекомендуется. В основном достаточно Windows 98, но моделирование 
может не завершить обработку, если недостаточно свободного 
пространства на жестком диске. Язык интерфейса: только английский. 

LTspice/SwitcherCAD III будет также работать на Linux. Программа 
была тестирована на Linux RedHat 8.0 с WINE версией 20030219. 

 

Установка SwitcherCAD III 
SwitcherCAD III может быть загружен с вебсайта LTC 

<http://www.linear.com>. Прямая ссылка к распределенному файлу 
<http://ltspice.linear.com/software/swcadiii.exe>. Файл 
swcadiii.exe является самораспаковывающимся gziped файлом, который 
устанавливает SwitcherCAD III.  

SwitcherCAD III часто обновляется. После того, как SwitcherCAD 
III первоначально установлена, можно использовать встроенную 
команду обновления меню <Web_Update.htm>, которая дополнит Вашу 
инсталляцию до последней редакции, если у Вас будет доступ к сети. 
Процесс обновления сначала загрузит индексный файл разработчика от 
вебсайта Linear Technology, у которого есть размер и контрольная 
сумма каждого файла в дистрибутиве. Если будет отсутствие файла, 
различие размера, или различия между локальной контрольной суммой и 
суммой от индексного файла, то этот файл будет обновлен 
автоматически. Базы данных компонента объединяются в процессе 
обновления так, что если Вы добавили приборы к своей инсталляции, 
то добавление не будет потеряно, когда Вы выполните автоматическую 
утилиту обновления. 

 

Лицензионное соглашение/Оговорка 
SwitcherCAD III - Лицензионное соглашение / Оговорка. Авторское 

право © 2001, Корпорация Linear Technology. Все права защищены. 

 

SwitcherCAD III является синтезатором импульсного источника 
питания Корпорации Linear Technology и программным обеспечением 
моделирования аналоговой схемы. 

это программное обеспечение защищено авторским правом. Вам 
предоставляется неисключительное, непередаваемое, 
неподлицензируемое, безгонорарное право исключительно, чтобы 
оценить продукты LTC и также выполнить общее моделирование схемы. 
Корпорация Linear Technology владеет программным обеспечением. Вы 
не можете изменять, адаптировать, транслировать, перепроектировать, 
декомпилировать, или дизассемблировать выполнимую программу 
(программы) или модели предоставленных продуктов LTC. Мы не несем 
ответственности за точность разработанных третьей стороной моделей, 
используемых в симуляторе, предоставленных или LTC или 
пользователем. 

В то время как мы приложили все усилия, чтобы гарантировать, что 
SwitcherCAD III работает, описанный таким образом, мы не 
гарантируем работу, свободную от ошибок. Обновления, модификации, 
или исправления к этой программе будут строго на усмотрение LTC. 
Если Вы столкнулись с проблемами установки или работы SwitcherCAD 
III с целью выбора и оценки продуктов LTC, можно получить 
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техническую помощь при вызове нашего Applications Department - тел. 
(408) 432-1900, между 8:00 и 17:00 Тихоокеанское время, с 
понедельника до пятницы. Мы не предоставляем такую техническую 
поддержку для общего моделирования схемы, которое не является для 
определения продуктов LTC. Из-за большого разнообразия совместимых 
с PC компьютерных систем, версий операционной системы, и 
использующихся периферийных устройств, мы не гарантируем, что Вы 
будете в состоянии использовать SwitcherCAD III успешно на всех 
таких системах. Если Вы неспособны использовать SwitcherCAD III, 
LTC действительно оказывает Вам поддержку разработки для LTC 
микросхем импульсного регулятора любыми необходимыми средствами. 

Программное обеспечение и связанная документация предоставляются 
"КАК ЕСТЬ" и без гарантии любого вида, и Корпорация Linear 
Technology явно отвергает все другие гарантии, явные или неявные, 
составные, не ограниченные, подразумевающие гарантии высокого 
спроса и пригодности в специфических целях. LTC ни в коем случае не 
несет ответственность за ущерб, прямой или косвенный, возникший в 
результате использования этого продукта или от неспособности 
использовать этот продукт, даже если нас предупредили о возможности 
такого ущерба. 

Перераспространение этого программного обеспечения разрешается, 
пока оно распространяется полностью, со всей документацией, 
приведенными в качестве примера файлами, обозначениями, и 
моделирует без модификации или присоединения. 

Эта программа определенно не лицензируется для использования 
изготовителями полупроводников в продвижении, демонстрации или 
продаже их продуктов. Специфичное право доступа должно быть 
получено от Linear Technology для использования SwitcherCAD III для 
этих приложений. 
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Режимы работы 
Краткий обзор 

У SwitcherCAD III есть два основных режима запуска симулятора: 

1. Использовать программу как универсальную программу редактора 
схем с интегрированным симулятором. Команда меню File=>New, или 
File=>Open (тип файла .asc) 

2. Запустить симулятор со списком соединений ручной работы или 
импортированным списком соединений, сгенерированным другой 
программой редактора схем. Команда меню File=>New (тип файла .cir) 

LTspice/SwitcherCAD III предназначается, чтобы использоваться как 
универсальная программа редактора схем с интегрированным 
симулятором SPICE. Идея - Вы вычерчиваете схему (или запускаете 
SwCAD с приведенной в качестве примера схемой, уже составленной), и 
наблюдаете ее работу в симуляторе. Процесс разработки включает 
выполнение итераций схемы до получения в результате моделирования 
необходимого режима. Более ранние версии LTspice/SwitcherCAD III 
включали синтезатор, который пытался предугадать разработку SMPS по 
обеспеченной пользователем спецификации, но он вытеснен новыми 
средствами. 

Описание схемы, в конечном счете, преобразовывается к текстовому 
списку соединений SPICE, который передается симулятору. В то время 
как список соединений обычно извлекается из графического описания 
схемы, вычерченного в LTspice/SwitcherCAD III, импортированный 
список соединений может быть выполнен непосредственно, не имея 
описания схемы. Этому есть несколько применений: (1) Программа 
синтеза фильтра Linear Technology FilterCAD может синтезировать 
список соединений для LTspice, чтобы имитировать временную область 
или частотную характеристику фильтра. (2) Это упрощает эталонное 
тестирование LTspice против других программ SPICE. (3) 
Профессионалы, исторически работающие с симуляторами схемы SPICE, 
знакомы с работой непосредственно с текстовыми списками соединений, 
потому что редактора схем не был интегрирован в симуляторы SPICE в 
ранних системах. 

 

Примеры схем 
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Есть несколько ресурсов приведенных в качестве примера схем для 

LTspice/SwitcherCAD III. Есть каталог, обычно установленный в 
C:\Program Files\LTC\SwCADIII\examples\Educational, дающий набор 
некоммерческих примеров моделирования SPICE, которые иллюстрируют 
различные типы исследования, методы или возможности 
программирования. В каталоге C:\Program 
Files\LTC\SwCADIII\examples\jigs есть приведенное в качестве 
примера моделирование для каждого прибора Linear Technology с 
макромоделью в LTspice/SwitcherCAD III. Обратите внимание, что эти 
модели часто только тестовые приспособления-модели для прибора, не 
обязательно рекомендуемые образцы разработки. Наиболее важно, Ваш 
инструмент Linear Technology вероятно может дать Вам особую 
поддержку, необходимую в Ваших прикладных разработках.  

 

Общие качества SwitcherCAD III 
Вы не ограничены в использовании LTspice/SwitcherCAD III как 

универсальной программы схемного редактора SPICE. Она полезна не 
только для разработки SMPS, но и других аспектов аналоговой 
техники. Приведенные в качестве примера модели, обычно 
установленные в каталоге C:\Program 
Files\LTC\SwCADIII\examples\Educational\ иллюстрируют различные 
возможности LTspice. 
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Импортированные списки соединений 

 
Можно открыть списки соединений, созданные вручную или другими 

программами описания схемы. У этих файлов обычно расширение ".cir", 
но понимаются и ".net", и ".sp". Редактор ASCII, используемый для 
файлов списка соединений, поддерживает неограниченный размер файла 
и неограниченную отмену/возврат последней операции undo/redo. 
Команда меню Tools=>Color Preferences может использоваться, чтобы 
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корректировать цвета, используемые в редакторе ASCII.  

 

Отчет о КПД 
SwCAD дает отчет о КПД преобразователя DC/DC во временной области 

.tran исследования, которое содержит ключевое слово "steady". После 
моделирования состояния steady отчет о КПД может быть сделан 
видимым на описании схемы как блок текста комментария. 

 
Для получения КПД преобразователя DC/DC необходимо 

идентифицировать вход и выход, должен быть точно один источник 
напряжения и один источник тока. Источник напряжения должен быть 
вводом, а источник тока должен быть выходным устройством. Схема 
запущена, пока состояние steady не выполнится симулятором. Это 
требует макромоделей SMPS, написанных с информацией о том, как 
обнаружить состояние steady. Обычно при условии, что ошибка amp 
тока, усредненная по тактовому циклу, уменьшается к малому значению 
для нескольких циклов. Затем во фронте синхроимпульса, энергия, 
сохраненная в каждом реактансе, отмечается, и моделирование 
выполняется еще для десяти тактовых циклов, но теперь интегрируется 
рассеяние в каждом приборе. Во фронте синхроимпульса последнего 
цикла энергия, сохраненная в каждом реактансе, отмечается снова, и 
моделирование останавливается. КПД выводится как отношение выходной 
мощности к мощности входного источника напряжения, после подсчета 
энергии, сохраненной в реактансах. Так как рассеяние каждого 
прибора отмечено, можно оценить потери в нем. 

Обычно можно вычислять КПД схем SMPS, которые Вы вычерчиваете 
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самостоятельно, используя пометку "Stop simulating if steady state 
is detected" на редакторе Edit Simulation Command. После 
моделирования, используйте команду меню View=>Efficiency Report. 

Автоматическое обнаружение состояния steady не всегда работает. 
Иногда критерии для обнаружения состояния steady слишком строги и 
иногда слишком снисходительны. Вы затем корректируете параметр 
опции sstol или просто в интерактивном режиме устанавливаете 
пределы для интеграции КПД. 

 

Переключатели командной строки 
Следующая таблица перечисляет переключатели командной строки, 

понятые выполнимой программой LTspice (scad3.exe): 

Флаг Описание 

-ascii Использовать ASCII .raw файлы. Серьезно ухудшает 
производительность программы. 

-b Работать в пакетном режиме. Например "scad3.exe-b 
deck.cir" будут оставлены данные в файле deck.raw 

-big Начало как развернутое окно. 

-encrypt Зашифровать модельную библиотеку. Для 3-ьих сторон, 
желающих позволить людям использовать библиотеки без 
разоблачающих подробностей реализации. Не 
используемый моделями Корпорации Linear Technology. 

-FastAccess Пакетное превращение двоичного .raw файла к формату 
Fast Access. 

-max Синоним для –big. 

-netlist Пакетное превращение описания схемы в список 
соединений. 

-nowine Предотвратить использование WINE (Linux) работы. 

-PCBnetlist Пакетное превращение описания схемы в список 
соединений PCB формата. 

-registry Вынудить LTspice сохранить пользовательские 
предпочтения, MRU, и т.д. в системном реестре вместо 
%WINDIR %\scad3.ini файл. 

-Run Запустить симуляцию описания схемы, открытого на 
командной строке, не нажимая кнопку пуска. 

-SOI Позволить MOSFET иметь до 7 узлов даже в расширении 
подсхемы. 

-uninstall Выполняет один шаг процесса деинсталляции. 

-web update Эквивалентно выполнению команды меню Tools => Sync 
Release. 

-wine Использование силы WINE (Linux) работы. 

Описание (ввод) схемы 
schematic capture 

Меню редактора схемы  
Программа описания схемы SwCAD используется, чтобы создать новые 
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описания схемы или изменить описания, предоставленные в качестве 
примера. Размер схем и глубина иерархии ограничиваются только 
компьютерными ресурсами. 

Программа поставляется приблизительно с 800 обозначениями. Эти 
обозначения покрывают большую часть возможностей LTC ICs, opamps, 
comparators, и многих универсальных приборов для проектирования 
схем. Можно также вычертить свои собственные обозначения для 
приборов, которые требуется ввести в программу. 

 
  В отличие от многих программ описания схемы, SwCAD была записана 

явно для моделирования SPICE. Это означает, что, если Вы нажимаете 
на объект, заданный по умолчанию режим должен чертить напряжения на 
этом проводе или ток через этот компонент, а не выбирает объект для 
редактирования или некоторого другого режима редактирования, 
который тогда лишил бы законной силы моделирование, только что 
выполненное. Однако когда требуется переместить, зеркалировать, 
вращать, перетащить или удалить объекты, сначала выберите команду 
перемещения, перетаскивания или удаления. Затем можно выбрать 
объект кликом на символе. Можно выбрать множественные объекты при 
перемещении рамки вокруг них. Программа останется в перемещении, 
перемещайте, или удалите режим правым кликом или клавишей ESC. Все 
редактирования описания схемы могут быть отменены или 
восстановлены. 

Undo: отменить. 

Redo: вернуть. 
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Text: поместить текст на описании схемы. Это просто помещает 
информацию на описание схемы. Этот текст не оказывает 
электрического влияния на метод проектирования схем. 

SPICE Directive: поместить на описание схемы текст, который будет 
включен в список соединений. Это позволяет Вам смешивать описание 
схемы со списком соединений SPICE. Он позволяет Вам устанавливать 
варианты моделирования, файлы для включения, которые содержат 
модели, определяют новые модели, или используют любые другие 
допустимые команды SPICE. Можно даже использовать его, чтобы 
прогнать подсхемой, для которой у Вас нет обозначения при заявлении 
экземпляра класса модели (команда SPICE впереди и 'X') на описании 
схемы и включении определения. 

SPICE Analysis: Введите/редактируйте команду моделирования. 

Resistor: Поместите новый резистор в описание схемы. 

Capacitor: Поместите новый конденсатор в описание схемы. 

Inductor: Поместите новую индуктивность в описание схемы. 

Diode: Поместите новый диод в описание схемы. 

Component: Поместите новый компонент в описание схемы. Команда 
открывает диалог, который позволяет Вам обозревать и предварительно 
просматривать базу данных обозначения. Это - более общий вид команд 
Резистора, Конденсатора, Индуктивности, и Диода. 

Rotate: Вращайте объекты подлежащие вращению. Примечание: когда 
вращение невозможно это отображается бледным цветом. 

Mirror: Зеркалируйте объекты подлежащие вращению. Примечание: 
когда зеркало невозможно это отображается бледным цветом. 

Draw Wire: клик мыши, чтобы запустить формирование соединения. 
Каждый щелчок мыши определит новый проводник. Нажмите на 
существующий проводник, чтобы присоединиться и продолжить провод. 
Правый клик отменяет проводник. Правый клик еще раз, выключает 
команду. Можно чертить проводники через компоненты, например, 
резисторы. Проводник будет автоматически вырезан таким образом, что 
резистор теперь последовательно с проводником. 

Label Net: Определите имя точки разветвления, в результате для 
этой точки разветвления не сгенерируется произвольное имя. 

Place GND: Поместите ЗАЗЕМЛЯЮЩЕЕ обозначение. Это - узел 
разветвления "0", глобальный обычный метод проектирования схем. 

Delete: объекты уничтожаются при нажатии на них или при 
перемещении рамки вокруг них. 

Duplicate: объекты копируются при нажатии на них или при 
перемещении рамки вокруг них. Можно скопировать из одного описания 
схемы в другое, если они оба открыты в одном окне программы SwCAD. 
Запустите команду Duplicate в окне первого описания схемы. Затем 
сделайте второе описание схемы активным окном и напечатайте Ctrl-V 
или командой Paste. 

Move: Нажать или перетащить рамку вокруг объектов, которые 
требуется переместить. Затем можно переместить те объекты в новое 
положение. 

Paste: Включается в новом окне описания схемы, когда объекты были 
уже выбраны командой 'Duplicate' в другом окне описания схемы. 

Drag: Нажать или перетащить рамку вокруг объектов, которые 
требуется перетащить. Затем можно переместить в новое размещение 
объекты с прикрепленными проводниками, которые тянутся резинкой к 
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новому размещению. 

Draw=>Line: Чертить линию на описании схемы. 

Draw=>Rectangle: Вычертить прямоугольник на описании схемы 

Draw=>Circle: Вычертить круг на описании схемы. 

Draw=>Arc: Вычертить дугу на описании схемы. 

Примечание: графические аннотации к описанию схемы; линии, 
прямоугольники, круги и дуги; это особенность по умолчанию с той же 
самой архитектурой, как используемая для электрических контактов, 
проводников и выводов. Удерживать клавишу CTRL при расположении их, 
для использования этой особенности. Эти линии, прямоугольники, 
круги, дуги и аннотации не оказывают электрического влияния на 
метод проектирования схем, но могут быть полезными для 
аннотирования схем примечаниями. 

 

Маркировка узлов 
Каждый узел (точка разветвления) в схеме требует уникального 

имени. Можно определить имя узла, при этом произвольное имя не 
сгенерируется. Узел "0" является "землей" - глобальной переменной 
SwCAD и вычерчивается со специальным графическим обозначением 
вместо имени "0". 

Есть также графическое обозначение, определенное для узла "COM", 
но у этого узла нет никакого специального значения. Таким образом, 
это не глобальная переменная SPICE, и это даже не глобальный узел. 
Только иногда удобно иметь графическое обозначение с узлом, 
отличным от земли. 

Если Вы даете узлу имя, начинающееся с символов "$G _"; как 
например, "$G_VDD"; тогда этот узел - глобальная переменная 
независимо от того, где имя встречается в иерархии схемы. 

      
 Можно указать узел - порт типа ввода, выходного устройства, или 

двунаправленный. Эти типы порта будут вычерчены по-другому, но не 
иметь никакого значения для netlister. Индикация типа порта может 
сделать схему более читаемой. Глобальные узлы также вычерчиваются 
по-другому, рамка вычерчивается вокруг имени. 

 

Цвета описания схемы 
Команда меню Tools=>Color позволяет Вам выбирать цвета, 

используемые в отображении описаний схемы. Вы нажимаете на объект в 
типовом описании схемы и используете красные, зеленые и синие 
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бегунки, чтобы корректировать цвета к Вашим предпочтениям. 

 
 Примечание: Неэлектрические графические аннотации, сделанные к 

описанию схемы, например, линии и круги, отображены в том же самом 
цвете как символ компонента. 

 

Размещение новых компонентов 
Определенные часто используемые компоненты, например, резисторы, 

конденсаторы, и катушки индуктивности, могут быть выбраны с кнопки 
панели для того, чтобы поместить их в описание схемы. 

Для большинства обозначений, используйте команду меню 
Edit=>Компонент, чтобы запустить диалог просмотра для прибора, 
который Вам нужен. 
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Программирование горячих клавиш 

 
Команда меню Tools=>Control Panel=>Drafting Options=>Hot Keys 

позволяет Вам программировать горячие клавиши клавиатуры для 
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большинства команд. Мышью отметить команду и затем нажать клавишу 
или комбинацию клавиш, которую требуется закодировать для команды. 
Чтобы удалить ярлык, нажмите на команду и нажмите клавишу "Delete". 

 

Импорт списка соединений печатной платы 
Команда меню Tools=>Export Netlist позволяет Вам генерировать 

список соединений ASCII для схемы размещения печатной платы. 
Обратите внимание, что необходимо установить символы с тем же 
порядком выводов, как в списке соединений. Например, если бы Вы 
хотите импортировать список соединений описания схемы LTspice в 
ExpressPCB <http://www.expresspcb.com>, необходимо бы сделать ряд 
обозначений для каждого LTspice или ExpressPCB с одинаковым 
порядком списка соединений относительно каждого обозначения, 
которое Вы используете. Иначе диоды могут поменять полярность или 
транзисторные выводы перепутаться. 

Следующие форматы доступны: Accel, Algorex, Allegro, Applicon 
Bravo, Applicon Leap, Cadnetix, Calay, Calay90, CBDS, 
Computervision, EE Designer, ExpressPCB, Intergraph, Mentor, 
Multiwire, PADS, Scicards, Tango, Telesis, Vectron, and Wire List. 

 

Редактирование компонентов 
Компоненты могут быть отредактированы двумя или тремя различными 

способами, в зависимости от типа компонента: 

1. Большинство видимых полей атрибута компонента может быть 
отредактировано при указании на это с мышью и затем правым щелчком. 
Курсор мыши превратится в текстовый символ "^", когда он укажет на 
текст. 

2. У многих типов компонента, например, резисторов, 
конденсаторов, катушек индуктивности, диодов, биполярных 
транзисторов, транзисторов MOSFET, транзисторов JFET, независимых 
источников напряжения, независимых источников тока, и иерархических 
блоков схемы есть специальные редакторы. Эти редакторы могут 
обратиться к соответствующей базе данных приборов. Чтобы 
использовать эти редакторы, правый клик мышью на символе 
компонента. 

3. Поместить мышь на обозначение, удержать клавишу CTRL, и нажать 
правую кнопку мыши. Появится диалоговое окно с отображением всех 
доступных атрибутов обозначения. Рядом с каждым полем флажок, чтобы 
указать, должно ли поле быть видимым на описании схемы. 

 

Редактировать видимый атрибут 
Большинство видимых полей атрибута компонента может быть 

отредактировано при указании на это с мышью и затем правым щелчком. 
Курсор мыши превратится в текстовый символ "^", когда он укажет на 
текст. Это - удобный способ изменить значение компонента. 
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Специализированные редакторы компонента 
Много типов компонентов, такие - резисторы, конденсаторы, катушки 

индуктивности, диоды, биполярные транзисторы, транзисторы MOSFET, 
транзисторы JFET, независимые источники напряжения, независимые 
источники тока, и иерархические блоки схемы имеют специальные 
редакторы. Эти редакторы могут обратиться к соответствующей базе 
данных связанных компонентов. Чтобы использовать эти редакторы, 
правый клик мышью на символе компонента. 
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Общий редактор атрибута 
Иногда по умолчанию задано получить прямой доступ к каждому 

действующему атрибуту компонента, редактировать их информационные 
наполнения и обозримость. Редактор позволяет это делать. Поместив 
мышь на символе, удерживая клавишу CTRL, правый щелчок мышью, 
появится диалоговое окно, где отображены все действующие атрибуты 
символа. Рядом с каждым полем флажок, чтобы указать, должно ли поле 
быть видимым на описании схемы. 

Атрибуты SpiceModel, Value, Value2, SpiceLine, и SpiceLine2 
являются полным значением компонента. В терминах SwCAD компонент 
есть "схемосписочный элемент" (netlisted) для SPICE, в виде строки. 
Выглядит эта строка компонента в SPICE netlist следующим образом: 

<имя node1 node2> [...] <SpiceModel> 

+ <Value> <Value2> <SpiceLine> <SpiceLine2> 

Атрибут Prefix, определяющий тип схемного элемента, автоматически 
дублируется в качестве первого символа атрибута InstName. Если он 
отличен от первого символа InstName, символы Prefix и InstName 
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будут разделены символом '$' в этом случае. Например, если у Вас 
будут Префиксный атрибут "M" и атрибут InstName "Q1", то именем в 
списке соединений будет M$Q1. Это позволяет использовать InstName с 
другим ведущим символом, чем используется в LTSPICE, чтобы 
идентифицировать тип прибора. 

Есть три исключения к вышеупомянутому правилу. Есть одно 
специальное обозначение, перемычка, она не транслируется в схемный 
элемент, но является директивой на датчик списка соединений, это 
два различных имени для того же самого электрически идентичного 
узла. Другое исключение - обозначение, определенное, чтобы иметь 
префикс 'X' и определенные атрибуты Value и Value2. Такие списки 
соединений компонента занимает две строки SPICE: 

.lib <SpiceModel> 

<имя node1 node2> [...] <Value2> 

Это позволяет обозначениям, определяемым автоматически, включать 
библиотеку, которая содержит определение подсхемы названного 
компонента. Компилятор списка соединений удаляет, копируют .lib 
операторов. Обратите внимание, что такие компоненты не доступны для 
редактирования в редакторе схем. Третье исключение - это 
обозначение, определенное, чтобы иметь префикс 'X' и определенный 
атрибут ModelFile. Такой компонент также в списке соединений как 
две строки SPICE: 

.lib <ModelFile> 

<имя node1 node2> [...] <SpiceModel> <Value> <Value2> <SpiceLine> 
<SpiceLine2> 

Использовать этот метод, когда Вы хотите автоматически включить 
библиотечный файл, и иметь экземпляр класса этого доступного для 
редактирования обозначения. Если атрибут обозначения SpiceModel 
будет существовать и будет именем подсхемы в файле, установленном 
как <ModelFile>, то список снижения всех имен подсхем будет 
доступен, когда экземпляр класса обозначения будет отредактирован 
на описании схемы. 
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Создание новых символов 
Обзор редактора обозначений  

Обозначения могут представить примитивный прибор, например, 
резистор или конденсатор; библиотечная подсхема в отдельном файле; 
или другая страница описания схемы. Этот раздел описывает, как 
определить Ваши собственные новые обозначения. Чтобы запустить 
новое обозначение, используйте команду меню File=>New Symbol. 

ОТМЕТИТЬ: обновления Экрана во время редактирования обозначения 
могут быть медленными. Если это - задача с Вашей видео платой, 
уменьшите размер окна редактирования обозначения, чтобы ускорить 
перерисовки экрана и/или уменьшите цветную разрешающую способность 
экрана. Это даст лучшую реакцию на движение мыши. 

 

Рисунок символа 
Вы вычерчиваете символ обозначения как ряд строк, 

прямоугольников, кругов, и дуг. Объекты не оказывают электрического 
влияния на схему. Можно также вычертить текст на обозначении с 
Draw=>Text, эта команда не оказывает влияния на схему. Точки 
привязки объекта вычерчиваются с небольшими красными кругами, для 
перемещения захватить их вокруг. Можно переключить красные 
маркировочные отметки выкл. и вкл. с командой меню View=>Mark 
Привязки Объекта. 

 
 

Добавление Выводов 
Выводы позволяют подключение к обозначению электросети. 

Использовать команду меню Edit=>Add Pin/Port , чтобы добавить новый 
вывод. 
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"Pin Label Position" определяет, как метка вывода 
представляется."TOP", "BOTTOM", "LEFT", и "RIGHT" являются 
текстовыми выравниваниями. Например, если метка вывода будет 
выровненной TOP, то вывод (точка привязки текстового выравнивания 
метки) будет выше метки. Если обозначение представляет элемент 
примитива SPICE или подсхему от библиотеки, то метка вывода не 
оказывает прямого электрического влияния на схему. Однако если 
обозначение представляет описание схемы низшего уровня 
иерархического описания схемы, то имя вывода существенно как имя 
сети в более низком описании схемы уровня. 

 "Netlist Order" определяет порядок (номер) этого вывода в записи 
netlist для SPICE. 

 

Добавление Атрибутов 
Можно определить атрибуты по умолчанию для компонента, используя 

команду меню Edit => Attributes => Edit Attributes. Самый важный 
атрибут называют "Префиксом". Он определяет основной тип 
компонента. Если компонент представляет примитив SPICE, у 
обозначения должен быть соответствующий префикс, R для резистора, C 
или конденсатора, M для MOSFET, и т.д. См. ссылку LTspice для 
полного набора доступных примитивов SPICE. Префикс должен быть 'X', 
если Вы хотите использовать компонент, чтобы представить подсхему, 
определенную в библиотеке. 

Атрибуты обозначения могут быть изменены в экземпляре класса 
обозначения компонента в описании схемы. Например, если у Вас есть 
обозначение для MOSFET с префиксным атрибутом 'M', можно изменить 
префикс на 'X', на основе экземпляра одного класса экземпляром 
другого класса так, чтобы транзистор мог быть оформлен как 
подсхема. 

Специальная комбинация этих атрибутов заставит требованную 
библиотеку быть автоматически включенной в каждое описание схемы 
при использования обозначения: 

Префикс: X 

SpiceModel: <имя файла, включающего SPICEмодель> 

Value: <Что должно быть видимым на описании схемы> 
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Value2: <значение, которое должно быть в списке соединений> 

Value2 был бы должен совпасть с именем подсхемы, определенным в 
файле, включающем spicemodel, и может передать дополнительные 
параметры для подсхемы. Когда обозначение определяется этим 
способом, экземпляром класса обозначения, компонент на описании 
схемы не может быть отредактирован, чтобы иметь измененные 
атрибуты. 

 
Если требуется, чтобы обозначение представило другую страницу 

иерархического описания схемы, все атрибуты должны быть пустым 
пробелом, тип обозначения должен быть изменен "Cell" на "Block". 
Никакие атрибуты со значением не должны быть установленными. 

Может быть указан атрибут обозначения ModelFile. Это используется 
для имени файла, который будет включен в список соединений как 
библиотека. Смотрите, что символ и подсхема это пара 
.\lib\sym\Opamps\1pole.asy и .\lib\sub\1pole.sub, чтобы видеть 
пример утилиты этого атрибута. Если префиксный атрибут 'X', это 
атрибут обозначения, определенный SpiceModel, и это подсхема, 
определенная в модельном файле, то список снижения всех имен 
подсхем будет доступен, когда экземпляр класса компонента будет 
отредактирован на описании схемы. 

 

Обозримость Атрибута 
Можно редактировать обозримость атрибутов, используя команду меню 

Edit => Attributes => Окно Атрибута. После того, как Вы выберете 
атрибут этим диалогом, Вы тогда будете в состоянии позиционировать 
его, где Вы желаете поместить символ. 
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Можно изменить текстовое выравнивание и информационные наполнения 

атрибутов размещенных символов правой мышью, нажимающей на текст 
атрибута. 

 

Иерархия  
Краткий обзор Иерархии 

У иерархического составления описания схемы есть сильные 
преимущества. Могут быть вычерчены намного большие схемы, чем можно 
подогнать на одно листовое описание схемы при сохранении ясности 
меньших описаний схемы. Вторичная схема легко обрабатывается 
абстрактным способом. Блоки схемы могут быть библиотечными для 
последнего использования в различном проекте. 

 

Правила Иерархии 
Способ именовать вложенные схемы как блок в высокоуровневом 

описании схемы состоит в том, чтобы создать символ с тем же самым 
именем как описание схемы блока и затем размещении этого компонента 
в высокоуровневое описание схемы. Например, если у Вас есть 
описание схемы верхнего уровня, названное topXYZ.asc, и другой файл 
описания схемы, названный preamp.asc, требуется поместить в 
описании схемы topXYZ, тогда создают символ, названный preamp.asy, 
и помещают экземпляр этого символа на описании схемы topXYZ. 
Электрическое обеспечение связи между описаниями схемы 
устанавливается при присоединении проводов схемы более высокого 
уровня к выводам блока более низкого уровня, эти выводы есть имена 
узлов в описании схемы низшего уровня. Имена символов, используемых 
как блоки, и имена описаний схем, передаваемых этому блоку, должны 
состоять из допустимых символов, может использоваться имя файла без 
пробелов. 
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LTspice будет смотреть в каталоге схемы верхнего уровня для 

компонентов и блоков, чтобы завершить описание схемы верхнего 
уровня. 

У компонента, который Вы создаете, чтобы представить блок 
описания схемы низшего уровня, не должно быть никаких определенных 
атрибутов (кроме Value и Description. Прим. перев.). 

 

Управление Иерархией 
Любой файл, открытый командой File=>Open считается описанием 

схемы верхнего уровня. Можно добавить директивы SPICE к этому блоку 
и выполнить моделирование, используя только его, или добавить любые 
описания схемы низшего уровня, на которые он ссылается. 

Чтобы открыть блок схемы как экземпляр блока схемы более высокого 
уровня, сначала откройте описание схемы более высокого уровня и 
затем переместите мышь в символ экземпляра, вызывающего блок. Когда 
правый клик мышью на экземпляре этого символа, специальный диалог 
появляется, что позволяет Вам открывать описание схемы. Когда Вы 
открываете описание схемы этим способом, можно перенести тестовое 
сообщение узлы и ток в блоке. Обратите внимание, что у Вас должны 
быть опции  "Save Subcircuit Node Voltages"  и "Save Subcircuit 
Device Currents" отмечены Save Defaults Pane of the Control Panel. 
Кроме того, если Вы подсветили узел на описании схемы верхнего 
уровня, тот узел будет также подсвечен в более низком блоке уровня. 
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Обратите внимание, что диалог, также позволяет Вам вводить 

параметры, чтобы пройти к этому экземпляру схемы в preamp.asc. 

 

Просмотр Формы сигнала 
Краткий обзор  

SwitcherCAD III включает интегрированное средство просмотра формы 
сигнала, которое позволяет законченный контроль способа черчения 
данных моделирования. 

 

Выбор отображаемых графиков  
Есть три основных средства выбора отображаемых графиков.  

1. Исследование непосредственно из описания схемы 

2. Команда меню Plot Settings=>Visible Traces  

3. Команда меню Plot Settings=>Add Trace  

Undo и Redo команды  позволяют Вам выбирать и возвращать выбор  
различных отображаемых графиков независимо от того, какой метод 
выбора используется. 

 

1. Исследование непосредственно от описания схемы: 

Самый простой метод должен просто исследовать описание схемы. Вы 
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просто указываете и нажимаете на проводе, чтобы чертить напряжения 
на этом проводе. Вы чертите график тока через любой компонент с 
двумя подключениями (как резистор, конденсатор или катушка 
индуктивности) при нажатии на символ компонента. Это работает на 
любом уровне иерархии схемы. Можно также чертить график тока в 
компоненте с больше чем двумя выводами, при нажатии на тот вывод 
символа, ток которого желаете отобразить, направление тока входящее 

 



29 
 

в компонент. Если Вы нажмете то же самое напряжение или ток дважды, 
то все другие трассировки будут стерты, и дважды нажатая 
трассировка будет чертиться отдельно. Можно удалить индивидуальные 
трассировки при нажатии на метку трассировки и выбором удаляющей 
команды. Скриншот показывает, как указать на ток вывода. Обратить 
внимание, что курсор мыши превращается в значок, который похож на 
зажим на амперметре, когда это указывает на ток, который будет 
чертиться. 

 
Также возможно указать на разность напряжения мышью. Можно нажать 

на один узел и перетащить мышь к другому узлу. Вы будете видеть 
красный вольтметровый щуп в первом узле и черное тестовое сообщение 
на втором. Это позволяет Вам чертить разность напряжения. 
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Еще один график чертит мощность мгновенного рассеяния компонента. 
Чтобы сделать это, удержите клавишу ALT и нажмите на символ 
компонента. Мгновенное рассеяние энергии будет чертиться как 
произведение напряжений и токов. Это будет чертиться в своем 
собственном масштабе с единицами Ватт. Курсор мыши превращается в 
значок, который похож на термометр, когда он указывает на мощность, 
которая может чертиться. Можно найти усредненное рассеяние энергии 
щелчком трассировочной метки и удерживая клавишу Ctrl. 

2. Команда меню Plot Settings=>Visible Traces: 

Команда меню Plot Settings => Видимые Трассировки является 
диалогом, видимым в начале составления графика данных при 
моделировании. Это позволяет Вам выбирать начальные трассировки, 
чтобы запустить график. Это также дает Вам, произвольный доступ к 
полному списку графиков. 

 
3. Команда меню Plot Settings=>Add Trace: похожа на команду Plot 

Settings => Visible Traces. Однако с ней невозможно удалить 
трассировки, которые уже видимы. У нее есть две полезных 
возможности. Это окно редактирования вверху диалога, которое 
позволяет Вам вводить шаблон кодовых комбинаций. Только проследите 
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имена, которые соответствуют шаблону, будут показаны в диалоге. Это 
очень полезно для обнаружения трассировки, когда можно только 
частично помнить имя. Кроме того, здесь немного проще составить 
переменную трассировочных данных, потому что можно нажать на имя в 
диалоге вместо того, чтобы печатать имя.  

 

Изменение масштаба изображения 
LTspice/SwitcherCAD III автоизменяет масштаб изображения всякий 

раз, когда есть новые данные, чтобы чертить. Чтобы изменить масштаб 
изображения на участке, просто перетащите рамку вокруг области, 
которую требуется видеть увеличенной. 

Кнопки панели и команды меню для того, чтобы изменить масштаб 
изображения, панорамирование, и возвратиться к автомасштабу 
изменяют масштаб изображения. Примечание: команды Undo и Redo 
позволяют делать обзор различного масштаба изображения. 

 
 

Арифметика Формы сигнала 
Есть три типа математических операций, которые могут быть 

выполнены на данных формы сигнала: 

1. Отобразить математические выражения для графиков. 

2. Вычислить УСРЕДНЕННОЕ или СРЕДНЕКВАДРАТИЧНОЕ значение графика. 

3. Отобразить преобразование Фурье графика. 

 

1. Математические выражения трассировок. 

Обе команды View=>Visible Traces и View=>Add Trace позволяют 
вводить математические выражения данных. Другой метод чертить 
математические выражения доступных данных моделирования - 
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переместить мышь в метку трассировки и правый щелчок. Это 
диалоговое окно также позволяет Вам выбирать цвет трассировки и 
позволяет Вам прикреплять курсор к форме сигнала. LTspice будет 
проводить размерное исследование выражения, и чертить его по 
вертикальной оси, помеченной теми единицами. Все формы сигнала в 
области окна вычерчивания с теми же самыми единицами чертятся на 
той же самой оси. 

Разность двух напряжений V(a)-V(b) эквивалентно записи V(a,b). 

 
 

 Следующие функции доступны для действительных данных: 

Имя функции Описание 

abs(x) Абсолютное значение x 

acos(x)  Арккосинус x 

arccos(x)  Синоним для Арккосинус x 

acosh(x)  Арккосинус гиперболический x 

asin(x)  Арксинус x 

arcsin(x)  Синоним для Арксинус x 

asinh(x)  Арксинус гиперболический x 

atan(x)  Арктангенс x 

arctan(x)  Синоним для Арктангенс x 

atan2(y, x)  Четырехквадрантный арктангенс y/x 
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atanh(x)  Арктангенс гиперболический x 

buf(x)  1 если x >0.5, иначе 0  

ceil(x)  Целое число, равное или больше чем x 

cos(x)  Косинус x 

cosh(x)  Гиперболический косинус x 

d()  Производная, основанная на конечных разностях  

exp(x)  e в степени x  

floor(x)  Целое число, равное или меньше чем x 

hypot(x,y)  Квадратный корень(x**2 + y**2) 

if(x,y,z)  Если x>.5, то y иначе z 

int(x)  целая часть x 

inv(x)  0 если x>.5, иначе 1.(инверсия) 

limit(x,y,z)  Промежуточное (среднее?) значение x, y, и z 

ln(x)  Натуральный логарифм x 

log(x)  Дополнительный синтаксис для ln (x) 

log10(x)  Логарифм по основанию 10 

max(x,y)  Больше из x или y 

min(x,y)  Меньший из x или y 

pow(x,y)  x в степени y  

pwr(x,y)  (модуль?) абсолютный (x) в степени y 

pwrs(x,y)  sgn(x)*abs(x)**y  

rand(x)  Случайное число между 0 и 1 в зависимости от 
целочисленного значения x 

random(x)  Подобный rand(x), но гладко переключения 
между значениями.  

round(x)  Самое близкое целое число к x 

sgn(x)  Знак x; -1 если х<0, +1 если х>0…? 

sin(x)  Синус x 

sinh(x)  Гиперболический синус x 

sqrt(x)  Квадратный корень x 
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table(x,a,b,c,d,...)  Интерполировать значение для x основанный на таблице просмотра, данной как ряд пар точек.  

tan(x)  Тангенс x 

tanh(x)  Гиперболический тангенс x 

u(x)  Шаг единицы, 1 если x>0 иначе 0.  

uramp(x)  x, если x> 0 иначе 0.  

white(x)  
Случайное число между -.5 и .5 гладко 
переключения между значениями даже более 
гладко чем случайный (). 

 

Для комплексных данных функции atan2(), sgn(),u(), buf(), inv() 
uramp(), int(), floor(), ceil(), rand(), min(), limit(), if(),и 
table(...) не доступны. Функции Re(x) и Im(x) доступны для 
комплексных данных и возвращают комплексное число с вещественной 
частью, равной действительной или мнимой части параметра 
соответственно и мнимой части, равной нулю. Функции Ph(x) и Mag(x) 
также доступны для комплексных данных и возвращают комплексное 
число с вещественной частью, равной углу сдвига фаз или величине 
параметра соответственно и мнимой части, равной нулю. Функция 
conj(x) также доступен для комплексных данных и возвращает 
комплекс, сопряженный с x.  

Следующие операции, группированные в обратном порядке 
предшествования эволюции, доступны для действительных данных: 

Операнд Описание 

& Преобразовать переменные в каждой части в Булевские 
переменные, затем И. 

| Преобразовать переменные в каждой части в Булевские 
переменные, затем ИЛИ. 

^ Преобразовать переменные в каждой части в Булевские 
переменные, затем неэквивалентность(XOR). 

> TRUE, если выражение слева больше чем выражение справа, 
иначе FALSE. 

< TRUE, если выражение слева - меньше чем выражение справа, 
иначе FALSE. 

>= TRUE, если выражение слева меньше чем или равно выражению 
справа, иначе FALSE. 

<= TRUE, если выражение слева больше чем или равняется 
выражению справа, иначе FALSE. 

+ Суммирование 

- Вычитание 

* Умножение 

/ Деление 
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** Возвести левую сторону в степень правой стороны. 

! Преобразовать следующую переменную в Булевские переменные 
и инвертировать. 

@ Оператор выбора шага 

TRUE в цифровой форме равен 1, и FALSE 0. Превращение к Булевским 
переменным преобразовывает значение в 1, если значение больше чем 
0.5, иначе значение преобразовывается к 0. 

Оператор выбора шага @ полезен, когда выполняется множественное 
моделирование, доступен в .step, .temp, или .dc исследовании. Он 
выбирает данные для специфичного запуска. Например, V(1)@3 чертил 
бы данные от 3-ьего, выполненного независимо от того какие шаги где 
выбраны для того, чтобы чертить. 

Для комплексных данных, только +, -, *, /, **, и @ доступны. 
Также относительно комплексных данных, оператор неэквивалентности 
Булевских переменных XOR, ^, как понимают, означает возведение в 
степень, **. 

Следующие константы внутренне определены: 

Имя Значение 

E 2.7182818284590452354 

Pi 3.14159265358979323846 

K 1.3806503e-23 

Q 1.602176462e-19 

Ключевое слово "time" понимается при вычерчивании данных формы 
сигнала анализа переходных процессов. Точно так же "freq" и "omega" 
понимаются при вычерчивании данных исследования AC. "w" может 
использоваться как синоним для омеги. 

2. Вычислить усреднение или СРЕДНЕКВАДРАТИЧНОЕ ЗНАЧЕНИЕ графика. 

 
Средство просмотра формы сигнала может интегрировать трассировку, 

чтобы получить усреднение и ЭФФЕКТИВНУЮ ВЕЛИЧИНУ по отображенной 
области. Сначала изменить масштаб изображения формы сигнала к 
области, представляющей интерес, затем переместить мышь в метку 
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трассировки, удержать клавишу CTRL и левый щелчок мыши. 

3. Отобразить преобразование Фурье Трассировки. 

Можно использовать команду меню View=>FFT, чтобы выполнить 
Быстрое преобразование Фурье на различных трассировках данных. 

 
 

Определяемые пользователем Функции 
Команда меню PlotSettings=>EditPlotDefsFile позволяет Вам вводить 

свои собственные функциональные определения и определения параметра 
для использования в средстве просмотра формы сигнала. Эти функции 
сохраняются в файле plot.defs в том же самом каталоге как 
выполнимая программа SwCADIII, scad3.exe. 

Затем синтаксис - то же самое как .param и .func операторы, 
используемые для параметризуемых схем. Например, линия 

.func Pythag (x, y) {sqrt (x*x+y*y)} 

определяет функцию Pythag (), чтобы быть квадратным корнем суммы 
его двух параметров. 

Точно так же линия 

.param twopi = 2*pi 

определяет twopi, чтобы быть 6.28318530717959. Обратите внимание, 
что это использует уже внутренне определенное постоянное Pi 
средства просмотра формы сигнала. 
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Контроль осей графика 
Когда Вы помещаете курсор мыши вне области данных, курсор 

превращается в линейку. Это указывает на атрибуты той оси. Левым 
щелчком можно ввести диалог, чтобы вручную ввести диапазон оси и 
характер графика. Например, для действительных данных, если Вы 
перемещаете мышь в нижнюю часть экрана и левый щелчок, можно ввести 
диалог, чтобы изменить горизонтальные параметры шкалы. Это 
позволяет Вам делать параметрические графики. 

Для комплексных данных можно чертить каждую фазу, групповое время 
задержки, или ничего против правой вертикальной оси. Можно изменить 
изображение комплексных данных от Bode до Nyquist или 
Cartesian(Декартов) при перемещении мыши в левую вертикальную ось 
комплексных данных. 

 

Графические области окна 
Множественные графические области окна могут быть отображены на 

одном окне. Это позволяет лучшее разделение между трассировками и 
позволяет различным трассировкам быть независимо 
автомасштабированными. Трассировки можно перетащить между областями 
окна при перемещении метки. Копия трассировки может быть сделана на 
другой области окна при удерживании клавиши CTRL, когда Вы 
выпускаете кнопку мыши. 

 
 

Управление цветом  
Команда меню Tools=>ColorPreferences позволяет Вам выбирать 
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цвета, используемые для того, чтобы чертить данные. Вы нажимаете на 
объект в типовом графике и используете красные, зеленые и синие 
бегунки, чтобы корректировать цвета к Вашим предпочтениям. 

  
 

Прикрепленные курсоры 

 

Доступно на усмотрении два прикрепленных курсора. Можно 
прикрепить курсор к трассировке левой мышью, нажимающей на 
трассировочную метку. Можно прикрепить оба курсора к отдельной 
трассировке правым кликом, нажимающим на трассировочную метку и в 
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окне Expression editor падающее меню Attached Cursor выбрать "1-ый 
& 2-ой", или 1-ый или 2-ой курсор. Прикрепленные курсоры можно 
перетащить мышью или перемещать клавишами управления курсором. 

Когда есть прикрепленные активные курсоры, становится видимым 
дисплей считывания, который покажет Вам значение координат 
местоположения и различие курсоров. 

 
Обратите внимание, что есть также значение координат курсора 

мыши, независимое от вышеупомянутого прикрепленного считывания 
курсора. При  нахождении мыши над окном формы сигнала, позиция мыши 
видна в строке состояния. Если Вы перетаскиваете мышь, как будто Вы 
собирались изменить масштаб изображения, размер рамки отображается 
на строке состояния. Это позволяет Вам быстро измерять разницу 
курсором мыши. Если горизонтальная ось - время, то эта разница во 
времени также преобразовывается к частоте. 

Можно измерить разницу этим способом, не изменяя масштаб 
изображения нажимом клавиши ESC или правой кнопки мыши прежде, чем 
выпустить левую кнопку мыши. 

Прикрепленные курсоры могут также использоваться для считывания, 
какая трассировка принадлежит, к какому пуску .step/.dc/.temp 
набора моделирования. Можно перемещать курсор от данных к данным 
клавишами клавиатуры вверх\вниз управления курсором и затем 
щелкнуть правой кнопкой мыши на курсоре, чтобы видеть информацию о 
шаге для выполненного. 
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Сохранить графические конфигурации 
Команды меню Plot Settings=>Save Plot Settings/Open Plot Settings 

files позволяют Вам читать и записывать графические конфигурации на 
диск. Файлы, устанавливающие график, является файлами ASCII, у 
которых расширение имени файла .plt. Заданное по умолчанию имя 
файла вычисляется с имени файла данных при замене ".raw" расширения 
файла данных на ".plt", Если такое наименование файла существует, 
при открытии файла данных этот графический файл параметров 
настройки читается для начальной графической конфигурации. 

Каждый тип исследования: .tran .ac .noise, и т.д., имеет свой 
собственный элемент в графическом файле параметров настройки. 
Невозможно загрузить параметры настройки от одного типа 
исследования для другого. Но можно использовать графический файл 
параметров настройки от другого моделирования того же самого типа 
исследования. 

 

Формат файла с Быстрым Доступом 
Во время моделирования LTspice обычно использует сжатый формат 

двоичного файла, который позволяет дополнительным данным 
моделирования быть добавленными, не изменяя остальную часть файла. 
Но как только моделирование заканчивается, этот формат файла может 
замедлять доступ при добавлении единственной новой графической 
трассировки. 

Чтобы уменьшить задержку, можно преобразовать файл к 
альтернативному формату, с Быстрым Доступом (Fast Access). Этот 
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формат можно сделать только после того, как моделирование 
заканчивается, когда никакие новые данные не будут добавлены к 
файлу. Но как только файл преобразовывается к этому формату, время 
загрузки новых трассировок обычно уменьшаться с коэффициентом, 
равным количеству трассировок данных, которые были сохранены в 
файле. Например, если у Вас есть файл на 5 Гбайт с 2000 
трассировками данных, может потребоваться 4 минуты, чтобы добавить 
новую трассировку. Но после того, как Вы преобразуете его в формат 
Fast Access, это четырехминутное время загрузки будет уменьшено до 
одной секунды. Это делает сквозное исследование больших схем, с 
моделированием огромных файлов данных, интерактивным. Точное время, 
необходимое чтобы загрузить трассировку файла формата Fast Access, 
будет зависеть больше от количества физической памяти, которую Вы 
имеете, чем от скорости жесткого диска. 

Чтобы преобразовать окно формы сигнала в формат Fast Access, 
сделайте окно формы сигнала активным окном и выполните команду меню 
=>Files=>ConvertToFastAccess. Процесс превращения будет требовать 
количество свободного дискового пространства, равное размеру файла, 
который будет преобразован, но переделанный файл будет только на 11 
байтов больше, чем исходный файл. 

Процесс превращения может занять много времени и использовать до 
одной четверти Вашей физической памяти. Фактически преобразовать 
файл к формату Fast Access может занять больше времени, чем было 
затрачено для начального моделирования. Точное время, которое 
потребует превращение, будет зависеть от состояния измельчения 
жесткого диска и количество физической памяти, которую Вы имеете. 
Во время превращения Ваша машина может реагировать с задержкой на 
мышь и клавиатуру. Возможно преобразовать файлы в групповой команде 
со следующим синтаксисом линии передачи команд: 

scad3.exe-FastAccess <файл> 

Где <файл> - имя.raw файла, который требуется преобразовать в 
формат с Быстрым Доступом. 

Этот формат поддерживается только для действительных данных, не 
для комплексных данных, которые исходят из .ac исследования.
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LTspice® 
 

Краткий обзор LTspice® 
LTspice - механизм моделирования схемы для SwitcherCAD III 

<SwitcherCAD_III_Overview.htm>. LTspice - управляемая описанием 
схемы программа моделирования схемы. Симулятор LTspice 
первоначально был основан несколько лет назад на Беркли SPICE 
3F4/5. Симулятор прошел полную перезапись, чтобы улучшить 
производительность симулятора, точность анализа, и расширить 
симулятор для выполнения моделирования полупроводника отраслевого 
стандарта и поведенческих моделей. Добавлена возможность цифрового 
моделирования наряду с обширными расширениями к аналоговому 
симулятору SPICE, для достижения LTspice высокой степени разработки 
на уровне плат аналогового и симулятора смешанного режима для 
многих классов схем, например, переключающихся регуляторов и 
фильтров с переключаемыми конденсаторами. 

Много продуктов Linear Technology оформляются с частными ячейками 
структурной схемы и/или частным аппаратным языком пробоя, которые 
точно формируют реалистичный режим с пользовательскими 
макромоделями <A_Special_functions_.htm>. Это позволяет 
объединительной силовой схеме имитироваться и моделироваться 
быстро. 

LTspice может использоваться как универсальный симулятор SPICE. 
Новые схемы могут быть вычерчены со встроенным описанием схемы 
<Schematic_Editing.htm>. Команды моделирования и параметры 
помещаются как текст на описании схемы, используя установленный 
синтаксис SPICE <A_General_Structure_and_Conventions.htm>. Формы 
сигнала узлов схемы и электрических токов прибора могут чертиться 
при щелчке мыши на узлах в описании схемы во время или после 
моделирования. 

Неоценимой ссылкой, которая дополняет эту документацию, является 
2-ой Выпуск Моделирования Полупроводникового устройства с SPICE 
Giuseppe Massobrio и Paolo Antognetti, Выступом McGraw, 1993. Эта 
книга документирует уравнения полупроводникового устройства и 
расширения, которые использовались в различных коммерческих 
программах SPICE, включающих используемых в этом. Для BSIM 3 и 4 
устройства, см. релевантная документация, доступная от UC Berkeley 
CAD group. 

LTspice и SwitcherCAD - зарегистрированные торговые марки Linear 
Technology Corporation.  

 

Введение 
Описание Схемы 

Схемы определяются текстовым списком соединений. Список 
соединений состоит из списка схемных элементов и их узлов, 
модельных определений, и других команд SPICE. 
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Список соединений обычно графически вводится. Чтобы запустить 
новое описание схемы, выберите File=>Open пункт меню. Появится 
средство просмотра файла windows. Каждое сохранение существующего 
описания схемы под новым именем или создание новой схемы с новым 
именем, создает новый файл описания схемы. LTspice использует много 
различных типов файлов и документов. Вы будете использовать файлы с 
расширением имени файла ".asc". Команды описания схемы находятся в 
меню Edit. Горячая клавиатура для команд перечисляется в разделе 
Описание (ввод) схемы - Программирование горячих клавиш. 

Когда Вы имитируете схему, информация о списке соединений 
извлекается из графической информации схемы в файл с тем же самым 
именем как описание схемы, но с расширением имени файла ".net". 
LTspice читает в этом списке соединений. 

Можно также открыть, имитировать, и редактировать текстовый 
список соединений, созданный вручную или другим СПАЙС. Файлы с 
расширениями ".net", ".cir", или ".sp" распознаются LTspice как 
списки соединений. 

Этот раздел справки документирует синтаксис, используемый в 
списках соединений, но иногда дает совет уровня описания схемы. 

 

Общая структура и соглашения 

Схема, которая будет проанализирована, описывается текстовым 
файлом, названным списком соединений. Первая строка в списке 
соединений игнорируется, то есть предполагается это комментарий. 
Последняя строка списка соединений - обычно просто строка ".END ", 
но это может быть опущено. Любые строки после строки ".END" 
игнорируются. 

Порядок строк между комментарием и концом является 
несущественным. Строки могут быть комментариями, объявлениями 
схемного элемента или директивами моделирования. Давайте начнем с 
примера: 

* Эта первая строка игнорируется 

* Схема ниже представляет управляемую RC-цепь 

* с импульсным сигналом сигнала на 1 МГц 

R1 n1 n2 1к; 1KOhm резистор <R_Resistor.htm> между узлами n1 и n2 

C1 n2 0 100p; 100pF конденсатор <C_Capacitor.htm> между узлами n2 
и земля 

V1 n1 0 ИМПУЛЬСОВ <V_Voltage_Source.htm> (0 1 0 0 0.5µ 1µ); 
импульсный сигнал на 1 мгц 

.tran <_TRAN_Do_a_non_linear_transient_analysis.htm> 3µ; сделайте 
3µs длинный анализ переходных процессов 

.end 

Первые две строки - комментарии. Любая строка, начинающаяся с 
"*", является комментарием и игнорируется. Строка, начинающаяся с 
"R1", объявляет, что есть резистор 1K, подключенный между узлами n1 
и n2. Обратите внимание, что точка с запятой, ";", может 
использоваться, чтобы запустить комментарий в середине строки. 
Строка, начинающаяся с "C1", объявляет, что есть 100pF конденсатор 
между узлами n2 и земля. Узел "0" - глобальная общая земля схемы. 
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КРАТКИЙ ОБЗОР словаря LTspice: 

o Регистр, межстрочные интервалы, пробелы, и позиции табуляции 
игнорируются. 

o первый незнакпробела строки определяет тип схемного элемента. 

Ведущий 
Символ Тип строки 

* Комментарий 

A Специальный функциональный прибор 

B Произвольный поведенческий исток 

C Конденсатор 

D Диод 

E Источник напряжения зависимый от напряжения  

F Источник тока зависимый от тока  

G Источник тока зависимый от напряжения  

H Источник напряжения зависимый от тока  

I Независимый источник тока 

J Транзистор JFET 

K Взаимная катушка индуктивности 

L Катушка индуктивности 

M Транзистор MOSFET 

O Линия электропередачи с потерями 

Q Биполярный транзистор 

R Резистор 

S Управляемый переключатель напряжения 

T Линия электропередачи без потерь 

U Универсальная RC-строка 

V Независимый источник напряжения 

W Переключение управляемое током 

X Вызов Подсхемы 

Z Транзистор MESFET 

. Директива моделирования, Например: .options 
<_OPTIONS_Set_simulator_options.htm> reltol=1e-4 

+ Продолжение предыдущей строки. "+" удаляется, и остаток 
от строки считается частью предшествующей строки.  

 

Числа могут быть выражены не только в экспоненциальном 
представлении; например, 1e12; но также используя масштабные 
коэффициенты. Таким образом, 1000.0 или 1e3 может также быть 
записан как 1K. Ниже таблица понятых множителей: 

Суффикс множитель наименование 
T 1e12 Тера 
G 1e9 Гига 
Meg 1e6 Мега 
K 1e3 Кило 
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Mil 25.4e-6  
m 1e-3 Милли 

u (или µ) 1e-6 Микро 
n 1e-9 Нано 
p 1e-12 Пико 
f 1e-15 Фетмо 

Суффиксы не чувствительны к регистру. Игнорируются нераспознанные 
символы немедленно после числа или множительного суффикса. 
Следовательно, 10, 10V, 10 вольтов, и 10 Гц все представляют то же 
самое число, и M, MA, МС, и MMhos, все представляют тот же самый 
масштабный коэффициент (.001). Общая ошибка состоит в том, чтобы 
вычертить резистор со значением 1M, думая о резисторе на один 
мегаом, однако, 1M интерпретируется как один milliOhm резистор. Это 
необходимо для совместимости со стандартной практикой SPICE. 

LTspice поймет числа, написанные в виде 6K34, что будет означать 
6.34K, для любого из множительных суффиксов. Эта опция может быть 
выключена в Tools=>Control Panel=>SPICE убрать отметку "Ввод 3K4 
как 3.4K". 

Имена узлов могут быть произвольными строками символов. Общий 
узел глобальной схемы (земля) "0", хотя "заземление" - специальный 
синоним. Обратите внимание что, так как узлы - строки символов, "0" 
и "00" различные узлы. 

Всюду по следующим разделам справочника угловые скобки помещаются 
вокруг полей данных, которые должны быть заполнены конкретной 
информацией; например, "<srcname>" был бы именем некоторого 
специфичного истока. Квадратные скобки указывают, что включенное 
поле данных является опциональным. 

 

Справочник элементов схемы  
 

КОМПОНЕНТ СИНТАКСИС  

Special functions Axx n1 n2 n3 n4 n5 n6 n7 n8  <model> [extra 
+parameters] 

Arbitrary 
behavioral source 

Bxx n+ n- <V=... or I=...> 

Capacitor Cxx n+ n- <capacitance> [ic=<val.>] 
+[Rser=<val.>] [Lser=<val.>] [Rpar=<val.>] 
+[Cpar=<val.>] [m=<val.>] 

Diode Dxx A K <model> [area] 

Voltage dependent 
voltage 

Exx n+ n- nc+ nc- <gain> 

Current dependent 
current 

Fxx n+ n- <Vnam> <gain> 

Voltage dependent 
current 

Gxx n+ n- nc+ nc- <transcond.> 



46 
 

 

 

Точечные Команды 
C. директивы симулятора - точечные команды 

Для запуска моделирования не только схема должна быть определена, 
но также и тип исследования, которое будет выполнено. Есть шесть 
различных типов исследований: 

1. TRANSIENT - анализ переходных процессов. 

Current dependent 
voltage 

Hxx n+ n- <Vnam> <transres.> 

Independent 
current source 

Ixx n+ n- <current> 

JFET transistor Jxx D G S <model> [area] [off] [IC=<Vds,Vgs>] 
+[temp=<T>] 

Mutual inductance Kxx L1 L2 L3… <coeff.> 

Inductance Lxx n+ n- <inductance> [ic=<val.>] 
+[Rser=<val.>] [Rpar=<val.>] [Cpar=<val.>] 
+[m=<val.>] 

MOSFET transistor Mxx D G S B <model> [L=<len>] [W=<width>] 
+[AD=<area>] [AS=<area>] [PD=<perim>] 
+[PS=<perim>] [NRD=<value>] [NRS=<value>] 
+[off] [IC=<Vds, Vgs, Vbs>] [temp=<T>] 

Lossy transmission 
line 

Oxx L+ L- R+ R- <model> 

Bipolar transistor Qxx C B E [S] <model> [area] [off] 
+[IC=Vbe,Vce][temp=<T>] 

Resistor Rxx n1 n2 <value> 

Voltage controlled 
switch 

Sxx n1 n2 nc+ nc- <model> [on,off] 

Lossless 
transmission line 

Txx L+ L- R+ R- ZO=<value> TD=<value> 

Uniform RC-line Uxx n1 n2 ncommon <model> L=<len> [N=<lumps>] 

Independent 
voltage source 

Vxx n+ n- <voltage> 

Current controlled 
switch 

Wxx n1 n2 <Vnam> <model> [on,off] 

Subcircuit Xxx n1 n2 n3... <subckt name> 

MESFET transistor Zxx D G S model [area] [off] [IC=<Vds,Vgs>] 
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2. AC ANALYSIS – расчет частотных характеристик. 

3. DC sweep – анализ режима DC при изменении U или I. 
4. NOISE – расчет уровня шума. 
5. DC TransFer – переходная функция по DC.  

6. DC OP PNT – режим схемы по DC. 

 Точно одно из этих шести исследований должно быть установлено. 
Принимая во внимание, что топология схемы обычно схематично 
вычерчивается, команды обычно помещаются в описание схемы как 
текст. Все такие команды начинаются с точки и поэтому называются 
"точечными командами". 

 

.AC - исследование малого сигнала AC  
Небольшой сигнал (линейная) часть AC LTspice вычисляет напряжения 

узла комплекса AC как функцию частоты. Во-первых, находится рабочая 
точка схемы DC. Затем, линеаризованные модели малого сигнала в 
схеме находятся для всех нелинейных приборов для этой рабочей 
точки. Наконец, используя независимое напряжение и источники тока 
как сигнал запуска, линеаризованная результирующая схема решается в 
частотной области по указанному диапазону частот. 

Этот режим исследования полезен для фильтров, сетей, исследований 
устойчивости, и рассмотрений шума. 

Синтаксис: .ac <oct, dec, lin> <Nsteps> <StartFreq> <EndFreq> 
Частота перемещается между частотами StartFreq и EndFreq. 
Количество шагов определяется ключевым словом " oct ", " dec ", или 
"lin" и Nsteps согласно следующей таблице: 

Ключевое слово      Nsteps 
Oct Количество шагов в октаву. 
Dec Количество шагов в декаду. 
Lin Полное количество линейно раздельных шагов между 

StartFreq и EndFreq.  

 

.BACKANNO - приписывает электрические токи к 
выводам подсхемы  

Синтаксис: .backanno 

Эта директива автоматически включается в каждый список 
соединений, который SwitcherCAD III генерирует от описания схемы. 
Это направляет LTspice, чтобы включить информацию в .raw файл, 
который может сослаться на портовые электрические токи имени 
вывода. Это позволяет Вам чертить электрический ток в выводе 
символа мышью, нажимающей на вывод символа. 

 

.DC sweep - исследование источника DC 
Выполняет исследование DC при изменении значение DC источника. 

Это полезно для вычисления функции преобразования усилителя DC или 
черчения характеристик транзистора для модельной верификации. 
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Синтаксис: .dc <srcnam> <Vstart> <Vstop> <Vincr> 

+ [<srcnam2> <Vstart2> <Vstop2> <Vincr2>] 

<Srcnam> является независимым напряжением или источником тока, 
который должен быть перемещен от <Vstart> до <Vstop> в <Vincr> 
размеры шага. В следующем примере чертятся заданные по умолчанию 
характеристики BSIM3v3.2.4: 

* Пример .dc sweep  

* 

M1 2 1 0 0 nbsim 

Vgs 1 0 3.5 

Vds 2 0 3.5 

.dc Vds 3.5 0-0.05 Vgs 0 3.5 0.5 

.model nbsim NMOS Level=8 

.save I (Vds) 

.end 

 

 

.END - конец списка соединений 
Эта директива отмечает конец текстового списка соединений. Все 

строки после него игнорируется. Не помещайте это как текст на 
описании схемы, поскольку экстрактор списка соединений поставляет 
это в конец. 

 

.ENDS - конец определения подсхемы 
Эта директива отмечает конец определения подсхемы. См..SUBCKT  

для получения дополнительной информации. 

 

.FOUR - анализ Фурье  
Синтаксис: .four <частота> [Nharmonics] [Nperiods] < data trace1> 

[<data trace2>...] 

Пример: .four 1 кГц V 

Эта команда выполняется после анализа переходных процессов  
.TRAN. Это предоставляется, чтобы быть совместимым с 
унаследованными симуляторами SPICE. Выходное анализ печатается в 
.log файле. Использовать пункт меню "View=>Spice Error Log", чтобы 
видеть выходной файл. В большинстве целей возможность FFT, 
встроенная в средство просмотра формы сигнала, более полезна. 

Если целое число гармоник присутствует, то исследование включает 
это число гармоник. Число значений гармоник по умолчанию 9, если не 
указано. 

Исследование Фурье выполненное за период конечного времени, имеет 
тенденцию к одной точке пока целочисленный Nperiods не будет больше 
Nharmonics. Если Nperiods дается как -1, исследование Фурье 
выполняется по всему диапазону данных моделирования. 
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.FUNC - пользовательские Функции 
Синтаксис: .func <имя> ([параметры]) {<переменная>} 

Пример: .func Pythag (x, y) {sqrt (x*x+y*y)} 

.func директива позволяет создание определяемых пользователем 
функций для использования с определенными пользователем схемами и 
поведенческими источниками. Это полезно для соединения имя с 
функцией ради ясности и параметризации подсхемы так, чтобы 
абстрактные схемы могли быть сохранены в библиотеках. 

.func оператор может быть включен в определение подсхемы, чтобы 
ограничить область видимости функции той подсхемой и подсхемами, 
вызванными той подсхемой. 

Чтобы вызвать подстановку параметра и определение переменной с 
определяемыми пользователем функциями, включите переменную в 
фигурные скобки. Включенная переменная будет заменена значением с 
плавающей точкой. 

Ниже пример использования .func и .param операторов. 

* Приведенный в качестве примера подзаголовок, используя .func 
оператора 

.func myfunc(x,y) {sqrt(x*x+y*y)} 

.param u=100 v=600 

V1 a 0 pulse (0 1 0 1n 1n.5µ 1µ) 

R1 a b {myfunc(u,v/3)} 

C1 b 0 100p 

.tran 3µ 

.end 

Все определение подстановки параметра делают прежде, чем 
моделирование начинается. 

 

.FERRET - загрузка файлов с URL 
Эта команда позволяет Вам загружать файлы в пакетном режиме при 

определении URL. Это удобно, когда Вы не хотите указывать браузеру 
каждый файл. Загруженный файл будет в том же самом каталоге где 
описание схемы источника команды или список соединений. Эта команда 
не имеет никакого эффекта на моделирование. 

* приведенный в качестве примера подзаголовок 

.ferret http://ltspice.linear.com/software/scad3.pdf 

.end 

 

 .GLOBAL - глобальные узлы 
Синтаксис: .global <node1> [node2 [node3] [...]] 

Пример: .global VDD VCC 

.global команда позволяет Вам объявлять, что определенные узлы, 
упомянутые в подсхемах, не являются локальными на подсхему, но 
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являются абсолютными глобальными узлами. 

Обратите внимание, что обычный узел "0" глобальный и .global 
оператор не требуется. Кроме того, имена узла вида "$G _" являются 
также глобальными узлами, не будучи упомянутым в .global операторе.  

 

 .IC - начальные условия анализа 
.ic директива позволяет указать начальные условия анализа 

переходных процессов. Напряжения узла и электрические токи катушки 
индуктивности могут быть указаны. Решение DC выполняется, используя 
начальные условия как ограничения. Обратите внимание, что хотя 
катушки индуктивности обычно обрабатываются как короткие замыкания 
в решении DC в других программах SPICE, если начальный 
электрический ток указан, они обрабатываются как источники тока 
бесконечного полного сопротивления в LTspice. 

Синтаксис: .ic [V(<n1>)=<напряжение>] [I(<катушка 
индуктивности>)=<электрический ток>] 

Пример: .ic V(in)=2 V(out)=5 V(vc)=1.8 I(L1)=300m 

 

.INCLUDE - включают другой Файл 
Синтаксис: .include <имя файла> 

Эта директива включает именованный файл, как будто тот файл был 
напечатан в список соединений вместо .include команды. Это полезно 
для включения библиотек моделей или подсхем. 

Абсолютное имя пути может быть введено для имени файла. Иначе 
LTspice смотрит сначала в каталоге <SwCADIII> \lib\sub и затем в 
каталоге, который содержит вызываемый нетлист, где <SwCADIII> - 
каталог, содержащий scad3.exe выполнимую программу, обычно 
устанавливаемую как C:\Program Files\LTC\SwCADIII. 

Никакое расширение имени файла не предполагается. Следует 
использовать ".inc myfile.lib" не ".inc myfile", если файл называют 
"myfile.lib" 

Это возможно, чтобы определить url следующего вида как имя файла: 

.inc http://www.company.com/models/library.lib 

Файл "library.lib" будет перемещен http каталогу схемы и включен. 
Для моделирования подпоследовательности, в интересе ухода от 
загрузки файла каждый раз, когда Вы выполняете моделирование, можно 
редактировать .inc оператора к 

.inc library.lib 

Обратите внимание, что если url Вы определяете, не существует, 
большинство Web-серверов не возвращает ошибку, но возвращает web-
страницу html, которая будет отображена в Вашем web-браузере, 
который объясняет ошибку. LTspice может не всегда читать эти 
страницы как аварийные ситуации, таким образом можно получить 
немного загадочного сообщения об ошибках, когда моделирование 
пытается продолжиться с включенной языковой ошибочной страницей 
html, включенной в моделирование как допустимый синтаксис SPICE. 

Если http - перемещенный url будет .pdf файлом, то моделирование 
прервется после загрузки. Например следующий подзаголовок загрузит 
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этот справочник как .pdf файл: 

* Моделирование макета, чтобы загрузить файл справки. 

* Моделирование прервется с ошибкой, но 

* Вы будете оставлены с файлом scad3.pdf в 

* тот же самый каталог, содержащий список соединений. 

.inc http://ltspice.linear.com/software/scad3.pdf 

.end 

 

.LIB - включает библиотеку 
Синтаксис: .lib <имя файла> 

Эта директива включает модель и определения подсхемы именованного 
файла, как будто тот файл был напечатан в список соединений вместо 
.lib команды. Схемные элементы в глобальной области видимости 
игнорируются. 

Абсолютное имя пути может быть введено для имени файла. Иначе 
LTspice смотрит сначала в каталоге <SwCADIII> \lib\cmp и затем 
<SwCADIII> \lib\sub и затем в каталоге, который содержит вызываемый 
нетлист, где <SwCADIII> - каталог, содержащий scad3.exe выполнимую 
программу, обычно устанавливаемую как C:\Program 
Files\LTC\SwCADIII. 

Никакое расширение имени файла не предполагается. Следует 
использовать ".lib myfile.lib" не ".lib myfile", если файл называют 
"myfile.lib" 

Возможно определить url следующего вида как имя файла: 

.lib http://www.company.com/models/library.mod 

Файл "library.mod" будет перемещен http каталогу схемы и включен 
как библиотека. Для моделирования подпоследовательности, в интересе 
ухода от загрузки файла каждый раз, когда Вы выполняете 
моделирование, можно редактировать .lib оператора к 

.lib library.mod 

Обратите внимание, что если url Вы определяете, не существует, 
большинство Web-серверов не возвращает ошибку, но возвращает web-
страницу html, которая будет отображена в Вашем web-браузере, 
который объясняет ошибку. LTspice может не всегда читать эти 
страницы как аварийные ситуации, таким образом можно получить 
немного загадочного сообщения об ошибках, когда моделирование 
пытается продолжиться с включенной языковой ошибочной страницей 
html, включенной в моделирование как допустимый синтаксис SPICE. 

Если перемещенный http url будет .pdf файлом, то моделирование 
прервется после загрузки. Например следующий подзаголовок загрузит 
этот справочник как .pdf файл: 

* Моделирование макета, чтобы загрузить файл справки. 

* Моделирование прервется с ошибкой, но 

* Вы будете оставлены с файлом scad3.pdf в 

* тот же самый каталог, содержащий список соединений. 

.lib http://ltspice.linear.com/software/scad3.pdf 
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.end 

 

Зашифрованные библиотеки 
LTspice может генерировать и читать специальный вид зашифрованных 

библиотек. Это позволяет одному пользователю готовить библиотеку, 
которую другой пользователь может использовать в моделировании, не 
раскрывая реализацию библиотеки. Разумная попытка сделать 
зашифрованную библиотеку трудной для декодирования без авторизации, 
но это не может рассматриваться совершенно безопасным, если нет 
другой причины чем это реализовано. 

Чтобы подготовить зашифрованную библиотеку, Вы должны вызвать 
LTspice от командной строки с опцией командной строки "-encrypt". 
Вы будете должны сначала резервировать библиотеку, потому что она 
будет заменена зашифрованной версией. НЕ СУЩЕСТВУЕТ НИКАКАЯ 
УТИЛИТА, ЧТОБЫ ПРЕОБРАЗОВАТЬ ЗАШИФРОВАННУЮ БИБЛИОТЕКУ НАЗАД В 
ОТКРЫТЫЙ ТЕКСТ. Ниже суммирует два шага: 

1. Сделать резервную копию библиотеки. 

версия, которую Вы шифруете, удаляется. 

2. От командной строки, напечатать 

scad3.exe -encrypt <имя файла> 

Файл <имя файла> будет заменен зашифрованной версией. Процесс 
шифрования займет некоторое время. 

Если этот процесс завершен, у Вас есть зашифрованный файл ASCII. 
Можно добавить объявление об авторском праве выше строки "*Begin:", 
первые 9 строк файла комментариев останутся неизменными и каждая 
строка объявления об авторском праве, которое Вы добавляете, должен 
начаться с символа '*'. 

Таким образом, здесь зашифрованный файл, написанный LTspice: 

* LTspice Зашифрованный Файл 

*  

* Этот зашифрованный файл был предоставлен 3-ьим 

* поставщик стороны, который не желает предать гласности 

* технология, используемая, чтобы реализовать эту библиотеку. 

*  

* Право доступа предоставляется, чтобы использовать этот файл для 

* моделирование, но не перепроектировать 

* информационные наполнения. 

*  

* Начать: 

50 3E 46 0F FA 6E 67 FF B8 4D D9 62 14 32 60 24 

36 71 35 0B 66 4F AD 52 B8 F5 9E 22 9F C0 18 8B 

FB FE 1D... 

можно изменить это, чтобы быть 

* LTspice Зашифрованный Файл 

*  
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* Этот зашифрованный файл был предоставлен 3-ьим 

* поставщик стороны, который не желает предать гласности 

* технология, используемая, чтобы реализовать эту библиотеку. 

*  

* Право доступа предоставляется, чтобы использовать этот файл для 

* моделирование, но не перепроектировать 

* информационные наполнения. 

*  

* Авторское право © Высшая точка 2005 Моделирование SPICE 

* Для дополнительной информации, см. 

* www.acmespicemodels.com 

* 

* Начать: 

50 3E 46 0F FA 6E 67 FF B8 4D D9 62 14 32 60 24 

36 71 35 0B 66 4F AD 52 B8 F5 9E 22 9F C0 18 8B 

FB FE 1D... 

 

.LOADBIAS - загрузка DC анализа  
Синтаксис: .loadbias <имя файла> 

loadbias команда - комплимент к .savebias команде. Сначала 
выполнить моделирование, которое выполняет .savebias команду. Затем 
изменить .savebias команду на .loadbias команду. 

 

.MEASURE - пользовательские измерения 
Есть два основных различных типа .MEASURE операторов. Те, которые 

ссылаются на точку вдоль абсциссы (независимая переменная вдоль 
горизонтальной оси, то есть, ось времени .tran исследования), и 
.MEASURE операторы, которые ссылаются на диапазон по абсциссе. 
Первый тип, указывающий на одну точку на абсциссе, используются, 
чтобы напечатать значение данных или переменной в специфичной точке 
или когда условие выполняется. Следующий синтаксис используется: 

Синтаксис: .MEAS [SURE] [AC|DC|OP|TRAN|TF|NOISE] <имя> 

+ [<FIND|DERIV|PARAM> <expr>] 

+ [WHEN <expr> | AT = <expr>] 

+ [TD = <val1>] [<RISE|FALL|CROSS> = [<count1> |LAST]] 

Примечание: можно опционально заявить тип исследования, на 
которое применяется .MEAS оператор. Это позволяет Вам использовать 
определенные .MEAS операторы только для определенных типов 
исследования. Имя обязано давать результату имя параметра, которое 
может использоваться в других .MEAS операторах. Ниже пример .MEAS 
операторы, которые ссылаются на отдельную точку вдоль абсциссы: 

.MEAS TRAN res1 FIND V(out) AT=5m 

Распечатать значение V(out) в t=5ms, помеченном как res1. 

.MEAS TRAN res2 FIND V(out)*I(Vout) WHEN V(x) =3*V(y) 
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Напечатать значение переменной V(out)*I(Vout) когда первый раз 
условие V(x)=3*V(y) встречается. Это будет помечено res2. 

.MEAS TRAN res3 FIND V(out) WHEN V(x)=3*V(y) cross=3 

Напечатать значение V(out) когда в третий раз условие V(x)=3*V(y) 
встречается. Это будет помечено res3. 

.MEAS TRAN res4 FIND V(out) WHEN V(x)=3*V(y) rise=last 

Распечатать значение V(out) когда в последний раз встречается 
условие V(x)=3*V(y) при возрастании V(x) в отношении 3*V (y). Это 
будет помечено res4. 

.MEAS TRAN res5 FIND V(out) WHEN V(x) =3*V(y) cross=3 TD=1m 

Напечатать значение V(out) когда в третий раз условие V(x)=3*V(y) 
встречается, но запускать подсчет по истечении времени 1ms. Это 
будет помечено res5. 

.MEAS TRAN res6 PARAM 3*res1/res2 

Напечатать значение 3*res1/res2. Этот вид полезен для печати 
значений над другими результатами .meas операторов. Не 
предназначается для выражений, основанных на прямых данных 
моделирования, например V(3) присутствуют в выражении, которое 
будет оценено, но если данные берутся от последней имитированной 
точки. Результат будет помечен res6. 

Обратите внимание, что вышеупомянутые примеры, при обращении к 
точке абсциссы, выдают в результате данные ординаты (зависящие 
переменные). Если никакую информацию об ординате не запрашивают, то 
.MEAS оператор выдает точку значения на абсциссе, в которой 
происходят измерения: 

.MEAS TRAN res6, WHEN V(x)=3*V(y) 

Напечатать в какой момент времени в первый раз условие 
V(x)=3*V(y), встречается. Это будет помечено res6. 

Другой тип .MEAS оператора ссылается на диапазон по абсциссе. 
Используется следующий синтаксис: 

Синтаксис: .MEAS [AC |DC|OP|TRAN|TF|NOISE] <имя> 

+ [<AVG|MAX|MIN|PP|RMS|INTEG> <expr>] 

+ [TRIG <lhs1> [[VAL] =] <rhs1>] [TD = <val1>] 

+ [<RISE|FALL|CROSS> = <count1>] 

+ [TARG <lhs2> [[VAL] =] <rhs2>] [TD = <val2>] 

+ [<RISE|FALL|CROSS> = <count2>] 

Диапазон по абсциссе указан точками, определенными "TRIG" и 
"TARG". Значение точки "TRIG" по умолчанию начало моделирования, 
если опущено. Так же "TARG" по умолчанию в конце данных 
моделирования. Если не одна из TRIG и TARG точек не указана, то 
.MEAS оператор работает по полному диапазону данных. Типы операций 
измерения, которые могут быть выполнены на интервале: 

Ключевое 
слово Операция по интервалу 

AVG Вычислить усреднение <expr> 
MAX Найти максимальное значение <expr> 

MIN Найти минимальное значение <expr> 
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PP Найти двойную амплитуду <expr> 
RMS Вычислить среднее квадратичное <expr> 

INTEG Интегрировать <expr> 

 

Если никакая операция измерения не указана, результат .MEAS 
оператора - расстояние вдоль абсциссы между точками TARG и TRIG. 
Ниже приведенные в качестве примера операторы .MEAS по интервалу: 

.MEAS TRAN res7 AVG V(NS01) 

+ TRIG V(NS05) VAL=1.5 TD=1.1u FALL=1 

+ TARG V(NS03) VAL=1.5 TD=1.1u FALL=1 

Напечатать среднее значение V (NS01) от 1-ого падения V (NS05) к 
1.5V после 1.1us до 1-ого падения V (NS03) к 1.5V после 1.1us. Это 
будет помечено res7. 

Для .AC исследований условные переменные комплексных данных 
оттранслированы к действительным условиям при преобразовании 
переменной в ее величину. Так в этом примере: 

.MEAS AC res8, WHEN V(out)=1/sqrt (2) 

Результат res8 является частотой, при которой V(out) равно 
0.7071067811865475 (-3дб). 

Кроме того, результат .MEAS оператора может использоваться в 
другом .MEAS операторе. В этом примере вычисляется полоса 
пропускания на 3 децибела: 

.MEAS AC tmp max mag(V(out)); найти максимальную чувствительность 

; и назовите это "tmp" 

.MEAS AC BW trig mag(V(out))=tmp/sqrt(2) rise=1 

+ targ mag(V(out))=tmp/sqrt(2) fall=last 

Напечатать различие в частоте между двумя точками 3 децибела вниз 
от максимальной чувствительности. ОТМЕТИТЬ: данные от .AC 
исследования - комплекс и так являются результатами .measurement 
операторов. Однако равенство ссылается только на вещественную часть 
комплексного числа, то есть, "mag(V(out))=tmp/sqrt(2)" является 
эквивалентным логическим элементом Rе(mag(V(out)))=Re(tmp/sqrt(2)). 

AVG, RMS, и INTEG операции являются отличными видами исследования 
для .NOISE исследования, так как шум более обоснованно 
интегрируется в сдвиге по фазе на 90° по частоте. Следовательно AVG 
и RMS оба дают напряжение шума RMS и INTEG дает интегрированный 
полный шум. Следовательно, если Вы добавляете директивы SPICE 

.MEAS NOISE out_totn INTEG V(onoise) 

.MEAS NOISE in_totn INTEG V(inoise) 

к .noise анализу, полный интегрированный шум ввода и вывода, на 
который ссылаются, будет напечатан в .log файле. 

Операторы .MEAS делают в посте, обрабатывающем после того, как 
моделирование заканчивается. Это позволяет Вам писать скрипт .MEAS 
операторов и выполнять их на наборе данных. Для этого сделайте окно 
формы сигнала активным окном и выполните команду меню File=>Execute 
.MEAS Script. Другое следствие .MEAS операторов, сделанных в посте, 
обрабатываемом после моделирования, это то, что точность выходного 
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устройства .MEAS оператора ограничивается точностью данных формы 
сигнала после сжатия. Вы, возможно, хотите корректировать параметры 
настройки сжатия для более точного выходного устройства .MEAS 
оператора. 

Примечание: при тестировании условие такого вида "when <cond1> = 
<cond2>", условие выраженное равенством, невыполнимо. Это связано с 
фактом, что равенство с плавающей запятой никогда не должно 
требоваться из-за конечной предуступки, используемой в сохранении 
чисел. 

 

.MODEL - определение SPICE модели  
Определение модели для диода, транзистора, переключателя, линии 

электропередачи с потерями или универсальной RC линии. 

У некоторых схемных элементов, например транзисторов, есть много 
параметров. Вместо того чтобы определить каждый транзисторный 
параметр для каждого экземпляра класса транзистора, транзисторы 
группируются модельным именем и имеют общие параметры. У 
транзисторов той же самой модели могут быть различные величины 
параметров, и электрический режим масштабируется к индивидуальному  
параметру экземпляра класса. 

Синтаксис: .model <modname> <тип> [(<список параметра>)] 

Модельное имя должно быть уникальным. Таким образом, у двух 
различных типов схемных элементов, например, диода и транзистора, 
не может быть того же самого модельного имени. Список параметра 
зависит от типа модели. Ниже список модельных типов: 

ТИП МОДЕЛИ     СХЕМНЫЙ ЭЛЕМЕНТ 

SW Переключатель, управляемый напряжением  
CSW Переключатель, управляемый током  
URC Универсальная RC линия 
LTRA Линия электропередачи с потерями 

D Диод  
NPN NPN Биполярный транзистор 
PNP PNP Биполярный транзистор 
NJF N-канал JFET 
PJF P-канал JFET 
NMOS N-канал MOSFET 
PMOS P-канал MOSFET 
NMF N-канал MESFET  

PMF P-канал MESFET  
VDMOS Vertical Double Diffused Power MOSFET 

(Вертикальный Двойной Расплывчатый…) 

См. описание схемного элемента, параметры которого - специфичный 
экземпляр класса, и которые характерны для модели. 

 

.NET - сетевые параметры на .AC исследовании 
Этот оператор используется с исследованием слабого сигнала (.AC), 

чтобы вычислить проводимость входа и выхода, полное сопротивление, 
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Y-параметры, Z-параметры, H-параметры, и S-параметры сети с 2 
портами. Может также использоваться, чтобы вычислить входную 
проводимость и полное сопротивление сети с 1 портом. Должно 
использоваться с .AC оператором, который определяет частотную 
проекцию теории цепей. 

Синтаксис: .net [V(out[,ref])|I(Rout)] <Vin|Iin> 

+ [Rin=<val>] [Rout=<val>] 

Каждый сетевой ввод указан как независимый источник напряжения 
<Vin>, или независимый источник тока <Iin>. Каждый опциональный 
выходной порт указан узлом V (out), или резистор, I (Rout). Порты 
будут выведены на зажимы с сопротивлениями Rin и Rout. Значение по 
умолчанию полного сопротивления оконечной заделки 1 ом, кроме 
случаев источника напряжения с указанным Rser или выходного порта с 
резистором. В этих двух случаях значения по умолчанию сопротивлений 
оконечной заделки к полному сопротивлению прибора. Значения 
оконечной заделки, указанные на операторе .NET, отменят полное 
сопротивление прибора для расчета .NET, но не для обычных .AC 
узловых напряжений и токов. Таким образом, оператор .NET не будет 
налагать полное сопротивление вывода на зажимы на сеть для 
нормальных напряжений и электрических токов, вычисленных как часть 
.AC исследования. 

См. приведенный в качестве примера файл, обычно устанавливаемый 
как C:\Program Files\LTC\SwCADIII\examples\Educational\S-param. 
Рекомендуется, используя источник напряжения V4, с Rser 
устанавливать полное сопротивление источника и резистор Rout, 
устанавливать выходную оконечную заделку с оператором .NET, 
читающим просто ".net I(Rout) V4". Никакие значения Rin или Rout, 
указанные на операторе .net и устройствах ввода-вывода, не 
предоставляют заданные по умолчанию значения оконечной заделки. Это 
расположение делает напряжения узла и электрические токи .AC 
исследование соответствует сети, выводимой на зажимы тем же самым 
способом как в операторе .NET. 

 

.NODESET - хинты для начального решения DC 
.nodeset директива предоставляет хинты для того, чтобы найти 

рабочую точку DC, если у схемы есть множественные возможные 
состояния DC, как например flipflop, итерационный процесс для того, 
чтобы найти DC решение может никогда не сходиться. .nodeset 
директива может использоваться, чтобы вести схему к одному или 
другому состоянию. В основном, после прохода решения сделанного с 
напряжением, указанным на nodeset директиве, ограничение снимается 
для последующих итерационных проходов. 

Синтаксис: .NODESET V(node1)=<voltage> [V(node2)=<voltage [...]] 

 

.NOISE - исследование шума 
Это  исследование частотной области, которое вычисляет шум 

Johnson, шага и фликер-шум. Выходные данные - спектральная 
плотность шума в единицу квадратного корня полосы пропускания. 

Синтаксис: .noise V(<out>[,<ref>]) <src> <oct,dec,lin> 



58 
 

+ <Nsteps> <StartFreq> <EndFreq> 

V(<out>[<ref>]) узел, в котором вычисляется шум полной мощности. 
Это может быть выражено как V (n1,n2), чтобы представить напряжение 
между двумя узлами. <src> - имя независимого истока, к которому 
отнесен входной шум. <src> - бесшумный входной сигнал. Параметры 
<oct,dec,lin>, <Nsteps>, <StartFreq>, и <EndFreq> определяют 
частотный диапазон, представляющий интерес и разрешающую 
способность, таким образом используемую в .ac директиве. 

Графиком выходных данных V(onoise) является шумовая спектральная 
плотность напряжения, отнесенная к узлу указанному как выходное 
устройство в вышеупомянутом синтаксисе. Если входной сигнал дается 
как источник напряжения, то трассировка данных V(inoise) является 
отнесенной к входу плотностью напряжения шума. Если вход указан как 
источник тока, то график данных входного шума - шум отнесенный к 
входному сигналу источника тока. Может чертиться вклад шума каждого 
компонента. Эти вклады относятся к выходному устройству. Можно 
отнести их ко входу при делении на усиление "gain". 

Средство просмотра формы сигнала может интегрировать шум по 
полосе пропускания клавишей <CTRL> + левая кнопка мыши, нажимающая 
на соответствующую метку трассировки данных. 

 

.OP - рабочая точка DC 
Выполнить решение DC с открытыми емкостями и коротким замыканием 

катушек индуктивности. Обычно решение DC выполняется как часть 
другого исследования, чтобы найти рабочую точку схемы. Использовать 
.op, если требуется, чтобы была найдена только эта рабочая точка. 
Результаты появятся в диалоговом окне. После .OP моделирования, 
когда Вы указываете на узел или электрический ток .OP решение 
появится на строке состояния. 

 

.OPTIONS - установка опций  
Ключевое 
слово 

Тип 
данных 

Значение 
по 
умолчанию 

Описание 

Abstol Числ. 1pA Абсолютная погрешность тока  

Baudrate  Числ. (нет)  Для графиков. Устанавливает 
развертку абсциссы на совмещение 
времени разрядных переключений. 

chgtol Числ. 10fC Абсолютная погрешность заряда 

cshunt Числ. 0. Опционально добавлена емкость от 
каждого узла на землю 

cshuntintern Числ. cshunt Опционально добавлена емкость от 
каждого прибора внутреннего узла на 
землю 

defad Числ. 0. Заданный по умолчанию участок 
диффузии стока МОП 

defas Числ. 0. Заданный по умолчанию участок 
диффузии истока МОП 
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defl Числ. 100µm По умолчанию длина канала МОП 

defw Числ. 100µm По умолчанию ширина канала МОП 

delay Числ. 0. Для графиков. Сдвиги разрядных 
переключений. 

fastaccess Метка ложь 
(false) 

Преобразовать файл в fastaccess 
формат в конце моделирования 

flagloads Метка ложь Помечает внешние источники тока как 
загрузки. 

Gmin Числ. 1e-12 Проводимость, добавленная на спай 
каждой детали, чтобы помочь 
сходимости. 

gminsteps Числ. 25 Обнулить gminstepping для 
начального DC решения. 

gshunt Числ. 0. Опционально добавлена проводимость 
от каждого узла на землю. 

itl1 Числ. 100 Предел счетчика итерации DC. 

itl2 Числ. 50 Предел счетчика итерации переноса 
DC характеристики. 

itl4 Числ. 10 Предел счетчика времени точки 
итерации Transient анализа. 

itl6 Числ. 25 Установить на нуль, чтобы 
предотвратить источник продвижения 
для начального DC решения. 

srcsteps Числ. 25 Альтернативное имя для itl6. 

maxclocks Числ. неопред. Максимальное число тактовых циклов, 
сохранения. 

maxstep Числ. неопред. Максимальный размер шага для 
Transient анализа.  

meascplxfmt Строка bode Формат комплексного числа 
результатов .meas оператора. Один 
из "polar", "cartesian", "bode". 

measdgt Числ. 6 Число значащих цифр используемых в 
выходных данных .measure оператора. 

method Строка trap Числовой метод интеграции, 
trapezoidal или Gear. 

minclocks Числ. 10 Минимальное число тактовых циклов 
сохранения. 

MinDeltaGmin Числ. 1e-4 Устанавливает предел для оконечной 
заделки адаптивного gmin 
продвижения. 

nomarch Метка ложь Не чертить идущих форм сигнала. 

noopiter Метка ложь Пойти непосредственно в gmin 
продвижение. 

numdgt Числ. 6 Исторически "numdgt" обозначал 
количество значащих цифр в выходных 
данных. В LTspice, если "numdgt">6, 
используется двойная точность 
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зависящих переменных данных. 

pivrel Числ. 1e-3 Относительное отношение между 
наибольшим элементом столбца и 
приемлемым центром значения. 

pivtol Числ. 1e-13 Абсолютное минимальное значение для 
матричного элемента, который будет 
принят как центр. 

reltol Числ. .001 Допуск относительной погрешности. 

srcstepmethod Числ. 0 С какого шага стартовать алгоритму. 

sstol Числ. .001 Относительная погрешность для 
обнаружения устойчивого состояния. 

startclocks Числ. 5 Число тактовых циклов ожидания 
перед просмотром установившегося 
состояния. 

temp Числ. 27°C Температура по умолчанию для 
схемного элемента, температура 
которого не установлена. 

tnom Числ. 27°C Температура по умолчанию, при 
которой были измерены параметры 
прибора для моделей, температура 
которых не установлена. 

topologycheck Числ. 1 Установить на нуль, чтобы 
пропустить проверку плавающих 
узлов, циклов источников 
напряжения, и нефизической 
transformerwinding топологии. 

trtol Числ. 1.0 Установить переходную погрешность. 
Этот параметр - оценка 
коэффициента, которым завышается 
фактическая ошибка отбрасывания. 

trytocompact Числ. 1 Когда значение ненулевое, симулятор 
пытается уплотнить LTRA хронологию 
линий электропередачи входных 
напряжений и электрических токов. 

vntol Числ. 1µV Устанавливает абсолютную 
погрешность напряжения. 

plotreltol Числ. .0025 Устанавливает относительную 
погрешность сжатия формы сигнала. 

plotvntol Числ. 10µV Устанавливает абсолютную 
погрешность напряжения для сжатия 
формы сигнала. 

plotabstol Числ. 1nA Устанавливает абсолютную 
погрешность тока для сжатия формы 
сигнала. 

plotwinsize Числ. 300 Число точек данных для сжатия в 
одном окне. Установить на нуль, 
чтобы отключить сжатие. 
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.PARAM - определяемые пользователем параметры 

Директива .param позволяет создание определяемых пользователем 
переменных. Это полезно для ассоциации имени со значением ради 
ясности, и параметризации подсхемы таким образом, чтобы абстрактные 
схемы могли быть сохранены в библиотеках. 

Оператор .param может быть включен в определении подсхемы, чтобы 
ограничить область видимости значения параметра той подсхемой и 
подсхемами, вызванными той подсхемой. 

Чтобы вызвать подстановку параметра и определение переменной, 
заключите переменную в фигурные скобки. Переменная будет заменена 
значением с плавающей точкой. 

Ниже пример использования .param оператора, и использования 
параметров, принятых непосредственно на строке вызова подсхемы. 

* 

* Это - определение схемы 

.params x=y y=z z=1k*tan(pi/4+.1) 

X1 a b 0 divider top=x bot=z 

V1 a 0 pulse(0 1 0 .5µ .5µ 0 1µ) 

* это - определение подсхемы 

.subckt divider n1 n2 n3 

r1 n1 n2 {top} 

r2 n2 n3 {bot} 

.ends 

* 

.tran 3µ 

.end 

Схема подстановки параметра - символьный декларативный язык. 
Параметры не передаются на подсхему как оцененные значения, но 
переменными и отношениями непосредственно. Когда встречаются 
фигурные скобки, включенная в них переменная оценивается на основе 
всех отношений, доступных в области видимости, и уменьшена до 
значения с плавающей точкой. 

Следующие функции и операции доступны: 

ИМЯ ФУНКЦИИ ОПИСАНИЕ 

abs(x) Абсолютное значение x 

acos(x) Вещественная часть арккосинуса x, например, acos(5) 
возвращает 3.14159, а не 3.14159+2.29243i 

arccos(x) Синоним для acos(x) 

acosh(x) Вещественная часть арккосинуса гиперболического x, 
например, acosh(.5) возвращает 0, а не 1.0472i 

asin(x) Вещественная часть арксинуса x, например, asin(-5) 
возвращает -1.57080, а не -1.57080+2.29243i 

arcsin(x) Синоним для asin(x) 

asinh(x) Арксинус гиперболический x 

atan(x) Арктангенс x 
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arctan(x) Синоним для atan(x) 

atan2(y,x) Четырехквадрантный (круговой) арктангенс y/x 

atanh(x) Арктангенс гиперболический x 

buf(x) 1 если x>.5, иначе 0 

cbrt(x) Кубический корень x 

ceil(x) Целое число, равное или больше чем x 

cos(x) Косинус x 

cosh(x) Гиперболический косинус x 

exp(x) e в степени x 

fabs(x) Синоним для abs(x) 

flat(x) Случайное число между -x и x с равномерным 
распределением 

floor(x) Целое число, равное или меньше чем x 

gauss(x) Случайное число с распределением Гаусса с сигмой x 

hypot(x,y) sqrt(x**2+y**2) 

if(x,y,z) Если x>.5, то y иначе z 

int (x) Преобразовать x в целое число 

inv(x) 0. если x>.5, иначе 1 (инверсия) 

limit(x,y,z) Промежуточное значение x, y, и z 

ln(x) Натуральный логарифм x 

log(x) Дополнительный синтаксис для ln(x) 

log10(x) Логарифм x по основанию 10 

max(x,y) Большее из x или y 

mc(x,y) Случайное число между x*(1+y) и x*(1-y) с равномерным 
распределением 

min(x,y) Меньшее из x или y 

pow(x,y) Вещественная часть x**y, например, pow(-.5,1.5) 
возвращает 0., а не 0.353553i 

pwr(x,y) abs(x)**y 

pwrs(x,y) sgn(x)*abs(x)**y 

rand(x) Случайное число между 0 и 1 в зависимости от 
целочисленного значения x 

random(x) Подобный rand(x), но гладко переключающийся между 
значениями 

round(x) Самое близкое целое число к x 

sgn(x) Знак x 

sin(x) Синус x 

sinh(x) Гиперболический синус x 

sqrt(x) Вещественная часть квадратного корня x, например, 
sqrt(-1) возвращает 0, а не 0.707107i 

table(x,a,b,
c,d,...) 

Интерполировать значение для x основанное на таблице 
просмотра, данной как ряд пар точек 

tan(x) Тангенс x 
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tanh(x) Гиперболический тангенс x 

u(x) Шаг единицы, то есть 1, если x>0., иначе 0. 

uramp(x) x, если x>0., иначе 0. 

 

Операции сгруппированы в порядке, обратном предшествованию 
определения: 

Операнд Описание 

& Преобразовать переменные в каждой части в Булевские 
переменные, затем И 

| Преобразовать переменные в каждой части в Булевские 
переменные, затем ИЛИ 

^ Преобразовать переменные в каждой части в Булевские 
переменные, затем неэквивалентность 

  

> Истина, если переменная слева больше чем переменная 
справа, иначе ложь 

< Истина, если переменная слева меньше чем переменная 
справа, иначе ложь 

>= Истина, если переменная слева больше или равна переменной 
справа, иначе ложь 

<= Истина, если переменная слева меньше или равна переменной 
справа, иначе ложь 

  

+ Суммирование с плавающей запятой 

- Вычитание с плавающей запятой 

* Умножение с плавающей запятой 

/ Деление с плавающей запятой 

** Вещественная часть возведения левой части в степень 
правой, например -2**1.5 возвращает 0., а не 2.82843i 

 

 

.SAVE - предел количества сохраненных данных. 
Некоторое моделирование, особенно моделирование временной 

области, может генерировать большой объем данных. Количество 
информации выходного устройства может быть ограничено, используя 
.save директиву, чтобы сохранить только специфичные напряжения узла 
и электрический ток прибора, представляющий интерес. 

Синтаксис: .save V(out) [V(in) [I(L1) [I(S2)]]] [dialogbox] 

Директива .save I(Q2) сохранит токи базы коллектора и эмиттера 
биполярного транзистора Q2. Чтобы сохранить отдельный ток в 
нагрузке, установите Ic(Q2). 

Подстановочные знаки '*' и '?' могут использоваться, чтобы 
определить трассировки данных, соответствующие шаблону. Например, 
".save V(*) Id(*)" сохранит каждое напряжение и каждый ток стока. 

Если ключевое слово "dialogbox" указано, то диалоговое окно со 
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списком всех доступных заданных по умолчанию узлов и электрических 
токов отображается, разрешая пользователю выбрать из списка, 
который должен быть сохранен. Если список соединений был 
сгенерирован от описания схемы, то на узлы и приборы можно указать 
и нажать в описании схемы, чтобы подсветить их, как выбрано в 
диалоговом окне. 

 

.SAVEBIAS - Сохраняют Рабочую точку на диск 
Синтаксис: .savebias <filename> [internal] 

+ [temp=<value>] [time=<value> [repeat]] [step=<value>] 

+ [DC1=<value>] [DC2=<value>] [DC3=<value>] 

  

Эта команда пишет текстовый файл диску, который перезагружается 
.loadbias командой в последующем моделировании. Если у Вас есть 
схема, у которой есть "труднорешаемая" рабочая точка DC, можно 
сохранить то решение на диск так, чтобы следующее исследование 
могло экономить время, находя решение DC прежде, чем перейти к 
остальной части моделирования. 

"Внутреннее" ключевое слово может быть добавлено, чтобы указать, 
что внутренние узлы некоторых приборов должны также быть сохранены 
так, чтобы более законченная версия решения DC была сохранена.  

Если Вы хотите сохранить специфическую рабочую точку DC от .tran 
исследования, можно дать установленное время. Первая решенная точка 
времени после предустановленного времени будет записана. 
Модификатор "repeat" заставит решение DC быть записанным после 
каждой точки, указанной к этому времени. Файл будет содержать 
только последнюю решенную DC точку. DC1, DC2, и DC3 могут быть 
даны, чтобы извлечь отдельную рабочую точку из .dc sweep 
исследования. 

Команда savebias пишет текстовый файл в виде .nodeset команды. 
Обратите внимание, что операторы nodeset только рекомендации 
решения. Таким образом, решающее устройство запустит выполнять 
итерации решения с напряжениями узла, данными в nodeset операторах, 
но будет продолжать выполнять итерации, пока не удостоверится, что 
решение допустимо. Если Вы хотите перезапустить .tran решение от 
рабочей точки DC, можно редактировать файл от .nodeset до .ic, 
чтобы попробовать принудить запустить решающее устройство с этого 
состояния DC. 

Пока состояние интеграции всех реактансов схемы не сохранено в 
.savebias файле, успех с этой методикой изменчив. 

 

.STEP – шаговое изменение параметра 
Эта команда заставляет исследование неоднократно выполняться при 

изменении температуры, модельного параметра, глобального параметра, 
или независимого источника. Шаги могут быть линейными, 
логарифмическими, или указанными как список значений.  

Пример: .step oct v1 1 20 5  

Шаг независимого источника напряжения V1 от 1 до 20 
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логарифмический с 5 точками на октаву. 

Пример: .step I1 10u 100u 10u  

Независимый источник тока I1 от 10u до 100u с шагом приращения 
10u. 

Пример: .step param RLOAD LIST 5 10 15  

Выполнить моделирование три раза с глобальным параметром Rload 
принимающим значения 5, 10 и 15.  

Пример: .step NPN 2N2222(VAF) 50 100 25  

Параметр NPN модели VAF от 50 до 100 с шагом 25.  

Пример: .step temp -55 125 10  

Температура от -55°C до 125°C с шагом 10 градусов. 

 Проекции шага могут быть вложены глубиной до трех уровней. 

 

.SUBCKT - определяет подсхему 
Как помощь определению схемы, повторная схема может быть включена 

в определение подсхемы и использоваться как множественные 
экземпляры класса в той же самой схеме. Прежде, чем моделирование 
выполняется, схема расширяется к плоскому списку соединений при 
замене каждого вызова подсхемы со схемными элементами в определении 
подсхемы. Нет никакого предела на размере или степени интеграции 
подсхем. 

Конец определения подсхемы должен быть .ends директивой. 

Вот пример использующий подсхему: 

* 

* Это - определение схемы 

X1 a b 0 divider 

V1 a 0 pulse(0 1 0 .5µ .5µ 0 1µ) 

* это - определение подсхемы 

.subckt divider n1 n2 n3 

r1 n1 n2 1k 

r2 n2 n3 1k 

.ends 

.tran 3µ  

.end 

Который выполняется после расширения до 

* Развернуть X1 в две резисторных схемы 

r:1:1 a b 1k 

r:1:2 b 0 1k 

* 

v1 a 0 pulse(0 1 0 .5µ .5µ 0 1µ) 

.tran 3µ 

.end 

Обратите внимание, что уникальные имена, основанные на имени 
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подсхемы и именах элемента определения подсхемы, делаются для 
схемных элементов, вставленных расширением подсхемы. 

 

.TEMP - температурные проекции 
Архаичный вид для команды шага для температуры. Это выполняет 

моделирование для каждой перечисленной температуре. 

Синтаксис 

.TEMP <T1> <T2>...  

Эквивалентно команде  

.STEP TEMP LIST <T1> <T2> ... 

 

.TF - переходная функция малого сигнала по DC 
Это - режим исследования, который находит переходную функцию по 

постоянному току напряжения узла или тока в ветви как функцию 
малого сигнала от малых изменений независимого источника. 

Синтаксис: .TF V(<node>[, <ref>]) <source> 

.TF I(<voltage source>) <source> 

Примеры: 

 .TF V(out) Vin 

 .TF V(5,3) Vin 

 .TF I(Vload) Vin 

 

.TRAN - выполняют нелинейный анализ переходных 
процессов 

Выполняет анализ переходных процессов. Это - самое прямое 
моделирование схемы. Это в основном вычисляет что произойдет, когда 
на схему подается питание. В качестве тестовых сигналов часто 
применяются независимые источники. 

Синтаксис: .TRAN <Tstep> <Tstop> [Tstart [dTmax]] [modifiers] 

           .TRAN <Tstop> [modifiers] 

Первый вид – традиционная .tran команда SPICE. Tstep - приращение 
составления графика для форм сигнала, но также используется как 
начальное предположение неродного размера. LTspice использует 
сжатие формы сигнала, таким образом этот параметр имеет немного 
значения и может быть опущен или установлен на нуль. Tstop - время 
действия моделирования. Анализы переходных процессов всегда 
начинаются во время, равное нулю. Однако если Tstart указан, данные 
формы сигнала между нулем и Tstart не сохраняются. Это - средство 
управления размером файлов формы сигнала при разрешении 
нестационарных процессов, при вводе может быть проигнорировано. 
Конечный параметр dTmax, максимальный временной шаг при 
интегрировании уравнений схемы. Если Tstart или dTmax указаны, 
Tstep должен быть указан. 

Несколько модификаторов modifiers  могут быть помещены в строку 
.tran. 
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.WAVE - запись .Wav файлов. 
LTspice может написать .wav звуковые файлы. Эти файлы можно затем 

слушать или использоваться как ввод другого моделирования. 

Синтаксис: .wave <filename.wav> <Nbits> <SampleRate> V(out) 
[V(out2)...] 

пример: .wave C:\output.wav 16 44.1K V(left) V(right) 

<filename.wav> это законченный абсолютный путь для .wav файла, 
который требуется создать или относительный путь, вычисленный от 
каталога, содержащего описание схемы моделирования или список 
соединений. Двойные кавычки могут использоваться, чтобы определить 
путь, содержащий пространства. <Nbits> - число битов выборки. 
Допустимый диапазон от 1 до 32 битов. 

<SampleRate> - число выборок для записи в имитированную секунду. 
Допустимый диапазон от 1 до 4294967295 выборок в секунду. Остаток 
синтаксиса перечисляет узлы, для которых требуется сохранить 
данные. Каждый узел будет независимым каналом в .wav файле. Число 
каналов может быть от одного до 65535. Можно записать электрический 
ток прибора, например, Ib(Q1), а также напряжение узла. У .wav 
аналога цифрового преобразователя полный диапазон шкалы от -1 до +1 
вольт или ампер. 

Обратите внимание, что возможно написать .wav файлы, которые 
нельзя запустить на звуковой системе Вашего PC из-за числа каналов, 
нормы выборок или числа битов, неподдерживаемых кодер-декодером 
Вашего PC. Но эти .wav файлы могут использоваться в LTspice как 
ввод для другого моделирования. См. разделы LTspice=>Схемные 
элементы=>источник напряжения и источник тока, для информации об 
воспроизведении .wav файла в моделирование LTspice. Если Вы хотите 
запустить .wav файл на Вашей звуковой плате PC, имейте в виду, что 
у обычно поддерживаемых .wav форматов файла есть 1 или 2 канала; 8 
или 16 битов/каналы; и типовая норма 11025, 22050, или 44100 Гц. 

 

Опции Transient анализа 
.TRAN модификаторы  

UIC: Пропустить D.C. работающее решение и использовать указанные 
пользователем начальные условия. 

steady: Остановить моделирование, когда состояние steady будет 
достигнуто. 

nodiscard: не удалять часть переходного моделирования прежде, чем 
состояние steady будет достигнуто. 

startup: Решить начальную рабочую точку с независимым напряжением 
и выключенными источниками тока. Затем запустить анализ переходных 
процессов и включить эти источники в первые 20 µs моделирования. 

step: Вычислить реакцию схемы на скачок. 

UIC 
Использовать Начальные Условия. Обычно исследование рабочей точки 

DC выполняется прежде запуска анализа переходных процессов. Эта 
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директива гасит эту инициализацию. Начальные условия некоторых 
схемных элементов могут быть указаны на основе экземпляра класса в 
экземпляре класса. Uic не особенно рекомендуемая возможность SPICE. 
Пропуск исследования рабочей точки DC приводит к нефизическому 
начальному условию. Например, подключите источник напряжения 
параллельно с емкостью. Напряжение узла берется как нуль, если не 
указанно. Затем, в первом временном шаге, бесконечный электрический 
ток обязан заряжать конденсатор. Симулятор не может определить, что 
достаточно короткий временной шаг делает текущий ток несингулярным, 
и выпускается сообщение сбоя "временной шаг слишком мал для 
конвергенции файла". 

Steady 
Останавливает моделирование, когда состояние steady будет 

достигнуто. Это требуется для отчета о расчете КПД. Обнаружение 
установившегося режима пишется в макромодели SMPS. Обычно они 
пишутся, чтобы искать нулевую ошибку amp выходного электрического 
тока, усредненного по тактовому циклу. Алгоритм берет ошибку выхода 
amp согласно диапазону рассмотрения. Величина максимального тока, 
который считается нулевым электрическим током, указана с опцией 
sstol. 

Автоматическое обнаружение состояния steady может терпеть 
неудачу, будучи слишком критическим или не достаточно критическим. 
Можно в интерактивном режиме определить состояние steady следующим 
способом: Как только моделирование начинается, выполните команду 
меню Simulate=>Efficiency Calculation=>Mark Start. В первый раз, 
когда Вы выполняете эту команду, Вы говорите LTspice, что Вы 
собираетесь вручную определить пределы интеграции. После того, как 
схема достигла steady - состояние, выполните эту команду снова. Это 
очистит хронологию и перезапустит Расчет КПД. Затем, через 
некоторое время, как видят проход больше чем 10 тактовых циклов, 
выполняют Simulate=>Efficiency Calculation=>Mark End. Каждый раз, 
когда Вы выполняете Simulate=>Efficiency Calculation=>Mark Start, 
Вы перезапускаете расчет КПД и очищаете хронологию формы сигнала. 
Это - хороший метод препятствования файлу данных стать слишком 
большим и замедлить составление графика, таким образом 
рекомендуется, чтобы Вы периодически выполнили Simulate=>Efficiency 
Calculation=>Mark Start всякий раз, когда ясно, что Вы суммировали 
существенные данные, которые Вы не хотите включать в отчет КПД. 

Использовать .ic директиву, чтобы определить напряжения узла и 
электрические токи катушки индуктивности, чтобы уменьшить 
продолжительность анализа переходных процессов для нахождения 
состояние steady. 

nodiscard 
Не удалять часть переходного моделирования прежде, чем состояние 

steady будет достигнуто. 

startup 
Это похоже на оригинал SPICE "uic". Это означает, что независимые 

источники должны сползаться (ramped) во время первых 20µs 
моделирования. Однако исследование рабочей точки DC выполняется, 
используя ограничения, указанные в .ic  директиве. 
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step 
Вычислить реакцию схемы на скачок тока. Эта функция работает с 

источником тока, заданным списком значений электрического тока. 
Процедура: 

1.вычислить steady состояние и сбросить хронологию, если 
nodiscard установлено. 

2.изменяющийся сигнал тока к следующему значению в списке 
электрических токов со скоростью 20A/µs. 

3.вычислить состояние steady 

4.изменить заданное значение на следующее значение в списке или 
выход, если больше нет. 

Из-за степени интеграции схемы автоматическое переключение ШАГА 
может быть не обнаруживаемым. При этом обстоятельстве, лучше 
использовать .TRAN команду, чтобы выполнить переходное 
моделирование и наблюдать начальные и конечные точки решения 
заданной загрузки значений. Использовать команду PWL, чтобы 
программировать выходной ток нагрузки, и переключается на разные 
уровни в заданных периодах времени. Например: 

PWL (0 0.5 1 м. 0.5 1.01 м. 0.1 3 м. 0.1 3.01 м. 0.5) 

Ток нагрузки начинается с 0.5A во время 0,  

остается в 0.5A в 1ms, 

переключения к 0.1A во время 1.01ms,  

остается в 0.1A до 3ms,  

и переключения к 0.5A в 3.01ms и остаются в 0.5A.  

У PWL могут быть почти неограниченная последовательность пар 
(время, величина). 

 

Элементы схемы 
A. Специальные Функции. 

Имена обозначения: INV, BUF, AND, OR, XOR, SCHMITT, SCHMTBUF, 
SCHMTINV, DFLOP, VARISTOR, и MODULATE 

Синтаксис: Annn n001 n002 n003 n004 n005 n006 n007 n008 <model> 
[instance parameters] 

Это частные специальные приборы моделирования режима 
function/mixed Корпорации Linear Technology. Большинство из них и 
их режима неописано, поскольку они часто изменяются с каждым новым 
набором моделей, доступных для LTspice. Однако здесь мы 
документируем некоторых из них из-за их общего интереса. 

INV, BUF, AND, OR, и XOR - универсальные идеализированные 
поведенческие логические элементы. Все логические элементы - 
netlisted с восьмью выводами. Эти логические элементы не требуют 
никакого внешнего электропитания. Электрический ток - входящий или 
выходящий от комплиментарных выходов, выводы 6 и 7, возвращается 
через общий вывод прибора 8. Выводы 1 - 5 являются входами. 
Неиспользованные входы и выходы должны быть подключены на землю 8. 
Компилятор цифрового устройства распознает, если вывод не 
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используется и удаляет его из моделирования. Это приводит к 
потенциально запутывающей ситуации, когда логические элементы AND 
действуют по-разному при заземлении входа или при нуле вольтов. 
Если земля - общий для ключей, то заземленный вход не состояние 
логического нуля схемы, а просто исключение из моделирования. 
Логические элементы реализуются таким образом по той причине, что 
это позволяет одному прибору действовать как 2-, 3-, 4-или 5-
входовый логический элемент с прямым, инверсным, или 
комплиментарным выходом без потери быстродействия моделирования из-
за неиспользуемых выводов. Таким образом, прибор AND действует как 
12 различных типов логических элементов AND. Значение логических 
уровней элементов по умолчанию 0V/1V с логическим порогом .5V, 
никакого времени задержки распространения, выходное сопротивление 
1ом. Выходные характеристики устанавливаются этими параметрами 
экземпляра класса: 

ИМЯ  ЗНАЧЕНИЕ ПО УМОЛЧАНИЮ ОПИСАНИЕ 

Vhigh 1. высокий уровень логической схемы 

Vlow 0. низкий уровень логической схемы 

Ref 0,5 Порог переключения 

Trise 0. Время нарастания выходного импульса 

Tfall Trise Время спада выходного импульса 

Tau 0. Выходная постоянная времени RC 

Td 0. Время распространения сигнала 

Cout 0. Выходная емкость 

Rout 1. Полное выходное сопротивление 

Rhigh Rout Полное выходное сопротивление высокого 
логического уровня 

Rlow Rout Полное выходное сопротивление низкого 
логического уровня 

Обратите внимание, что не все параметры могут быть указаны на том 
же самом экземпляре класса одновременно, например, выходные 
характеристики: или время повышения и затухания, или постоянная 
времени, не обе. 

Значения времени задержки распространения по умолчанию нуль и 
устанавливаются с параметром Td. экземпляра класса. Входное время 
задержки равно времени задержки распространения. 

Входные пороговые значения логической схемы по умолчанию 
.5*(Vhigh+Vlow), но могут быть установлены параметром экземпляра 
класса Ref. Время задержки равно времени задержки распространения. 

У оригинального прибора неэквивалентности есть нестандартный 
режим, когда используются больше чем два входа: выход - истина 
только тогда, когда точно один из всех входов - истина. 
Использовать ассоциативное свойство неэквивалентности с 
множественными приборами неэквивалентности, чтобы реализовать блок 
неэквивалентности с больше чем двумя вводами. 

У приборов Триггера Шмитта выходные характеристики подобные как у 
логических элементов. Их пороги переключения указаны параметрами Vt 
и Vh экземпляра класса. Низкий порог переключения Vt-Vh, и высокий 
Vt+Vh. 
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Логические элементы и триггеры Шмитта по умолчанию не 
предоставляют информации на механизм моделирования. Таким образом, 
они не смотрят, когда они собираются изменить состояние и 
удостовериться, что есть шаг времени близко к каждому изменению 
состояния. Параметр экземпляра класса tripdt может быть установлен, 
чтобы предусмотреть, что максимальные размеры шага симулятор берет 
через время изменения состояния. 

ВАРИСТОР - управляемый напряжением варистор. Его напряжение 
пробоя устанавливается напряжением между выводами 1 и 2. Его полное 
сопротивление в области пробоя указано с параметром экземпляра 
класса rclamp. См. приведенное в качестве примера описание схемы 
\examples\Educational\varistor.asc 

Прибор MODULATE - управляемый напряжением осциллятор. См. 
приведенное в качестве примера описание схемы 
\examples\Educational\PLL.asc. Мгновенная частота колебаний 
устанавливается напряжением на FM входе. Преобразование напряжения 
в частоту  линейное, устанавливается двумя параметрами экземпляра 
класса, mark и space. Mark - частота, когда FM вход 1V, и - space 
частота, когда вход 0V. Амплитуда устанавливается напряжением на 
входе AM и по умолчанию 1V, если вход AM неиспользован (подключен к 
MODULATE общий). 

Особенность описания схемы LTspice списков соединений для этих 
приборов. Все несвязанные выводы автоматически подключаются на 
вывод 8. Кроме того, если вывод 8 несвязан, то он подключается к 
узлу 0 (общий). 

 

B. произвольные поведенческие источники напряжения 
или тока. 

Имена обозначения: BV, BI 

Синтаксис: Bnnn n001 n002 V=<expression> [ic=<value>] 

+ [tripdv=<value>] [tripdt=<value>] 

+ [laplace=<expression> [window=<time>] 

+ [nfft=<number>] [mtol=<number>]] 

  

Bnnn n001 n002 I=<expression> [ic=<value>] 

+ [tripdv=<value>] [tripdt=<value>] [Rpar=<value>] 

+ [laplace=<expression> [window=<time>] 

+ [nfft=<number>] [mtol=<number>]] 

  

Первый синтаксис определяет поведенческий источник напряжения, 
второй - поведенческий источник тока. Для источника тока 
параллельное сопротивление может быть указано с параметром 
экземпляра класса Rpar. 

Tripdv и tripdt управляют отбраковкой шага. Если напряжение 
источника изменяется больше чем tripdv вольтами в tripdt секунды, 
тот временной шаг моделирования бракуется. 

Переменные могут содержать следующее: 
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o напряжения Узла, например, V(n001) 

o разность напряжений Узлов, например, V(n001,n002) 

o электрические токи схемного элемента; например I(S1) 
электрический ток через ключ S1, или Ib(Q1) ток базы Q1. Однако 
предполагается, что электрический ток схемного элемента изменяется 
квазистатически, то есть, нет никакой мгновенной обратной связи 
между электрическим током через прибор, на который ссылаются, и 
поведенческим выходным устройством источника. Точно так же любая 
переменная составляющая такого тока прибора предполагается нулевой 
в линейном .AC исследование малого сигнала. 

o ключевое слово, "time", означающее текущее время в 
моделировании. 

o ключевое слово, "pi", означающее 3.14159265358979323846. 

o следующие функции: 

Имя функции ОПИСАНИЕ 

abs(x) Абсолютное значение x 

absdelay(x,t[,tmax
]) 

x задержан на t. Опция установки максимального 
времени задержки tmax 

acos(x) Вещественная часть арккосинуса x, например, 
acos(5) возвращает 3.14159, а не 3.14159+2.29243i 

arccos(x) Синоним для acos(x) 

acosh(x) Вещественная часть арккосинуса гиперболического 
x, например, acosh(.5) возвращает 0, а не 1.0472i 

asin(x) Вещественная часть арксинуса x, например, asin(-
5) возвращает -1.57080, а не -1.57080+2.29243i 

arcsin(x) Синоним для asin(x) 

asinh(x) Арксинус гиперболический x 

atan(x) Арктангенс x 

arctan(x) Синоним для atan(x) 

atan2(y,x) Четырехквадрантный (круговой) арктангенс y/x 

atanh(x) Арктангенс гиперболический x 

buf(x) 1 если x>.5, иначе 0 

ceil(x) Целое число, равное или больше чем x 

cos(x) Косинус x 

cosh(x) Гиперболический косинус x 

ddt(x) Производная x по времени  

delay(x,t[,tmax]) Синоним для absdelay(x,t[,tmax]) 

exp(x) e в степени x 

floor(x) Целое число, равное или меньше чем x 

hypot(x,y) sqrt(x**2+y**2) 

idt(x[,ic[,a]]) Интегрировать x, опциональное начальное условие 
ic, сбросить, если истина 

idtmod(x[,ic[,m[,o
]]])  

Интегрировать x, опциональное начальное условие 
ic, сброс по достижению модуля m., сместить выход 
на o. 
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if(x,y,z) Если x>.5, то y иначе z 

int(x) Преобразовать x в целое число 

inv(x) 0. если x>.5, иначе 1 (инверсия) 

limit(x,y,z) Промежуточное значение x, y, и z 

ln(x) Натуральный логарифм x 

log(x) Дополнительный синтаксис для ln(x) 

log10(x) Логарифм x по основанию 10 

max(x,y) Большее из x или y 

min(x,y) Меньшее из x или y 

pow(x,y) Вещественная часть x**y, например, pow(-.5,1.5) 
возвращает 0., а не 0.353553i 

pwr(x,y) abs(x)**y 

pwrs(x,y) sgn(x)*abs(x)**y 

rand(x) Случайное число между 0. и 1. в зависимости от 
целочисленного значения x 

random(x) Подобно rand(x), но гладко переключается между 
значениями 

round(x) Самое близкое целое число к x 

sdt(x[,ic[,assert]
]) 

Дополнительный синтаксис для idt(x[,ic[,a]]) 

sgn(x) Знак x 

sin(x) Синус x 

sinh(x) Гиперболический синус x 

sqrt(x) Вещественная часть квадратного корня x, например, 
sqrt(-1) возвращает 0, а не 0.707107i 

table(x,a,b,c,d,..
.) 

Интерполировать значение для x основанное на 
таблице просмотра, данной как ряд пар точек 

tan(x) Тангенс x 

tanh(x) Гиперболический тангенс x 

u(x) Шаг единицы, то есть 1, если x>0., иначе 0. 

uramp(x) x, если x>0., иначе 0. 

white(x) Случайное число между -.5 и .5 гладко 
переключающееся между значениями даже более 
гладко, чем random() 

!(x) Альтернативный синтаксис для inv (x) 

~(x) Альтернативный синтаксис для inv (x) 

 

o следующие операции, группированные в порядке увеличения 
приоритета: 

Операнд Описание 

& Преобразовать переменные в каждой части в Булевские 
переменные, затем И 

| Преобразовать переменные в каждой части в Булевские 
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переменные, затем ИЛИ 

^ Преобразовать переменные в каждой части в Булевские 
переменные, затем неэквивалентность 

  

> Истина, если переменная слева больше чем переменная 
справа, иначе ложь 

< Истина, если переменная слева меньше чем переменная 
справа, иначе ложь 

>= Истина, если переменная слева больше или равна переменной 
справа, иначе ложь 

<= Истина, если переменная слева меньше или равна переменной 
справа, иначе ложь 

  

+ Суммирование с плавающей запятой 

- Вычитание с плавающей запятой 

  

* Умножение с плавающей запятой 

/ Деление с плавающей запятой 

  

** Вещественная часть возведения левой части в степень 
правой, например -2**1.5 возвращает 0., а не 2.82843i 

  

! Преобразовать следующую переменную в Булевские переменные 
и инвертировать 

 

Истина в цифровой форме равна 1, и Ложь 0. Превращение к 
Булевским переменным преобразовывает значение в 1, если значение 
больше чем 0.5, иначе значение преобразовывается к 0. 

Обратите внимание, что LTspice использует символ "^", для 
Булевских переменных XOR и "**" для возведения в степень. Кроме 
того, LTspice различает возведение в степень, x**y она же pow(x,y), 
и функцию pwr(x,y). У некоторых симуляторов 3-ьих сторон есть 
неправильная реализация поведенческого возведения в степень, 
оценивая -3**3 неправильно 27 вместо -27, по-видимому, для ухода от 
задачи возведения отрицательного числа в степень нецелого числа. 
LTspice обрабатывает степень возвращением вещественной части 
результата возведения в степень. Например, -2**1.5 в результате 
нуль, который является вещественной частью правильного ответа 
2.82842712474619i. Это означает что, когда Вы импортируете модель 
3-ьей стороны, которая создавалась в симуляторе 3-ьей стороны, Вы, 
возможно, должны транслировать синтаксис, например, x^y к x**y или 
даже pwr(x,y). 

Если опциональное Преобразование Лапласа определяется, эта 
трансформация применяется к результату поведенческого 
электрического тока или напряжения. Преобразование Лапласа должно 
быть функцией исключительно s. Оператор XOR Булевских переменных, 
^, означает возведение в степень, **, когда используется в 
переменной Laplace. Частотная характеристика в частоте f находится 
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при замене s на sqrt(-1)*2*pi*f. Режим временной области находится 
от суммы мгновенного тока (или напряжения) со сверткой хронологии 
этого электрического тока (или напряжения) с импульсной 
передаточной функцией. Числовая инверсия функции преобразования 
Лапласа к временной области импульсной передаточной функции 
потенциально ограниченный процесс по скорости вычислений и тема 
текущего числового исследования. В LTspice импульсная передаточная 
функция находится от FFT дискретных точек набора в частотной 
области. Этот процесс является склонным к обычным артефактам, 
например, спектрального тока утечки FFT и ограждения пикета, 
которое распространено у дискретных FFT. LTspice использует частный 
алгоритм, который использует это, он имеет точную аналитическую 
переменную для характеристики частотной области и выбирает точки и 
окна, чтобы заставить такие артефакты дифрагировать точно к нулю. 
Однако LTspice должен предположить соответствующий частотный 
диапазон и разрешающую способность. Рекомендуется, чтобы LTspice 
сначала позволили высказать предположение в этом. О 
продолжительности окна и числе используемых точек на графике FFT 
сообщено в .log файле. Можно затем корректировать варианты 
алгоритма явной установкой nfft и продолжительности окна. Обратная 
величина значения окна - разрешающая способность по частоте. 
Значение nfft времен эта разрешающая способность является самой 
высокой частотой, которую рассматривают. Обратите внимание, что 
свертка импульсной передаточной функции с поведенческим источником 
также потенциально ограниченный процесс по скорости вычисления. 

 

C. Конденсатор 
Имена обозначения: CAP, POLCAP 

Синтаксис: Cnnn n1 n2 <capacitance> [ic=<value>] 

+ [Rser=<value>] [Lser=<value>] [Rpar=<value>] 

+ [Cpar=<value>] [m=<value>]  

+ [RLshunt=<value>] [temp=<value>] 

Возможно установить эквивалентное последовательное сопротивление, 
последовательную индуктивность, параллельное сопротивление и 
параллельную замыкающую емкость. Эквивалентная схема дается ниже: 

 



76 
 

Параметры Экземпляра класса Конденсатора 

ИМЯ  ОПИСАНИЕ 

Rser Эквивалентное последовательное сопротивление 

Lser Эквивалентная последовательная индуктивность 

Rpar Эквивалентное параллельное сопротивление 

Cpar Эквивалентная параллельная емкость 

RLshunt Сопротивление шунтируещее Lser 

m Число параллельных единиц 

temp Температура экземпляра класса (для передачи tempcos в 
.model оператор) 

ic Начальное напряжение (используется, только если uic 
помечено на .tran объявлении) 

В вычислительном отношении лучше включить паразитный Rpar, Rser, 
RLshunt, Cpar и Lser в конденсаторе, чем явно вычертить их. LTspice 
использует частную технологию моделирования схемы, чтобы 
имитировать эту модель физического конденсатора без любых 
внутренних узлов. Это делает матрицу моделирования меньшей, быстрее 
решаемой, и менее вероятно быть вырожденной в коротких временных 
шагах. 

Обратите внимание, что, так как элемент конденсатора включает 
свои паразитные элементы, это полезно для макромоделирования 
фундаментального пьезоэлектрического кристалла. 

Есть также общий нелинейный конденсатор. Для него вместо задания 
емкости, задается выражение для заряда. 

LTspice компилирует это выражение и символически дифференцирует 
ее относительно всех переменных, находя частные производные, 
которые соответствуют емкостям. 

Синтаксис: Cnnn n1 n2 Q=<expression> [ic=<value>] [m=<value>] 

 Есть специальная переменная, x, который означает напряжение на 
приборе. Поэтому, 100pF постоянная емкость может быть написана как 

Cnnn n1 n2 Q=100p*x 

Емкость с резким изменением от 100p до 300p в нулевых вольтах 
может быть написана как 

Cnnn n1 n2 Q=x*if (x <0,100p, 300p) 

Этот прибор полезен для быстрой оценки режима новой 
гипотетической модели заряда, например, для транзистора. 

 

D. Диод 
Имена Обозначения: DIODE, ZENER, SCHOTTKY, VARACTOR. 

Синтаксис: Dnnn anode cathode <model> [area] 

+ [off] [m=<val>] [n=<val>] [temp=<value>] 

Примеры: 

D1 SW OUT MyIdealDiode 

.model MyIdealDiode D(Ron=.1 Roff=1Meg Vfwd=.4) 

D2 SW OUT dio2 
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.model dio2 D(Is=1e-10) 

Параметр M экземпляра класса устанавливает количество 
параллельных приборов, в то время как параметр N экземпляра класса 
устанавливает количество последовательных приборов. 

Диод требует задать .model карту, чтобы определить его 
характеристики. Есть два типа доступных диодов. Первый - проводящая 
кусочно-линейная модель, которая приводит в вычислительном 
отношении к изображению индикации нагрузки идеализированного диода. 
У него есть три области линейной проводимости: прямой, обратной и 
пробоя в обратном направлении. Прямая проводимость и пробой в 
обратном направлении может быть нелинейной при определении предела 
тока Ilimit (revIlimit). Tanh() используется, чтобы подогнать 
градиент прямой проводимости к предельному электрическому току. 
Параметры epsilon и revepsilon могут быть указаны, чтобы гладко 
переключиться между закрытым и проводящим состоянием. Квадратичная 
функция - подгонка между выкл. и вкл. состоянием таким образом, что 
I-V характеристика диода непрерывна в значении и градиенте, и 
переключение происходит по напряжению, определенному значением 
epsilon для переключения между закрытым и проводящим состоянием и 
revepsilon для переключения между закрытым и пробоем в обратном 
направлении. 

Ниже модельные параметры для этого типа диода: 

ИМЯ  Описание Единицы Значение по 
умолчанию 

Ron Прямое сопротивление  Ω 1. 

Roff Обратное сопротивление Ω 1./Gmin 

Vfwd Прямое пороговое напряжение начала 
проводимости 

V 0. 

Vrev Напряжение обратного пробоя V Infin. 

Rrev Сопротивление в области пробоя Ω Ron 

Ilimit Предел прямого тока A Infin. 

Revilimit Предел обратного тока A Infin. 

Epsilon Ширина квадратичной области V 0. 

Revepsilon Ширина обратной квадратичной 
области 

V 0. 

Эта идеализированная модель используется, если любой Ron, Roff, 
Vfwd, Vrev или Rrev указан в модели. 

Другой доступной моделью является стандартный Беркли SPICE 
полупроводниковый диод, но расширенный, чтобы обработать более 
детальный режим пробоя и ток рекомбинации. Коэффициент участка 
определяет количество эквивалентных параллельных приборов указанной 
модели. Ниже диодные параметры модели для этого диода. 

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ ЗНАЧЕНИЕ ПО 

УМОЛЧАНИЮ 
ПРИМЕР 

Is Ток режима насыщения A 1e-14 1e-7 

Rs Активное сопротивление Ω 0. 10. 

N Эмиссионный коэффициент - 1. 1. 

Tt Время переключения sec 0. 2n 
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Cjo Емкость перехода при смещении 0.V F 0. 2p 

Vj Электрический потенциал перехода V 1. .6 

M Оценочный коэффициент - 0.5 0.5 

Eg Энергия активации eV 1.11 1.11 Si 
0.69 Sbd 
0.67 Ge 

Xti Sat.-current temp. exp - 3.0 3.0 jn 
2.0 Sbd 

Kf Коэффициент фликер-шума - 0.  

Af Экспонента фликер-шума 1 1  

Fc Коэффициент для формулы барьерной 
емкости прямого смещения 

- 0.5  

BV Напряжение обратного пробоя V Infin. 40. 

Ibv Электрический ток в напряжении 
пробоя 

A 1e-10  

Tnom Температура измерения параметра °C 27 50 

Isr Параметр тока рекомбинации A 0  

Nr Коэффициент эмиссии Isr - 2  

Ikf Высоко-инжекционный электрический 
ток колена 

A Infin.  

Tikf Линейный коэффициент температуры 
Ikf 

/°C 0  

Trs1 линейный коэффициент температуры Rs /°C 0  

Trs2 Квадратичный коэффициент 
температуры Rs 

/°C/°C 0  

Возможно установить предельные напряжение, электрический ток, и 
максимальные рассеиваемые мощности для модели. Эти модельные 
параметры не затрагивают электрический режим. Они позволяют LTspice 
проверять, используется ли диод вне его номинальной возможности. 
Эти параметры применяются к обеим моделям диода. Эти параметры не 
масштабируют с участком. 

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ 

Vpk Оценка пикового напряжения V 

Ipk Оценка пикового тока A 

Iave Оценка активного тока A 

Irms Оценка электрического тока RMS A 

diss Максимальная рассеиваемая мощность W 

 

E. зависимый от напряжения источник напряжения  
Имена Обозначения: E, E2 

Есть пять типов зависящих от напряжения схемных элементов 
источника напряжения. 

Синтаксис: Exxx n+ n- nc+ nc-<gain> 
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Этот схемный элемент утверждает выходное напряжение между узлами 
n+ и n-, который зависит от входного напряжения между узлами nc+ и 
nc-. Это - линейно-зависимый исток, установленный исключительно 
постоянным усилением. 

Синтаксис: Exxx n+ n- nc+ nc- table=(<value pair>, <value pair>, 
...) 

Таблица поиска используется, чтобы установить функцию 
преобразования. Таблица - список пар значений. Второе значение пары 
- выходное напряжение, когда напряжение элемента управления равно 
первому значению этой пары. Выходное устройство линейно 
интерполируется, когда напряжение элемента управления между 
указанными точками. Если напряжение элемента управления вне 
диапазона таблицы поиска, выходное напряжение экстраполируется как 
постоянное напряжение последней точки таблицы поиска. 

Синтаксис: Exxx n+ n- nc+ nc- Laplace=<func(s)> 

+ [window=<time>] [nfft=<number>] [mtol=<number>] 

Функция преобразования этого схемного элемента устанавливается 
его Преобразованием Лапласа. Преобразование Лапласа должно быть 
функцией s. Частотная характеристика на частоте f находится при 
замене s на sqrt(-1)*2*pi*f. Режим временной области находится от 
импульсной передаточной функции, найденной от преобразования Фурье 
характеристики частотной области. LTspice должен предположить 
соответствующий частотный диапазон и разрешающую способность. 
Характеристика должна понижаться в высоких частотах, или сообщается 
об ошибке. Рекомендуется, чтобы LTspice сначала позволили высказать 
предположение в этом и затем проверить точность уменьшением 
изображения reltol или явная установка nfft и параметров окна. 
Обратная величина значения окна - разрешающая способность по 
частоте. Значение nfft времен это разрешающая способность, является 
самой высокой частотой, которую рассматривают. Оператор XOR 
Булевских переменных, "^", означает возведение в степень "**" когда 
используется в переменной Laplace. 

Синтаксис: Exxx n+ n- value={<expression>} Это - альтернативный 
синтаксис поведенческого источника, произвольного поведенческого 
источника напряжения B. 

Синтаксис: Exxx n+ n- POLY(<N>) <(node1+,node1-) (node2+,node2-) 

+ ... (nodeN+,nodeN-)> <c0 c1 c2 c3 c4 ...> 

Это - архаичное средство произвольного поведенческого 
моделирования с полиноминалами. Это полезно для выполнения 
существующих поведенческих моделей Linear Technology. 

Примечание: лучше использовать источник G, шунтируемый с 
сопротивлением, чтобы аппроксимировать источник E, чем использовать 
источник E. Управляемый напряжением источник тока, шунтируемый с 
сопротивлением, вычисляется быстрее и вызовет меньше вопросов о 
сходимости, чем управляемый напряжением источник напряжения. Кроме 
того, результирующее выходное сопротивление отличное от нуля 
является более представительным для практической схемы. 

 

F. зависимый от тока источник тока 
Имя Обозначения: F 
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Синтаксис: Fxxx n+ n- <Vnam> <gain> 

Этот схемный элемент создает электрический ток между узлами n+ и 
n-. Примененный электрический ток больше в коэффициент усиления раз 
электрического тока через источник напряжения, указанный как 
<Vnam>. 

Синтаксис: Fxxx n+ n- value={<expression>} 

Это - альтернативный синтаксис поведенческого источника, 
произвольного поведенческого источника напряжения, B. 

Синтаксис: Fxxx n+ n- POLY(<N>) <V1 V2... VN> <c0 c1 c2 c3 c4...> 

Это - архаичное средство произвольного поведенческого 
моделирования с полиноминалами. Это полезно для выполнения 
существующих поведенческих моделей Linear Technology. 

 

G. зависимый от напряжения источник тока 
Имена Обозначения: G, G2 

Есть пять типов схемных элементов зависящих от напряжения 
источников тока. 

Синтаксис: Gxxx n+ n- nc+ nc- <gain> 

Этот схемный элемент утверждает выходной электрический ток между 
узлами n+ и n-, который зависит от входного напряжения между узлами 
nc+ и nc-. Это - линейно-зависимый исток, установленный 
исключительно постоянным усилением. 

Синтаксис: Gxxx n+ n- nc+ nc- table=(<value pair>, <value pair>, 
...) 

Здесь поисковая таблица используется, чтобы установить функцию 
преобразования. Таблица - список пар величин. Второе значение пары 
- выходной электрический ток, когда напряжение элемента управления 
равно первому значению этой пары. Выходное устройство линейно 
интерполируется, когда напряжение элемента управления между 
указанными точками. Если напряжение элемента управления вне 
диапазона таблицы поиска, выходной электрический ток 
экстраполируется как постоянный электрический ток последней точки 
таблицы поиска. 

Синтаксис: Gxxx n+ n- nc+ nc- Laplace=<func(s)> 

+ [window=<time>] [nfft=<number>] [mtol=<number>] 

Функция преобразования этого схемного элемента устанавливается 
его Преобразованием Лапласа. Преобразование Лапласа должно быть 
функцией s. Частотная характеристика на частоте f находится при 
замене s на sqrt(-1)*2*pi*f. Режим временной области находится от 
импульсной передаточной функции, найденной от преобразования Фурье 
функции частотной области. LTspice должен предположить 
соответствующий частотный диапазон и разрешающую способность. 
Характеристика должна понижаться в высоких частотах, или сообщается 
об ошибке. Рекомендуется, чтобы LTspice сначала позволили высказать 
предположение в этом и затем проверить точность уменьшением 
изображения reltol или явной установкой nfft и параметров окна. 
Обратная величина значения окна - разрешающая способность по 
частоте. Значение nfft времен это разрешающая способность, является 
самой высокой частотой, которую рассматривают. Оператор XOR 
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Булевских переменных, "^", означает возведение в степень "**" когда 
используется в переменной Laplace. 

Синтаксис: Gxxx n+ n- value={<expression>} Это - альтернативный 
синтаксис поведенческого источника, rbitrary поведенческий источник 
напряжения, B. 

Синтаксис: Gxxx n+ n- POLY(<N>) <(node1+,node1-) (node2+,node2-) 

+ ... (nodeN+,nodeN-)> <c0 c1 c2 c3 c4 ...> 

Это - архаичное средство произвольного поведенческого 
моделирования с полиноминалами. Это полезно для выполнения 
существующих поведенческих моделей Linear Technology. 

 

H. зависимый от тока источник напряжения 
Имя Обозначения: H 

Синтаксис: Hxxx n+ n- <Vnam> <transresistance> 

Этот схемный элемент применяет напряжение между узлами n+ и n-. 
Примененное напряжение равно электрическому току через источник 
напряжения <Vnam>. с коэффициентом значение усиления 

Синтаксис: Hxxx n+ n- value={<expression>} 

Это - альтернативный синтаксис поведенческого источника, 
произвольного поведенческого источника напряжения, B. 

Синтаксис: Hxxx n+ n- POLY(<N>) <V1 V2 ... V3> <c0 c1 c2 c3 c4 
...> 

Это - архаичное средство произвольного поведенческого 
моделирования с полиноминалами. Это полезно для выполнения 
существующих поведенческих моделей Linear Technology. 

 

I. источник тока 
Имя Обозначения: CURRENT 

●Синтаксис: Ixxx n+ n- <current> [AC=<amplitude>] [load] 

Это схемный элемент источника постоянного электрического тока 
между узлами n+ и n-. Если источник помечается как загрузка (load), 
источник вынуждается быть диссипативным, то есть, электрический ток 
нулевой, если напряжение между узлами n+ и n- нулевое или 
отрицательное. Цель этой опции - моделировать токовую загрузку на 
источнике питания, которая не дает электрический ток, если выходное 
напряжение - нуль. 

Для исследования AC значение AC используется как амплитуда 
источника на частоте исследования. 

●Синтаксис: Ixxx n+ n- PULSE(Ioff Ion Tdelay Trise Tfall Ton 
Tperiod Ncycles) 

Источник импульсного тока с временной зависимостью  

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ 

Ioff Начальное значение A 

Ion Импульсное значение A 

Tdelay Время задержки sec 
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Tr Время фронта нарастания sec 

Tf Время фронта спада sec 

Ton Время включения sec 

Tperiod Время периода sec 

Ncycles Количество циклов (Опускают для 
непрерывной функции импульса) 

num. 

 

●Синтаксис: Ixxx n+ n- SINE(Ioffset Iamp Freq Td Theta Phi 
Ncycles) 

Источник синусоидального тока с временной зависимостью. 

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ 

Ioffset DC смещение A 

Iamp Амплитуда A 

Freq Частота Hz 

Td Время задержки sec 

Theta Декремент затухания 1/sec 

Phi Фаза синусоидальной волны градусы 

Ncycles Количество циклов (Опускают для 
непрерывной функции импульса) 

num. 

Для времени меньше чем Td или после завершения Ncycles, для 
работы выходной ток задан Ioffset+Iamp*sin (pi*phi/180). Иначе, 
электрический ток задан 

Ioffset+Iamp*exp(-(time-Td)*Theta)*sin(2*pi*Freq*(time-
Td)+pi*phi/180) 

Декремент затухания, Theta является обратной величиной константы 
времени спада импульса. 

●Синтаксис: Ixxx n + n-EXP (I1 I2 Td1 Tau1 Td2 Tau2) 

Экспоненциальный источник тока с временной зависимостью 

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ 

I1 Начальное значение A 

I2 Импульсное значение A 

Td1 Время задержки повышения sec 

Tau1 Константа времени повышения sec 

Td2 Время задержки падения sec 

Tau2 Константа времени затухания sec 

Для времени меньше чем Td1 выходной ток - I1. Для времени между 
Td1 и Td2 ток задан 

I1+(I2-I1)*(1-exp(-(time-Td1)/Tau1)). 

Для времени после Td2 ток задает 

I1+(I2-I1)*(1-exp(-(time-Td1)/Tau1)) 

+(I1-I2)*(1-exp(-(time-Td2)/Tau2)) 

●Синтаксис: Ixxx n+ n- SFFM(Ioff Iamp Fcar MDI) 

FM источник тока одной частоты с временной зависимостью. 
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ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ 

Ioff DC смещение A 

Iamp Амплитуда A 

Fcar Несущая частота  

MDI Индекс модуляции - 

Fsig Частота сигнала Hz 

Ток задан 

Ioff+Iamp*sin((2.*pi*Fcar*time)+MDI*sin(2.*pi*Fsig*time)). 

●Синтаксис: Ixxx n+ n- tbl=(<voltage, current>, <voltage, 
current>, ...) 

Электрический ток может также быть установлен как функция 
напряжения через выходные узлы с таблицей поиска. Это полезно для 
моделирования характеристик загрузки. 

●Синтаксис: Ixxx n+ n- <value> step(<value1>, [<value2>], 
[<value3>, ...]) [load] 

Это - специальный вид для источника тока. Электрический ток 
устанавливается как список токов, чтобы использовать в анализе 
переходных процессов ответа загрузки шага. В этом режиме 
вычисляется моделирование, пока состояние steady не достигается при 
первом электрическом токе в списке, <value1>. Затем электрический 
ток принимает следующее значение в списке, <value2>. Довод 
моделирования до состояния steady достигаются при этом токе. Затем 
электрический ток принимает следующее значение и повторение 
процесса, пока список не истощается. Если .tran команда не 
устанавливает "step", то используется оригинал <value>. 

●Синтаксис: Ixxx n+ n- R=<value> 

Это не источник тока вообще, а резистор. Это используется, чтобы 
моделировать активную нагрузку, когда загрузка - netlisted как 
источник тока. 

●Синтаксис: Ixxx n+ n- PWL(t1 i1 t2 i2 t3 i3...) 

Произвольный Кусочно-линейный источник тока. 

Для времени меньше t1, электрический ток - i1. Для времени между 
t1 и t2, электрический ток изменяется линейно между i1 и i2. Может 
быть любое количество времени, текущие данные точки. Для времени 
после последней точки, электрический ток - последнее значение. 

●Синтаксис: Ixxx n+ n- wavefile=<filename> [chan=<nnn>] 

Это позволяет .wav файлу использоваться как ввод в LTspice. <Имя 
файла> есть полный, абсолютный путь для .wav файла или 
относительный путь, вычисленный от каталога, содержащего описание 
схемы моделирования или список соединений. Двойные кавычки могут 
использоваться, чтобы установить путь, содержащий пространства..Wav 
файл может содержать до 65536 каналов, пронумерованных от 0 до 
65535. Может быть установлено, какой канал использовать. По 
умолчанию, первый канал, номер 0, используется. Файл .wav 
интерпретируется как наличие полного диапазона шкалы от-1A до 1A. 

У этого источника есть значение только в .tran исследовании. 
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J. транзистор JFET 
Имена Обозначения: NJF, PJF 

Синтаксис: Jxxx D G S <model> [area] [off] [IC=Vds,Vgs] 

[temp=T] 

Примеры: 

J1 0 в out MyJFETmodel 

.model MyJFETmodel NJF(Lambda =.001) 

J2 0 в out MyPJFETmodel 

.model MyPJFETmodel PJF(Lambda =.001) 

Транзистор JFET требует задать .model карту, чтобы установить его 
характеристики. Обратите внимание, что модельные ключевые слова 
платы NJF и PJF устанавливают полярность транзистора. Коэффициент 
площади area определяет количество эквивалентных параллельных 
приборов указанной модели. 

Модель JFET производная от FET модели полевого транзистора 
Shichman и Hodges, расширенная включением тока рекомбинации затвора 
и ударной ионизации. Характеристики DC определяются параметрами VTO 
и BETA, которые определяют изменение тока стока от напряжения 
затвора; LAMBDA, которая определяет выходную проводимость; и Is, 
током насыщения двух переходов затвора. Включаются два активных 
сопротивления, Rd и Rs. Память заряда моделируется нелинейными 
емкостями запирающего слоя для обоих переходов затвора, которые 
изменяются как -1/2 степень напряжения на переходе и определяются 
параметрами Cgs, Cgd, и PB. Подгоняемый параметр B был добавлен. 
См. A.E.Parker и D.J.Skellern, An Improved FET Model for Computer 
Simulators, IEEE Trans CAD, vol. 9, no. 5, pp. 551-553, May 1990 
(Улучшенная Модель полевого транзистора для Компьютерных 
Симуляторов, издание 9, номер 5, стр.551-553, май 1990). 

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ ЗНАЧ. ПО 

УМОЛЧ. 
ПРИМЕР 

Vto Пороговое напряжение V -2.0 -2.0 

Beta Параметр активной межэлектродной 
проводимости 

A/V/V 1e-4 1e-3 

Lambda Параметр модуляции длины канала 1/V 0 1e-4 

Rd Активное сопротивление стока Ω 0. 100 

Rs Активное сопротивление истока Ω 0. 100 

Cgs Емкость перехода G-S при нулевом 
смещении 

F 0. 5p 

Cgd Емкость перехода G-D при нулевом 
смещении 

F 0. 1p 

Pb Потенциал перехода затвора V 1. 0.6 

Is Ток насыщения перехода затвора A 1e-14 1e-14 

B Параметр легирования хвоста - 1 1.1 

KF Коэффициент фликер-шума - 0  

AF Экспонента фликер-шума - 1  

Fc Коэффициент для передовой - .5  
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барьерной емкости (запирания?) 

Tnom Температура измерения параметра °C 27 50 

BetaTce Температурный коэффициент 
показательной функции активной 
межэлектродной проводимости 

%/°C 0  

VtoTc Пороговый температурный 
коэффициент напряжения 

V/°C 0  

N Коэффициент испускания перехода 
затвора 

- 1.  

Isr Параметр тока рекомбинации 
перехода затвора 

A 0.  

Nr Эмиссионный коэффициент для Isr - 2  

alpha Коэффициент ионизации 1/V 0  

Vk Напряжение колена ионизации V 0  

Xti Температурный коэффициент тока 
режима насыщения 

- 3  

 

 

K. взаимосвязь индуктивностей 
Имена Обозначения: Нет. 

 Имя не размещается как текст на описании схемы, размещается 
строка(и) связи существующих в схеме индуктивностей: 

Синтаксис: Kxxx L1 L2 [L3...] <коэффициент> 

L1 и L2 - имена катушек индуктивности в схеме. Взаимный 
коэффициент связи должен быть в диапазоне от -1 до 1. 

Строка 

K1 L1 L2 L3 L4 1. 

Тождественна по значению шестью строкам 

K1 L1 L2 1. 

K2 L2 L3 1. 

K3 L3 L4 1. 

K4 L1 L3 1. 

K5 L2 L4 1. 

K6 L1 L4 1. 

Рекомендуется начать с коэффициента взаимосвязи индуктивностей, 
равного 1. Это устранит индуктивность рассеивания, которая может 
звонить на высоких частотах, если нет демпфирования, и замедлять 
моделирование. Однако значение взаимоиндукции -1 или 1 может 
привести к трудностям в моделировании, если uic директива помечена 
на .tran карте. 

 

L. Катушка индуктивности 
Имена Обозначения: IND, IND2 

Синтаксис: Lxxx n+ n- <inductance> [ic=<value>] 
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+ [Rser=<value>] [Rpar=<value>] 

+ [Cpar=<value>] [m=<value>] [temp=<value>] 

Это позволяет установить эквивалентное последовательное 
сопротивление, последовательную индуктивность, параллельное 
сопротивление и параллельную замыкающую емкость. Эквивалентная 
схема дается ниже: 

 
Параметры Экземпляра класса Катушки индуктивности 

ИМЯ  ОПИСАНИЕ 

Rser Эквивалентное последовательное сопротивление 

Rpar Эквивалентное параллельное сопротивление 

Cpar Эквивалентная параллельная емкость 

m Количество параллельных единиц 

ic Начальный ток (используется только если uic директива 
помечена на .tran карте) 

tc1 Линейный температурный коэффициент индуктивности 

Tc1 Квадратичный температурный коэффициент индуктивности 

temp Температура экземпляра класса 

Лучше включить паразитные элементы прибора Rpar, Rser, и Cpar в 
катушке индуктивности, чем явно вычертить их. LTspice использует 
частную технологию моделирования схемы, чтобы имитировать эту 
физическую катушку индуктивности без любых внутренних схемных 
узлов. Это делает матрицу моделирования меньшей, быстрее 
вычисляемой, и менее вероятно быть вырожденной, по всем размерам 
временного шага. 

По умолчанию, LTspice предоставит потери на катушке 
индуктивности, чтобы помочь анализу переходных процессов SMPS. На 
SMPS эти потери обычно не влияют, но могут быть выключены если 
задать. На "Tools=> Control Panel=>Hacks!" странице снять метку 
"Supply a min. inductor damping if no Rpar is given". Эта установка 
сохранится между вызовами программы. Есть также заданное по 
умолчанию последовательное сопротивление 1 milliOhm для катушек 
индуктивности, которые не упоминаются в операторе взаимоиндукции. 
Этот Rser позволяет SwitcherCAD III интегрировать катушку 
индуктивности как эквивалентную схему с источником тока вместо 
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источника напряжения, чтобы уменьшить размер линеаризовавшей 
матрицы схемы. Если Вы не хотите, чтобы LTspice подставил это 
минимальное сопротивление, следует явно установить Rser=0 для той 
катушки индуктивности. Это будет вынуждать LTspice использовать 
более громоздкий эквивалент катушки индуктивности - источник 
напряжения, во время анализа переходных процессов. 

Есть два вида нелинейных катушек индуктивности, доступных в 
LTspice. Первый - поведенческая катушка индуктивности, определенная 
выражением flux. Электрический ток катушки индуктивности 
обозначается переменной "x" в выражении. Ниже пример в списке 
соединений: 

* 

L1 N001 0 Flux=1m*tanh(5*x) 

I1 0 N001 PWL(0 0 1 1) 

.tran 1 

.end 

В этом примере I1 предоставляет единицу dI/dT так, чтобы 
индуктивность катушки  могла быть прочитана как напряжение на узле 
N001. 

Другая нелинейная катушка индуктивности, доступная в LTspice, 
является моделью с гистерезисным сердечником, основанной на модели, 
которую предложил впервые JOHN CHAN ET LA. В IEEE TRANSACTIONS ON COMPUTER-AIDED DESIGN, VOL. 

10. NO. 4, APRIL 1991. Эта модель определяет гистерезисную петлю только с 
тремя параметрами: 

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ 

Hc Коэрцитивная сила Amp-
turns/meter 

Br Остаточная магнитная индукция Тесла 

Bs Магнитная индукция насыщения Тесла 

Верхний и нижний переходы главного гистерезисного цикла задают 

выражения 

 

Эти функции чертятся в рисунке ниже. Hc и Br - пересечения 
главной гистерезисной петли с H- и B-осями. Bs - пересечение B-оси 
асимптотической линией, Bsat(H)=Bs+µ0*H, приближенно, поскольку H 
идет в бесконечность. 
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Характеристику начального намагничивания дает выражение 

Bmag(H)=.5*(Bup(H)+Bdn(H)) 

Частные циклы получаются различными трансляциями вышеупомянутых 
уравнений в приведенное выражение. Абсолютная и дифференциальная 
проницаемости сердечника - функция H и исторически вычисляется из 
значений H. График ниже показывает путь, взятый несимметричным 
частным циклом для типичного силового феррита (Hc=16 A-turns/m, 
Bs=.44T, Br=.10T). 

 

В дополнение к основным параметрам свойств сердечника Hc, Br, и 
Bs, требуются механические размерности сердечника: 

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ 
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Lm Длина магнитной линии сердечника 
(исключая зазор) 

meter 

Lg Длина немагнитного зазора meter 

A Площадь поперечного сечения сердечника meter**2 

N Количество витков Number 

Обратите внимание, что при определении ненулевого зазора 
магнитное поле, H, не пропорционально электрическому току в 
обмотках. LTspice решает для магнитных полей в сердечнике и зазоре 
согласно предположению об универсальной площади поперечного сечения 
и тонком или однородно распределенном зазоре. 

Ниже пример, который показывает зависимость индуктивности от тока 
для L1, катушки индуктивности на сердечнике с зазором. Можно читать 
индуктивность как V(n001) с включением источника тока I1 с dI/dt=1. 
Сердечник следует за начальной характеристикой намагничивания, 
таким образом можно видеть, что магнитная проницаемость сначала 
увеличивается от начального значения, поскольку электрический ток 
возрастает, и затем уменьшается, когда начинается насыщение. Так 
как зазор делает катушку индуктивности нечувствительной к точной 
магнитной проницаемости сердечника, необходимо значительно 
увеличить масштаб на V(n001), чтобы видеть, что индуктивность 
действительно увеличивается. Пик, когда напряженность поля H в 
сердечнике равна его коэрцитивной силе Hc. 

* 

L1 N001 0 Hc=16. Bs=.44 Br=.10 A=0.0000251 

+ Lm=0.0198 Lg=0.0006858 N=1000 

I1 0 N001 PWL(0 0 1 1) 

.tran .5 

.options maxstep=10u 

.end 

 

M. MOSFET 
Имена Обозначения: NMOS, NMOS3, PMOS, PMOS3. В LTspice два 

существенно различных типа модели MOSFET's (МОП транзисторов): 
монолитный MOSFET и новый вертикальной двойной диффузии силовой 
MOSFET. 

●Монолитный MOSFET: 

Синтаксис: Mxxx Nd Ng Ns Nb <model> [m=<value>] [L=<len>] 

+ [W=<width>] [AD=<area>] [AS=<area>] 

+ [PD=<perim>] [PS=<perim>] [NRD=<value>] 

+ [NRS=<value>] [off] [IC=<Vds, Vgs, Vbs>] 

+ [temp=<T>] 

Пример: 

M1 Nd Ng Ns 0 MyMOSFET 

.model MyMOSFET NMOS(KP=.001) 

M1 Nd Ng Ns Nb MypMOSFET 
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.model MypMOSFET PMOS(KP=.001) 

●Вертикальной двойной диффузии силовой MOSFET: 

Синтаксис: Mxxx Nd Ng Ns <model> [L=<len>] [W=<width>] 

+ [M=<area>] [m=<value>] [off] 

+ [IC=<Vds, Vgs, Vbs>] [temp=<T>] 

Пример: 

M1 Nd Ng Ns Si4410DY 

.model Si4410DY VDMOS(Rd=3m Rs=3m Vto=2.6 Kp=60 

+ Cgdmax=1.9n Cgdmin=50p Cgs=3.1n Cjo=1n 

+ Is=5.5p Rb=5.7m) 

Модельная карта MOSFET устанавливает тип модели. Ключевые слова 
модельной карты NMOS и PMOS устанавливают монолитный N- или P- 
канальный MOSFET транзистор. Ключевое слово модельной карты VDMOS 
устанавливает вертикальной двойной диффузии силовой MOSFET. 

Монолитный MOSFET - четырех выводный прибор. Nd, Ng, NS, и Nb – 
имена выводов с названием соответственно сток, затвор, исток и 
основа, т.е., подложка. L и W - длина и ширина канала в метрах. AD 
и AS - участки диффузии стока и истока, в квадратных метрах. 
Обратите внимание, что суффикс u устанавливает µm (микрометры), 
суффикс p квадратные µm. Если любой из L, W, AD, или AS не 
устанавливается, используются значения по умолчанию. PD и PS - 
периметры переходов стока и истока, в метрах. NRD и NRS определяют 
эквивалентное количество площадей диффузии стока и истока; эти 
значения умножаются на поверхностное сопротивление слоя RSH, 
установленное в контрольной строке .MODEL. PD и PS по умолчанию 
равны нулю, в то время как NRD и NRS равны одному. OFF указывает 
начальное условие на приборе для исследования DC. Начальная 
спецификация условия, используя IC =VDS, VGS, VBS для использования 
с опцией UIC в контрольной строке .TRAN, когда анализ переходных 
процессов задан стартовать с иной рабочей точки, кроме статической. 
Опциональное значение TEMP - температура, в которой этот прибор 
должен работать, и отменяет температурную спецификацию в 
контрольной строке .OPTION. Температурная спецификация допустима 
ТОЛЬКО для уровня 1, 2, 3, и 6 MOSFET's, не для уровня 4, 5 или 8 
BSIM приборов. 

LTspice содержит семь различных типов monolithic MOSFET's, и один 
тип вертикальной двойной диффузии силовой MOSFET. 

Есть семь моделей прибора monolithic MOSFET. Модельный параметр 
LEVEL устанавливает модель, которая будет использоваться. Заданный 
по умолчанию level=1. 

 

(LEVEL) УРОВЕНЬ МОДЕЛИ 

----------------------- 

1 Shichman-Hodges 

2 MOS2 (см. A. Vladimirescu and S. Liu, The Simulation of MOS 
Integrated Circuits Using SPICE2, ERL Memo No. M80/7, Electronics 
Research Laboratory University of California, Berkeley, October 
1980) 

3 MOS3, полуэмпирическая модель (см. ссылку для уровня 2) 
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4 BSIM (см. B. J. Sheu, D. L. Scharfetter, and P. K. Ko, SPICE2 
Implementation of BSIM. ERL Memo No. ERL M85/42, Electronics 
Research Laboratory University of California, Berkeley, May 1985) 

5 BSIM2 (см. Min-Chie Jeng, Design and Modeling of Deep-
Submicrometer MOSFETs ERL Memo Nos. ERL M90/90, Electronics 
Research Laboratory University of California, Berkeley, October 
1990) 

6 MOS6 (см. T. Sakurai and A. R. Newton, A Simple MOSFET Model 
for Circuit Analysis and its application to CMOS gate delay 
analysis and series-connected MOSFET Structure, ERL Memo No. ERL 
M90/19, Electronics Research Laboratory, University of California, 
Berkeley, March 1990) 

8 BSIM3v3.3.0 от Университета Калифорнии, Беркли на 29 июля 2005 

9 BSIMSOI3.2 (Silicon on insulator) от Группы Исследования BSIM 
Университета Калифорнии, Беркли, февраль 2004. 

12 EKV 2.6 основанный на коде от Ecole Polytechnique Federale de 
Lausanne. См. <http://legwww.epfl.ch/ekv> и "The EPFL-EKV MOSFET 
Model Equations for Simulation, Version 2.6", M. Bucher, C. 
Lallement, F. Theodoloz, C. Enz, F. Krummenacher, EPFL-DE-LEG, June 
1997. 

14 BSIM4.6.1 от Университета Калифорнии, Беркли Группа 
Исследования BSIM, 18 мая 2007. 

Характеристики DC уровней с 1 по 3 MOSFET's определяются 
параметрами VTO, KP, LAMBDA, PHI и GAMMA. Эти параметры 
вычисляются, если параметры процесса (NSUB, TOX,...) даны, но 
указанные пользователем значения всегда отменяют. VTO позитивен 
(негатив) для обогащенного типа и негатив (позитивный) для 
обедненного типа N-канала (P-канал) приборов. Память заряда 
оформляется тремя постоянными конденсаторами, CGSO, CGDO, и CGBO, 
которые представляют емкости перекрытия, нелинейной емкостью 
тонкого слоя оксида, которая распределяется среди затвора, истока, 
стока, и подложки, и нелинейными барьерными емкостями и для спаев 
подложки, разделенных на нижнюю часть и для края, которые 
изменяются как MJ и MJSW электропитание напряжения на переходе 
соответственно, и определяются параметрами CBD, CBS, CJ, CJSW, MJ, 
MJSW и PB. Явления памяти заряда оформляются кусочно-линейной 
зависящей от напряжений моделью емкости, предложенной Мейером. 
Явления памяти заряда тонкого слоя оксида обрабатываются немного 
иначе для модели Level=1. Эти зависящие от напряжения емкости 
включаются, только если Tox устанавливается. 

Есть немного перекрытия среди параметров, описывающих переходы, 
например, реверсирующийся электрический ток может быть установлен 
через Is[Amp] или через Js[Amp/m/m]. Принимая во внимание, что 
первое - абсолютное значение, второе умножается на Ad и As, чтобы 
получить реверсирующийся электрический ток переходов стока и истока 
соответственно. Та же самая идея применяет также к емкостям 
перехода нулевого смещения CBD и CBS [Farad] с одной стороны, и CJ 
[Farad/m/m] с другой. Паразитные последовательные сопротивления 
стока и истока могут быть выражены как RD и RS [Ohms] или 
RSH[Ohms/square], последний умножается на количество квадратов NRD 
и NRS, вводимое на строке прибора. 

УРОВЕНЬ MOSFET 1, 2, И 3, ПАРАМЕТРЫ: 
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ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ ЗНАЧ. ПО 
УМОЛЧ. 

ПРИМЕР 

Vto Пороговое напряжение нулевого смещения V 0 1.0 

Kp Параметр активной межэлектродной 
проводимости 

A/VІ 2e-5 3e-5 

Gamma Объемный пороговый параметр VЅ 0. 0.37 

Phi Поверхностный инверсный потенциал V 0.6 0.65 

Lambda Модуляция длины канала (только уровень 
1 и 2) 

1/V 0. 0.02 

Rd Активное сопротивление стока Ω 0. 1. 

Rs Активное сопротивление истока Ω 0. 1. 

Cbd Емкость перехода B-D нулевого смещения F 0. 20f 

Cbs Емкость перехода B-S нулевого смещения F 0. 20f 

Is Ток насыщения подложки A 1e-14 1e-15 

N Коэффициент эмиссии диода подложки - 1.  

Pb Потенциал спая подложки V 0.8 0.87 

Cgso Емкость перекрытия затвор исток на 
метр ширины канала 

F/m 0. 4e-11 

Cgdo Емкость перекрытия затвор сток на метр 
ширины канала 

F/m 0. 4e-11 

Cgbo Емкость перекрытия затвор подложка на 
метр ширины канала 

F/m 0. 2e-10 

Rsh Сопротивление слоя диффузии стока и 
истока 

Ω 0. 10. 

Cj Емкость нижнего спая подложки нулевого 
смещения на квадратный метр области 
перехода 

F/mІ 0. 2e-4 

Mj Коэффициент оценки нижнего спая 
подложки 

- 0.5 0.5 

Cjsw Емкость бокового спая подложки 
нулевого смещения на метр периметра 
спая 

F/m 0. 1p 

Mjsw Коэффициент оценки бокового спая 
подложки 

- .50 level 1 
.33 level 2,3 

Js Ток насыщения спая подложки на 
квадратный метр области перехода 

A/m 0. 1e-8 

Tox Окисная толщина m 1e-7 1e-7 

Nsub Легирование подложки полупроводника 1/cmі 0. 4e15 

Nss Плотность поверхностного состояния 1/cmІ 0. 1e-10 

Nfs Состояние быстрой поверхности 1/cmІ 0. 1e-10 

TPG Тип материала затвора: +1 оппозитный 
подложке; -1 тот же как подложка ; 0 
все затворы 

- 1  

Xj Глубина металлургического перехода m 0. 1µ 

Ld Боковая диффузия m 0. 0.8 µ 
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Uo Поверхностная подвижность cmІ/V/
s 

600 700 

Ucrit Критическое поле для ухудшения 
мобильности (только уровень 2) 

V/cm 1e4 1e4 

Uexp Экспонента критического поля в 
ухудшении мобильности (только уровень 
2) 

- 0. 0.1 

Utra Поперечный полевой коэффициент (только 
уровень 2) 

- 0. 0.3 

Vmax Максимальная скорость дрейфа носителей 
(только уровень 2, 3) 

m/s 0. 5e4 

Neff Полная экспонента заряда канала 
(только уровень 2) 

- 1. 5. 

Kf Коэффициент фликер-шума - 0. 1e-26 

Af Экспонента фликер-шума - 1. 1.2 

Fc Коэффициент для формулы барьерной 
емкости прямого смещения 

- 0.5  

Delta Эффект длительности импульса на порог 
напряжения (уровни 2 и 3) 

- 0. 1. 

Theta Модуляция мобильности (только уровень 
3) 

- 0. 0.1 

Eta Обратная связь статического 
электричества (уровень 3 только) 

- 0. 1. 

Kappa Поле режима насыщения (уровень 3 
только) 

 0.2 0.5 

Tnom Температура измерения параметра °C 27 50 

 
Дискретный вертикальной двойной диффузии силовой MOSFET 

транзистор (VDMOS), обычно используемый в плате импульсного 
источника питания, имеет режим, который качественно отличается от 
вышеупомянутых моделей monolithic MOSFET. В частности (1) 
внутренний диод VDMOS транзистора подключается с внешними выводами, 
по-другому чем диод подложки monolithic MOSFET и (2) емкость 
"затвор-сток" (Cgd) нелинейна, и не может быть оформлена с простыми 
градуируемыми емкостями моделей monolithic MOSFET. В транзисторе 
VDMOS Cgd резко изменяется в близости нулевого напряжения затвор-
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сток (Vgd). Когда Vgd - отрицательно, физическая основа Cgd - 
конденсатор с затвором как один электрод и сток на обороте 
кристалла как другой электрод. Эта емкость справедливо невелика из-
за толщины непроводящего кристалла. Но когда Vgd положительно, 
кристалл проводит, и Cgd физически основан на конденсаторе с малой 
толщиной подзатворного оксида. 

Традиционно, сложные подсхемы использовались, чтобы копировать 
режим силового MOSFET. Новое встроенное средство spice прибора было 
написано, оно формирует этот режим в интересе быстродействия 
вычисления, надежности конвергенции, и простоты записи моделей. 
Модель DC - то же самое как уровня 1 monolithic MOSFET, за 
исключением того, что значение по умолчанию длины и ширины такое, 
чтобы активная межэлектродная проводимость могла быть 
непосредственно установлена без масштабирования. Модель AC 
следующая. Емкость "затвор-исток" берется как константа. Это, как 
опытным путем найдено, хорошее приближение для power MOSFETS, если 
напряжение затвор-исток не отрицательно. Зависимость емкости 
"затвор-сток" от напряжения следующая, найдена опытным путем:  

 
Для положительного Vgd, Cgd изменяется как гиперболический 

тангенс Vgd. Для отрицательного Vgd, Cgd изменяется как арктангенс 
Vgd. Модельные параметры A, Cgdmax, и Cgdmin параметризуют емкость 
затвор-сток. Емкость исток-сток предоставляется градуируемой 
емкостью внутреннего диода, подключенного через электроды стока и 
истока, за пределами сопротивлений истока и стоковой области. 

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ ЗНАЧ. ПО 

УМОЛЧ. 
ПРИМЕР 

Vto Пороговое напряжение V 0 1.0 

Kp Параметр активной межэлектродной 
проводимости 

A/VІ 1. .5 

Phi Поверхностный потенциал инверсии V 0.6 0.65 

Lambda Модуляция длины канала 1/V 0. 0.02 

Rd Активное сопротивление стока Ω 0. 1. 

Rs Активное сопротивление истока Ω 0. 1. 

Rg Активное сопротивление затвора Ω 0. 2. 
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Rds Сопротивление шунта сток-исток Ω Infin. 10Meg 

Rb Активное сопротивление внутреннего 
диода 

Ω 0. .5 

Cjo Емкость перехода внутреннего диода 
нулевого смещения 

F 0. 1n 

Cgs Емкость затвор-исток F 0. 500p 

Cgdmin Минимальная нелинейная емкость 
затвор-сток 

F 0. 300p 

Cgdmax Максимальная нелинейная емкость 
затвор-сток 

F 0. 1000p 

A Нелинейный параметр емкости Cgd - 1. .5 

Is Ток насыщения внутреннего диода A 1e-14 1e-15 

N Объемный диодный коэффициент эмиссии - 1.  

Vj Потенциал перехода внутреннего диода V 1. 0.87 

M Коэффициент оценки внутреннего диода - 0.5 0.5 

Fc коэффициент внутреннего диода для 
формулы барьерной емкости прямого 
смещения 

- 0.5  

tt Время транзита внутреннего диода sec 0. 10n 

Eg Энергия активации внутреннего диода 
для температурного эффекта на Is 

eV 1.11  

Xti Температурная экспонента тока 
насыщения внутреннего диода 

- 3  

L Масштабирование длины - 1.  

W Масштабирование ширины - 1.  

Kf Коэффициент фликер-шума - 0.  

Af Экспонента фликер-шума - 1.  

nchan[*] N-канал VDMOS - (true) - 

pchan[*] P-канал VDMOS - (false) - 

Tnom Температура измерения параметра °C 27 50 

[*] Модельное имя VDMOS используется и для N- и для P-канального 
VDMOS -транзистора. Значения полярности по умолчанию для N-канала. 
Чтобы установить P-канал, пометьте модель ключевым словом "pchan", 
например, ".model xyz VDMOS(Kp=3 pchan)" определяет транзистор P-
канала. 

 

O. Линия электропередачи с потерями 

Имя Обозначения: LTLIN 

Синтаксис: Oxxx L+ L- R+ R- <model> 

Пример: 

O1 in 0 out 0 MyLossyTline 

.model MyLossyTline LTRA(len=1 R=10 L=1u C =10n) 

Это - одиночный проводник линии электропередачи с потерями. N1 и 
N2 - узлы в порту 1. N3 и N4 - узлы в порту 2. Модельная плата 
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обязана определять электрические характеристики этого схемного 
элемента. 

Модельные параметры для Линий электропередачи с потерями 

Имя Описание Единицы/тип ЗНАЧ. ПО 

УМОЛЧ. 

R  Ω/unit len 0. 

L  H/unit len 0. 

G  1/W/unit len 0. 

C  F/unit len 0. 

Len Количество единиц длины - 0. 

Rel Относительная производная производной, 
чтобы установить контрольную точку 

 1. 

Abs Абсолютная производная производной, 
чтобы установить контрольную точку 

 1. 

NoStep
Limit 

Не ограничивать временной шаг  меньше 
чем временем задержки линии 

flag not set 

NoCont
rol 

Не делать попытку комплексного 
управления временного шага 

flag not set 

LinInt
erp 

Использовать линейную интерполяцию flag not set 

MixedI
nterp 

Использовать линейную интерполяцию, 
когда квадратичная терпит неудачу 

flag not set 

Compac
tRel 

Reltol для уплотнения хронологии  RELTOL 

Compac
tAbs 

Abstol для уплотнения хронологии  ABSTOL 

TruncNr Использовать метод Newton-Raphson для 
контроля временного шага 

flag not set 

TruncD
ontCut 

Не ограничивайте временной шаг, чтобы 
сохранить ошибки импульсной передаточной 
функции низкими 

flag not set 

 

 

Q. Биполярный транзистор 
Имена Обозначения: NPN, PNP, NPN2, PNP2 

Синтаксис: Qxxx Collector Base Emitter [Substrate Node] 

+model [area] [off] [IC=<Vbe, Vce>] [temp=<T>] 

Пример: 

Q1 C B E MyNPNmodel 

.model MyNPNmodel NPN (Bf=75) 

Биполярные транзисторы требуют модельной карты, чтобы установить 
их характеристики. Ключевые слова модельная карты NPN и PNP 
указывают полярность транзистора. Коэффициент участка определяет 
количество эквивалентных параллельных приборов указанной модели. 

Биполярная модель плоскостного транзистора - адаптация 
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интегральной модели элемента управления заряда Gummel и Poon. Это 
изменило модель Gummel-Poon, расширяет оригинальную модель, чтобы 
включить несколько явлений на высоких уровнях смещения, квазирежиме 
насыщения, и удельной проводимости подложки. Модель автоматически 
упрощает к модели Ebers-Moll, когда определенные параметры не 
устанавливаются. Модель DC определяется параметрами Is, Bf, Nf, 
Ise, Ikf, и Ne, которые определяют характеристики усиления прямого 
тока, Is, Br, Nr, Isc, Ikr, и Nc, которые определяют характеристики 
усиления обратного тока, и Vaf и Var, которые определяют выходную 
проводимость прямой и обратной области. Включаются три активных 
сопротивления Rb, Rc и Re, где Rb может быть высоко зависимым от 
тока. Память заряда базы оформляется прямым и обратным временем 
прохода, Tf и Tr, прямое время прохода Tf зависит от смещения, если 
задано. И нелинейными емкостями запирающего слоя, которые 
определяются Cje, Vje и Mje, для перехода B-E, Cjc, Vjc, и Mjc для 
перехода B-C и Cjs, Vjs, и Mjs для перехода коллектор подложка. 
Температурная зависимость тока насыщения, Is, определяется 
дефицитом энергии, Eg, и температурной экспонентой насыщения тока, 
XTI. Дополнительно температурная зависимость тока базы оформляется 
бета экспонентой температуры XTB в новой модели. Предполагаются, 
что установленные значения измерены при температуре TNOM, которая 
установлена на контрольной строке .OPTIONS или переопределена 
спецификацией на строке .model. 

Параметры BJT, используемые в модифицированной модели Gummel-
Poon, перечислены ниже. 

МОДИФИЦИРОВАННЫЕ GUMMEL-POON BJT ПАРАМЕТРЫ 

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ ЗНАЧ. ПО УМОЛЧ. 

Is Ток насыщения перемещения A 1e-16 

Bf Идеальный прямой максимум beta - 100 

Nf Коэффициент испускания тока - 1. 

Vaf Прямое опережающее напряжение V Infin. 

Ikf Corner for forward beta high current 
roll-off 

A Infin. 

Ise Ток насыщения тока утечки B-E A 0. 

Ne Коэффициент эмиссии тока утечки B-E - 1.5 

Br Идеальный обратный максимум бета - 1. 

Nr Коэффициент эмиссии обратного тока - 1. 

Var Обратное опережающее напряжение V Infin. 

Ikr Corner for reverse beta high current 
roll-off 

A Infin. 

Isc Ток насыщения тока утечки B-C A 0 

Nc Коэффициент эмиссии тока утечки B-C - 2 

Rb Сопротивление базы нулевого смещения Ω 0 

Irb Ток, где сопротивление базы падает, на 
полпути к мин. значению 

A Infin. 

Rbm Минимальное сопротивление базы в больших 
токах 

Ω Rb 

Re Сопротивление эмиттера Ω 0. 
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Rc Сопротивление коллектора Ω 0. 

Cje Барьерная емкость нулевого смещения B-E F 0. 

Vje B-E встроенный электрический потенциал V 0.75 

Mje Коэффициент экспоненты перехода B-E - 0.33 

Tf Идеальное время прямого прохода sec 0. 

Xtf Коэффициент для зависимости смещения от 
Tf 

- 0. 

Vtf Напряжение, описывающее зависимость Vbc 
от Tf 

V Infin. 

Itf Параметр большого тока для явления на Tf A 0. 

Ptf Избыток фазы в freq=1/(Tf*2*PI) Гц ° 0. 

Cjc Барьерная емкость нулевого смещения B-C F 0. 

Vjc B-C встроенный электрический потенциал V 0.75 

Mjc Коэффициент экспоненты перехода B-C - 0.33 

Xcjc Фракция барьерной емкости B-C, 
подключенной к внутреннему узлу базы 

- 1. 

Tr Идеальное время обратного прохода sec 0. 

Cjs Емкость "коллектор-подложка" нулевого 
смещения 

F 0. 

Vjs Спай подложки встроенный потенциал V 0.75 

Mjs Коэффициент экспоненты спая подложки - 0. 

Xtb прямая и обратная beta экспонента 
температуры 

- 0. 

Eg Энергия активации для температурного 
эффекта на Is 

eV 1.11 

Xti Температурная экспонента для явления на 
Is 

- 3. 

Kf Коэффициент фликер-шума - 0. 

Af Экспонента фликер-шума - 1. 

Fc Коэффициент для формулы барьерной емкости 
прямого смещения 

- 0.5 

Tnom Температура измерения параметра °C 27 

Cn Температурный коэффициент квазинасыщения 
для подвижности дырок 

2.42 NPN 
2.2 PNP 

D Температурный коэффициент квазинасыщения 
для ограниченной рассеиванием скорости 
дырки 

.87 NPN 

.52 PNP 

Gamma Коэффициент легирования эпитаксиальной 
области 

 1e-11 

Qco Коэффициент заряда эпитаксиальной области C 0. 

Quasimod Флажок квазирежима насыщения для 
температурной зависимости 

flag не 
установлен 

Rco Сопротивление эпитаксиальной области Ω 0. 

Vg Экстраполируемое режимом квазинасыщения V 1.206 
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напряжение энергетической щели в 0°K 

Vo Напряжение излома подвижности носителей V 10. 

Tre1 Re линейный температурный коэффициент 1/°C 0. 

Tre2 Re квадратичный температурный коэффициент 1/°CІ 0. 

Trb1 Rb линейный температурный коэффициент 1/°C 0. 

Trb2 Rb квадратичный температурный коэффициент 1/°CІ 0. 

Trc1 Rc линейный температурный коэффициент 1/°C 0. 

Trc2 Rc квадратичный температурный коэффициент 1/°CІ 0. 

Trm1 Rmb линейный температурный коэффициент 1/°C 0. 

Trm2 Rmb квадратичный температурный 
коэффициент 

1/°CІ 0. 

Iss Ток насыщения спая подложки A 0. 

Ns Коэффициент эмиссии спая подложки - 1. 

Модельный параметр "уровень" может использоваться, чтобы 
установить другой тип BJT в LTspice. Благодаря щедрому вкладу 
исходного кода доктором-инженером Dietmar Warning of DAnalyse GmbH, 
Berlin, Germany, LTspice включает версию VBIC. 

 Установить Level=9, чтобы использовать дополнительный прибор. 
Уровень 4 - синоним для уровня 9. Следующая документация была 
предоставлена д-р Warning: 

VBIC - Вертикальная Биполярная Интер Компании модель 

Модель VBIC - расширенная разработка стандартной Gummel-Poon 
(SGP) модели с фокусом интегрированных биполярных транзисторов в 
сегодняшних современных полупроводниковых технологиях. С 
реализованной измененной моделью Квазирежима насыщения от Kull и 
Nagel также возможно моделировать специальную выходную 
характеристику переключающих транзисторов. Это - широко 
используемая альтернатива модели SGP для кремния, SiGe и III-V HBT 
приборов. 

Возможности VBIC по сравнению со Стандартной Моделью Gummel-Poon 

o Интегрированный Транзистор подложки для паразитных приборов в 
интегрированных процессах 

o Модель Слабой лавины и Пробоя база - эмиттер 

o Улучшенное моделирование Эффекта опережения 

o Физическое разделение Ic и Ib 

o Улучшенная модель Барьерной емкости 

o Улучшенное температурное моделирование 

o моделирование Саморазогрева (не в этой версии) 

Модельная Структура 
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Параметры 

Поскольку модель VBIC основана на модели SGP, возможно стартовать 
с параметров SGP, вынести некоторые трансформации. Следующие 
параметры от версии 1.2VBIC, которая реализуется в LTspice в 4х-
выводной версии без избыточной фазы цепи и явления саморазогрева. 
Чтобы переключить SGP к VBIC, следует установить дополнительный 
параметр LEVEL на 9. 

ИМЯ  ОПИСАНИЕ ЕДИНИЦА ЗНАЧ. ПО 

УМОЛЧ. 

tnom Температура измерения параметра °C 27. 

rcx Примесное сопротивление коллектора Ω 0.1 

rci Встроенное сопротивление коллектора Ω 0.1 

vo Напряжение режима насыщения ухода 
эпитаксиального слоя 

V Infin. 

gamm Параметр легирования полупроводника 
эпитаксиального слоя 

 0.0 

hrcf RC фактор большого тока  Infin. 

rbx Примесное сопротивление базы Ω 0.1 

rbi Встроенное сопротивление базы Ω 0.1 

re Встроенное сопротивление эмиттера Ω 0.1 

rs Встроенное сопротивление подложки Ω 0.1 

rbp Паразитное сопротивление базы Ω 0.1 
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is Электрический ток насыщения перемещения A 1e-16 

nf Коэффициент прямой эмиссии  1. 

nr Коэффициент обратной эмиссии  1. 

fc Предел барьерной емкости прямого смещения  0.9 

cbeo Емкость перекрытия примесная B-E F 0.0 

cje Барьерная емкость нулевого смещения B-E F 0.0 

pe Встраиваемый потенциал B-E V 0.75 

me Коэффициент  оценки перехода B-E  0.33 

aje Фактор сглаживания емкости перехода B-E  -0.5 

cbco Емкость перекрытия примесная B-C F 0. 

cjc Барьерная емкость нулевого смещения B-C F 0. 

qco Параметр заряда эпитаксиального слоя C 0. 

cjep Примесная емкость нулевого смещения B-C F 0. 

pc Встраиваемый потенциал перехода B-C V 0.75 

mc Коэффициент  оценки перехода B-C  0.33 

ajc Фактор сглаживания емкости перехода B-C  -0.5 

cjcp Емкость нулевого смещения перехода S-C F 0. 

ps Встраиваемый потенциал перехода S-C V 0.75 

ms Коэффициент  оценки перехода S-C  0.33 

ajs Фактор сглаживания емкости перехода S-C  -0.5 

ibei Идеальный ток насыщения перехода B-E A 1e-18 

wbe Часть IBEI от Vbei 1-WBE от Vbex  1. 

nei Идеальный коэффициент эмиссии B-E  1. 

iben Неидеальный ток режима насыщения B-E A 0. 

nen Неидеальный коэффициент эмиссии B-E  2. 

ibci Идеальный ток насыщения перехода B-C A 1e-16 

nci Идеальный коэффициент эмиссии B-C  1. 

ibcn Неидеальный ток режима насыщения B-C A 0. 

ncn Неидеальный коэффициент эмиссии B-C  1. 

avc1 B-C слабый лавинный параметр 1 1/V 0. 

avc2 B-C слабый лавинный параметр 2 1/V 0. 

isp Паразитный ток режима насыщения перемещения A 0. 

wsp Часть ICCP  1. 

nfp Коэффициент паразитной прямой эмиссии  1. 

ibeip Идеальный паразитный ток насыщения B-E A 0. 

ibenp Неидеальный паразитный ток насыщения B-E A 0. 

ibcip Идеальный паразитный ток насыщения B-C A 0. 

ncip Идеальный паразитный коэффициент эмиссии B-C  1. 

ibcnp Неидеальный паразитный ток насыщения B-C A 0. 

ncnp Неидеальный паразитный коэффициент эмиссии B-C  2. 

vef Прямое напряжение опережения  Infin. 
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ver Обратное напряжение опережения  Infin. 

ikf Прямой ток излома A Infin. 

ikr Обратный ток излома A Infin. 

ikp Паразитный ток излома A Infin. 

tf Идеальное время прямого прохода s 0. 

qtf Изменение TF с модуляцией ширины базы  0. 

xtf Коэффициент для зависимости смещения TF  0. 

vtf Напряжение, дающее зависимость VBC TF V Infin. 

itf Большого тока зависимость TF A Infin. 

tr Идеальное время обратного прохода sec 0. 

td Время задержки прямого избытка фазы sec 0. 

kfn Коэффициент Фликер-шума B-E  0. 

afn Экспонента Фликер-шума B-E  1. 

bfn Фликер-шум B-E 1/f зависимость  1.0 

xre Температурная экспонента RЕ  0. 

xrbi Температурная экспонента RBI  0. 

xrci Температурная экспонента RCI  0. 

xrs Температурная экспонента RS  0. 

xvo Температурная экспонента VO  0. 

ea Энергия активации для IS V 1.12 

eaie Энергия активации для IBEI V 1.12 

eaic Энергия активации для IBCI/IBEIP V 1.12 

eais Энергия активации для IBCIP V 1.12 

eane Энергия активации для IBEN V 1.12 

eanc Энергия активации для IBCN/IBENP V 1.12 

eans Энергия активации для IBCNP V 1.12 

xis Температурная экспонента IS  3. 

xii Температурная экспонента IBEI, IBCI, IBEIP, 
IBCIP 

 3. 

xin Температурная экспонента IBEN, IBCN, IBENP, 
IBCNP 

 3. 

tnf Температурная экспонента NF  0. 

tavc Температурная экспонента AVC2  0. 

rth Тепловое сопротивление K/W 0. 

cth Удельная теплоемкость Ws/K 0. 

vrt Напряжение смыкания внутреннего перехода B-C V 0. 

art Параметр сглаживания для сквозной области  0.1 

ccso Фиксированная C-S емкость F 0. 

qbm Выбрать SGP qb формулировку  0. 

nkf Спад beta большого тока  0.5 

xikf Температурная экспонента IKF  0. 
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xrcx Температурная экспонента RCX  0. 

xrbx Температурная экспонента RBX  0. 

xrbp Температурная экспонента RBP  0. 

isrr Отдельный IS for fwd и rev  1. 

xisr Температурная экспонента ISR  0. 

dear Энергия активации Delta для ISRR  0. 

eap Энергия возбуждения для ISP  1.12 

vbbe Напряжение пробоя B-E V 0. 

nbbe Коэффициент эмиссии пробоя B-E  1. 

ibbe Ток пробоя B-E  1e-06 

tvbbe1 Линейный температурный коэффициент VBBE  0. 

tvbbe2 Квадратичный температурный коэффициент VBBE  0. 

tnbbe Температурный коэффициент NBBE  0. 

ebbe exp(-VBBE/(NBBE*Vtv))  0. 

dtemp Различие температуры региона є 0. 

vers Версия Редакции  1.2 

vref Версия Ссылки  0. 

ССЫЛКИ: 

C. C. McAndrew et al., "Vertical Bipolar Inter Company 1995: An 
Improved Vertical, IC Bipolar Transistor Model", Proceedings of the 
IEEE Bipolar Circuits and Technology Meeting, pp. 170 – 177, 1995 

  

C. C. McAndrew et.al., VBIC95, "The Vertical Bipolar Inter-
Company Model", IEEE Journal of Solid State Circuits, vol. 31, No. 
10, October 1996 

  

C. C. McAndrew, VBIC Model Definition, Release 1.2, 18. Sep. 1999 

 

R. Резистор 
Имена Обозначения: RES, RES2 

Синтаксис: Rxxx n1 n2 <value> [tc=tc1, tc2, ...] 

+ [temp=<value>] 

Резистор предоставляет простое линейное сопротивление между 
узлами n1 и n2. Температурная зависимость может быть определена для 
каждого экземпляра класса резистора с параметром tc. Сопротивление 
R может быть 

R=R0*(1.+dt*tc1+dt**2*tc2+dt**3*tc3+...) 

где R0 - сопротивление при номинальной температуре, и dt - 
различие между температурой резистора и номинальной температурой. 

 

S. Управляемый напряжением переключатель 
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Имена Обозначения: SW 

Синтаксис: Sxxx n1 n2 nc+ nc- <model> [on,off] 

Пример: 

S1 out 0 in 0 MySwitch 

.model MySwitch SW(Ron=.1 Roff=1Meg Vt=0 Vh=-.5 Lser=10n Vser=.6) 

Напряжение между узлами nc+ и nc- управляет полным сопротивлением 
переключения между узлами n1 и n2. Модельная карта обязана 
определять режим переключения. См. файл 
.\examples\Educational\Vswitch.asc описания схемы, чтобы видеть 
пример модельной карты, помещенной непосредственно в описание схемы 
как директива SPICE. 

Управляемые напряжением параметры модели переключения 

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ ЗНАЧ. ПО 

УМОЛЧ. 

Vt Пороговое напряжение V 0. 

Vh Гистерезисное напряжение V 0. 

Ron Сопротивление в открытом состоянии Ω 1. 

Roff Сопротивление в закрытом состоянии Ω 1/Gmin 

Lser Последовательная индуктивность H 0. 

Vser Последовательное напряжение V 0. 

Ilimit Предел тока A Infin. 

У переключателя есть три различных режима контроля напряжения, в 
зависимости от значения гистерезисного напряжения, Vh. Если Vh - 
нуль, переключение всегда полностью вкл. или выкл. в зависимости от 
того, является ли входное напряжение выше порога. Если Vh 
положителен, переключение показывает гистерезис, как будто 
переключателем управляет триггер Шмитта с порогами Vt-Vh и Vt+Vh. 
Обратите внимание, что величина Vh это половина напряжения между 
точками обработки, обозначение гистерезисного напряжения является 
иным, чем в общей лабораторной терминологии. Если Vh будет 
отрицательным, то переключение будет происходить гладким изменением 
полного сопротивления между значениями вкл. и выкл.. Переключение 
происходит между управляющими напряжениями Vt-Vh и Vt+Vh. Гладкое 
переключение следует за низким порядком полиномиальной подгонки к 
логарифму проводимости переключения. 

Есть также уровень 2 управляемое напряжением переключение, 
которое является улучшенной версией переключения уровня 1 с 
отрицательным гистерезисом. Переключение уровня 2 никогда не вкл. 
или выкл. полностью. Проводимость, как функция управляющего 
напряжения Vc, задается уравнением 

g(Vc)=exp(A*atn((Vc-Vt)/Vh)+B) 

где  

A=pi*(log(1/Ron)-log(1/Roff)) 

B=(log(1/Ron)+log(1/Roff)) 

Кроме того, переключение уровня 2 переключаются на текущий предел 
плавно, а не резко. В установленном управляющем напряжении I-V 
характеристика задается уравнением 



105 
 

I(V)=Ilimit*tanh(g(Vc)*V) 

Переключение уровня 2 поддерживает опцию проводимости только в 
одном направлении определением "одностороннего" флажка или 
определением удаления напряжения с параметром Vser. Переключение 
между прямой проводимостью и обратной разомкнутой цепью может быть 
установлено гладким переключением при определении параметра epsilon 
ненулевым. 

 

T. Линия электропередачи без потерь 
Имя Обозначения: TLINE 

Синтаксис: Txxx L+ L- R+ R- Zo=<value> Td=<value>  

L + и L- являются узлами в одном порту. R + и R- являются узлами 
для другого порта. Zo - характеристический импеданс. 
Продолжительность линии дается временем задержки распространения 
Td. 

Этот элемент моделирует только один вид распространения. Если все 
четыре узла отличны в фактической схеме, то два режима могут быть 
взволнованы. Чтобы имитировать такое местоположение, требуются два 
элемента линии электропередачи. 

 

U. Универсальная RC-line  
Имена Обозначения: URC 

Синтаксис: Uxxx N1 N2 Ncom <model> L=<len> [N=<lumps>]  

N1 и N2 - два узла схемы, к которым подключена RC линии, тогда 
как Ncom - узел, к которому подключаются емкости. MNAME - модельное 
имя, и LEN - продолжительность RC линии в метрах. Lumps, если 
установлено, являются количеством сосредоточенных сегментов, чтобы 
использовать в моделировании RC линии. Предположение в 
использовании соответствующего количества сегментов, будет 
высказано, если lumps не будут установлен. 

Модель URC получается из модели, предложенной L. Gertzberrg в 
1974. Модель выполняется расширением типа подсхемы линии URC в сеть 
сосредоточенных RC сегментов с внутренне сгенерированными узлами. 
RC сегменты находятся в геометрической прогрессии, увеличивающейся 
к середине линии URC, с K как константа пропорциональности. 

Линия URC составляется строго из сегментов резистора и 
конденсатора, если параметру ISPERL не дают значение отличное от 
нуля, когда конденсаторы заменяются обратно-смещенными диодами с 
емкостью перехода нулевого смещения эквивалентной замененной 
емкости, и с током насыщения ISPERL А/метр линии электропередачи и 
опционального последовательного эквивалентного сопротивления RSPERL 
ом/метр. 

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ ЗНАЧ. ПО 

УМОЛЧ. 

K Константа Распространения - 2. 

Fmax Предельная рассматриваемая частота Hz 1G 

Rperl Сопротивление на единицу длины Ω 1K 
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Cperl Емкость на единицу длины F 1e-15 

Isperl Ток насыщения на единицу длины A 0. 

Rsperl Диодное Сопротивление на единицу 
длины 

Ω 0. 

 

 

V. Источник напряжения 

Имена Обозначения: VOLTAGE, BATTERY  

Синтаксис: Vxxx n+ n- <voltage> [AC=<amplitude>] 

+ [Rser=<value>] [Cpar=<value>] 

Эти элементы источники постоянного 
напряжения между узлами n+ и n-. Для 
исследования AC, значение AC используется как 
амплитуда источника на частоте исследования. 
Могут быть определены последовательное 
сопротивление и параллельная емкость. 
Эквивалентная схема приведена рядом. 

 Источники напряжения исторически 
использовались как измерительные приборы в 
SPICE и используются как измерители или 
датчики тока для элементов управляемых током. 
Если Rser устанавливается, источник 
напряжения не может использоваться как датчик 
тока для F, H, или W элементов. Однако, 
электрический ток любого схемного элемента, 
включая источник напряжения, может чертиться.  

ИМПУЛЬСНЫЙ ИСТОЧНИК НАПРЯЖЕНИЯ С ВРЕМЕННОЙ ЗАВИСИМОСТЬЮ  

Синтаксис: Vxxx n+ n- PULSE(V1 V2 Tdelay Trise Tfall Ton Tperiod 
Ncycles) 

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ 

Voff Начальное значение V 

Von Импульсное значение V 

Tdelay Время задержки sec 

Tr Время возрастания sec 

Tf Время спада sec 

Ton Время включения sec 

Tperiod Период sec 

Ncycles Число циклов (Опускают для 
непрерывного источника) 

Num 

 

ИСТОЧНИК СИНУСОИДАЛЬНОГО НАПРЯЖЕНИЯ С ВРЕМЕННОЙ ЗАВИСИМОСТЬЮ. 

Синтаксис: Vxxx n+ n- SINE(Voffset Vamp Freq Td Theta Phi 
Ncycles) 

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ 

Voffset DC смещение V 
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Vamp Амплитуда V 

Freq Частота Hz 

Td Время задержки 1/sec 

Theta Декремент затухания sec 

Phi Фаза синусоидальной волны degrees 

Ncycles Число циклов (Опускают для 
непрерывного источника) 

Num 

Для времени, меньше чем Td или после завершения Ncycles, выходное 
напряжение будет 

Voffset+Vamp*sin(pi*Phi/180) 

В остальное время напряжение будет  

Voffset+Vamp*exp(-(time-Td)*Theta)*sin(2*pi*Freq*(time-
Td)+pi*Phi/180) 

Декремент затухания, Theta, является обратной величиной константы 
времени спада импульса. 

 

ЭКСПОНЕНЦИАЛЬНЫЙ ИСТОЧНИК НАПРЯЖЕНИЯ С ВРЕМЕННОЙ ЗАВИСИМОСТЬЮ. 

Синтаксис: Vxxx n + n- EXP(V1 V2 Td1 Tau1 Td2 Tau2) 

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ 

V1 Начальное значение V 

V2 Импульсное значение V 

Td1 Время задержки повышения sec 

Tau1 Константа времени повышения sec 

Td2 Время задержки спада sec 

Tau2 Константа времени спада sec 

Для времени меньше чем Td1 выходное напряжение - V1. Для времени 
между Td1 и Td2 выходное напряжение будет  

V1+(V2-V1)*(1-exp(-(time-Td1)/Tau1)) 

Для времени после Td2 выходное напряжение будет  

V1+(V2-V1)*(1-exp(-(time-Td1)/Tau1)) 

+(V1-V2)*(1-exp(-(time-Td2)/Tau2)) 

 

ЧАСТОТНЫЙ FM ИСТОЧНИК НАПРЯЖЕНИЯ С ВРЕМЕННОЙ ЗАВИСИМОСТЬЮ. 

 Синтаксис: Vxxx n+ n- SFFM(Voff Vamp Fcar MDI Fsig) 

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ 

Voff DC смещение V 

Vamp Амплитуда V 

Fcar Несущая частота Hz 

MDI Индекс модуляции  

Fsig Частота сигнала Hz 

Выходное напряжение будет  

Voff+Vamp*sin((2.*pi*Fcar*time)+MDI*sin(2.*pi*Fsig*time)). 
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ПРОИЗВОЛЬНЫЙ КУСОЧНО-ЛИНЕЙНЫЙ ИСТОЧНИК НАПРЯЖЕНИЯ. 

Синтаксис: Vxxx n+ n- PWL(t1 v1 t2 v2 t3 v3...) 

Для времени меньше t1, напряжение - v1. Для времени между t1 и 
t2, напряжение изменяется линейно между v1 и v2. Может быть любое 
количество пар точек время-напряжение. Для времени после 
последнего, напряжение - последнее напряжение. 

 

Синтаксис: Vxxx n+ n- wavefile=<filename> [chan=<nnn>]  

Позволяет .wav файлу использоваться как ввод к LTspice. <имя 
файла> - полный, абсолютный путь для .wav файла или относительный 
путь, вычисленный от каталога, содержащего описание схемы 
моделирования или список соединений. Двойные кавычки могут 
использоваться, чтобы установить путь, содержащий пространства..wav 
файл может содержать до 65536 каналов, пронумерованных от 0 до 
65535. Используемый канал устанавливается. По умолчанию, первый 
канал, номер 0, используется. .wav файл интерпретируется как 
наличие полного диапазона шкалы от-1V до 1V. 

Этот источник используется только в .tran исследовании. 

 

W. Управляемый током переключатель 
Имена Обозначения: CSW 

Синтаксис: Wxxx n1 n2 Vnam <model> [on,off]  

Пример: 

 W1 out 0 Vsense MySwitch  

Vsense b 0. 

.model MySwitch CSW(Ron=.1 Roff=1Meg It=0 Ih=-.5) 

Электрический ток через названный контрольный источник напряжения 
переключает полное сопротивление. Модельная карта обязана 
определять режим управляемого током переключения. 

Параметры модели управляемого током переключателя 

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ ЗНАЧ. ПО 

УМОЛЧ. 

It Пороговый ток A 0. 

Ih Гистерезисный ток A 0. 

Ron Сопротивление в открытом состоянии Ω 1. 

Roff Сопротивление в закрытом состоянии Ω 1/Gmin 

У переключения есть три различных режима текущего элемента 
управления, в зависимости от значения гистерезисного электрического 
тока Ih. Если Ih - нуль, переключение всегда полностью вкл. или 
выкл. согласно тому, является ли электрический ток элемента 
управления выше порога. Если Ih положителен, переключение 
происходит с гистерезисом при значениях тока It-Ih и It+Ih. Если Ih 
отрицателен, то переключение происходит гладким изменением полного 
сопротивления между Ron и Roff. Переключение происходит между 
электрическими токами элемента управления It-Ih и It+Ih. Гладкое 
переключение следует за низким порядком полиномиальной подгонки к 
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логарифму проводимости переключения. 

 

X. Подсхема 
Синтаксис: Xxxx n1 n2 n3... <subckt name> 

 [<parameter>=<expression>]  

Подсхемы позволяют схеме быть определенной и сохраненной в 
библиотеке для более позднего поиска по имени. Ниже пример 
определения и вызова делителя напряжения, и вызова его в схеме. 

* calling a subcircuit 

* 

* This is the circuit 

X1 in out 0 divider top=9K bot=1K 

V1 in 0 pulse(0 1 0 .5m .5m 0 1m) 

  

* This is the subcircuit 

.subckt divider A B C 

R1 A B {top} 

R2 B C {bot} 

.ends divider 

.tran 3m 

.end 

 

Z. транзистор MESFET 
Имена Обозначения: MESFET 

Синтаксис: Zxxx D G S model [area] [off] [IC=<Vds, Vgs>] 

+ [temp=<value>] 

Транзистор MESFET требует модельной карты, чтобы установить его 
характеристики. Модельные ключевые слова карты NMF и PMF 
устанавливают полярность транзистора. Модель MESFET получается из 
модели полевого транзистора арсенида галлия, описанной H. Statz et 
al., GaAs FET Device and Circuit Simulation in SPICE, IEEE 
Transactions on Electron Devices, V34, Number 2, February, 1987 
pp160-169. 

Включаются два активных сопротивления, Rd и Rs. Память заряда 
оформляется полным зарядом затвора как функция напряжений затвор-
сток и затвор-исток и определяется параметрами Cgs, Cgd, и Pb. 

ИМЯ  ОПИСАНИЕ ЕДИНИЦЫ ЗНАЧ. ПО 

УМОЛЧ. 

Vto Напряжение отсечки V -2. 

Beta Параметр активной межэлектродной проводимости A/VІ 1e-4 

B Параметр легирования распространения хвоста 1/V 0.3 

Alpha Параметр напряжения режима насыщения 1/V 2. 

Lamda Модуляция длины канала 1/V 0. 
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Rd Активное сопротивление стока Ω 0. 

Rs Активное сопротивление истока Ω 0. 

Cgs Емкость перехода G-S нулевого смещения F 0. 

Cgd Емкость перехода G-D нулевого смещения F 0. 

Pb Потенциал перехода затвора V 1. 

Kf Коэффициент фликер-шума - 0. 

Af Экспонента фликер-шума - 1. 

Fc Коэффициент истощения прямого смещения - 0.5 

 

 

 

 

 

Черновой перевод пользователя http://valvol.flyboard.ru/index.php 

С именем Lincent , почтовый адрес   acconvert@mail.ru 

http://valvol.flyboard.ru/index.php
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